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Chapter 1: Materials

1.1. Verification by the partial factor method
Cfart2.4.2.4.
Partial factors for materials for ultimate limit states, yc and ys should be used.

The recommended values of yc and ys for ‘persistent & transient’ and ‘accidental, design situations are given
in the following table. These are not valid for fire design for which reference should be made to EN 1992-1-2.

For fatigue verification the partial factors for persistent design situations given in this table are recommended
for the values of yc.fat and ys fat.

Design situations yc for concrete | s for reinforcing steel | s for prestressing steel
Persistent & Transient 1,5 1,15 1,15
Accidental 1,2 1,0 1,0

These values can also be found in the Concrete setup of the National Annex:

B Concrete setup X
4 Type of values S?andard EM Name Standard EN o
i = Concrete .
MA building & General Concrete

4 Type of functionality
Hollow core beams
Prestressing

ncrete 4 General

-~ Non-prestressed reinforcement 4 Concrete
Prestressed reinforcement

H a i
- Durability and concrete cover National annex

= ULS 4 EN_1992_1_1
General 4 rgy-partial factor for shrinkage actic
= Punching

= 5LS Value[-] 1.00
General 4 1 - partial factor for design values o

‘- Prestressing
= Allowable stress
‘.- Stress limitation during tensioning 4 fok may - Maximum value of the char

- SLS stress limitation Value [MPa] 90.00
[=)- Detailing provisions

i Common detailing provisions

Values[] 1.50 / 1.20

4 . - coeff. taking account of long ter

Columns Value[] 1.00
: Sg)a;:rsud:ures and slabs 4 a, - coeff. taking account of long ter
.. Punching Value[-] 1.00
4 kypq - coeff. for calculation of ratio
Value[-] 0.44
4 kz joq - coeff. for calculation of ratio
Formula Formula
4 k3 1aq - coeff. for calculation of ratio
Value[-] 0.54
4 k4 \ed - coeff. for calculation of ratio
Formula Formula
< ks 4 kg ,.q - coeff. for calculation of ratio v
select all Unselect all Refresh Load default NA parameters Cancel
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B Concrete setup X
4 Type of values Standard EN Name Standard EN
. [=- Concrete
Fl
MA building 2+ General Concrete
4 Type of functionality L. Concrete 4 General
sl eere Forme - Mon-prestressed reinforcement I Concrete

i Prestressed reinforcement

Prestressing ‘.- Durability and concrete cover

4  Mon-prestressed reinforcement

= ULs 4 National annex
- General 4 EN_1992 1 1
- Punching
= 5LS 4 rg- partial factor for design values o
. General Values [-] 1.15/1.00

Prastressing

o Allowable stress 4 =,4/5, - ratio of design and characte

Stress limitation during tensioning Value [-] 0.90
- 5L stress limitation m
yk.up
[=)- Detailing provisions
: ¥ 600.00
- Common detailing provisions Value [MFa]
i Columns P Prestressed reinforcement
- Beams I Durability and concrete cover
- 2D structures and slabs
i Punching F uLs
F SLS
& Allowable stress
P Detailing provisions
< >
Select all Unselect all Refresh Load default MA parameters Cancel

All factors related to the code are shown in green on the screen. By default, the values of the chosen code are
taken.

The values for partial factors for materials for serviceability limit state verification should be taken as those
given in the particular clauses of this Eurocode.

Lower values of yc and ys may be used if justified by measures reducing the uncertainty in the calculated
resistance.

1.2. Concrete

The following clauses give principles and rules for normal and high strength concrete.

1.2.1.  Strength (art 3.1.2)

The compressive strength of concrete is denoted by concrete strength classes which relate to the characteristic
(5%) cylinder strength fcx, or the cube strength fek cube.

The strength classes in this code are based on the characteristic cylinder strength fck determined at 28 days
with a maximum value of Cmax.

The recommended value of Cmax is C90/105.

6 MJ — 08/08/2024



B | Concrete setup X

4 Type of values Standard EN Name Standard EN ~
NA building - Céljh(;r:::ral 4 Concrete
4 Type of functionality Concrete 4 General
Hollow core beams Mon-prestressed reinforcement 4 Concrete

Prestressed reinforcement

“- Durability and concrete cover
= ULS 4 EN_1992_1_1
i General P
Punching
- 515 Value[-] 1.00
General
Prestressing
—I- Allowable stress
. Stress limitation during tensioning 4 fok max -~ Maximum value of the char

SLS stress limitation Value [MPa] 90.00
[=- Detailing provisions

- Common detailing provisions

Prestressing 4 MNational annex

rgy-partial factor for shrinkage actic

n

T - partial factor for design values o
Values[-] 1.50/1.20

4 a..- coeff. taking account of long ter

Columns Value[-] 1.00
gsla::r!uctures and slabs 4 a_, - coeff. taking account of long ter
- Punching Value[] 1.00
4 ki req - coeff. for calculation of ratio
Value[-] 9.44
4 k3 ;od - coefl. for calculation of ratic
Fermula Formula
4 k3 roq - coeff. for calculation of ratio
Value[-] 0.54
4 k4 red - coeff. for calculation of ratio
Formula Formula
< > 4 kg roq - coeff. for calculation of ratio v
Select all Unselect all Refresh Load default NA parameters Cancel

In certain situations (e.g. prestressing) it may be appropriate to assess the compressive strength for concrete
before or after 28 days, on the basis of test specimens stored under other conditions than prescribed in EN
12390.

All values can also be found in the material library of SCIA Engineer:

B Materials *
HEiEGHFE a2 O A=BD A i
C12/15 Mame C50/60
Cle/20 P Code independent

e 4 EM1992-1-1

C25/30

. Characteristic compressive cylinder strength fck(28) [MPa] 50.00
C35-."45 Calculated depended values
C40/50 Mean compressive strength fcm(28) [MPa] 55.00
C45/55 fcm(28) - fck(28) [MPa] .00
C50/60 Mean tensile strength fetm(28) [MPa] 4.10
Co fctk 0,05(28) [MPa] 2-90
C60/75

T fctk 0,95(28) [MPa] 5.30
[380-."95 Design compressive strength - persistent (fed = fck / gamma c_p) [MPa] 33.33
C90/105 Design compressive strength - accidental (fcd = fck / gamma c_a) [MPa] 41.67
C6/8 (British BS-E... Strain at reaching maximum strength eps c2 [1e-4] 20.0
C8/10 (British BS-E... Ultimate strain eps cu2 [1e-4] 35.0

C28/35 (British BS-...
C28/35 (Irish L.5-E...

C28/35 (Dutch ME...

C32/40 (British BS-...
C100/115 (Germa...

C12/15(EN1992-2) Type of aﬁregate Quartzite v
C16/20(EN1992-2) 4 Measured values

C20/25(EN1992-2)
C25/30(EN1992-2)
C30/37(EN1992-2)

Strain at reaching maximum strength eps €3 [1e4] 17.5
Ultimate strain eps cu3 [1e-4] 35.0

Stene diameter (dg) [mm] 32
Cement class N {nermal hardening - CEM 32,! v

Measured values of mean compressive strength (influence of ageing)

b Stress-strain diagram

MNew Insert Edit Delete Close
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B Materials x
PR GFE «~ O A=B A M4

C12/15 Ultimate strain eps cu3 [1e-4] 35.0 -
C16/20 Stone diameter (dg) [mm] 32

t20/25 Cement class M (nermal hardening - CEM 2 v
C25/30 .

- Type of aggregate Quartzite v
C35/45 4 Measured values

(‘,40:,.'50 Measured values of mean compressive strength (influence of ageing)

C45/55 4+ Measured values |

Cs0/60 Age of concrete [day] 7.0

CSS-“:ET Mean value of compressive cylinder strength [MPa] 44.12

E:g;z Emod, sec [MPa] 34342.2

C80/95 4 Measured values Il

C90/105 Age of concrete [day] 28.0

C6/8 (British BS-E... Mean value of compressive cylinder strength [MPa] 50.00

C8/10 (British BS-E... Emod, sec [MPa] 35654.4

C28/35 (British BS-...
C28/35 (Irish 1.5-E...
28/35 (Dutch NE...

4 Measured values Il

Age of concrete [day] 0.0

C32/40 (British BS-... Mean value of compressive cylinder strength [MPa] 0.00

C100/115 (Germa... Emod, sec [MPa] ©.00

C12/15(EN1992-2) Standard deviation [MPa] 4.2

C16/20(EN1992-2) Characteristic compressive cylinder strength (28) (Fck) [MPa] 42.0

C20/25(EN1992-2) Graph

C25_.-30EEN1992—2:I B Stress-strain diagram

C30/37(EN1992-2) v
Mew Insert Edit Delete Close

It may be required to specify the concrete compressive strength, fe(t), at time t for a number of stages (e.g.
demoulding, transfer of prestress), where:

fek(t) = fem(t) - 8 (MPa) for 3 <t< 28 days
fek(t) = fox for t 2 28 days

The compressive strength of concrete at an age t depends on the type of cement, temperature and curing
conditions. For a mean temperature of 20°C and curing in accordance with EN 12390 the compressive strength
of concrete at various ages fem(t) may be estimated from:

fcm(t) = Bcc(t) fem (31)

1
I
with Bec(t) = e (3.2
where:
o fem(t) is the mean concrete compressive strength at an age of t days
o fem  is the mean compressive strength at 28 days according to Table 3.1
o Pec(t) isa coefficient which depends on the age of the concrete t
o t is the age of the concrete in days
e S is a coefficient which depends on the type of cement:
= 0,20 for cement of strength Classes CEM 42,5 R, CEM 52,5 N and CEM 52,5 R (Class R)
= 0,25 for cement of strength Classes CEM 32,5 R, CEM 42,5 N (Class N)
= 0,38 for cement of strength Classes CEM 32,5 N (Class S)

8 MJ — 08/08/2024



The type of cement

can be chosen in the material library:

B Msterials

EikGra
Ci2/15

Cl16/20

£20/25

C25/30

C30/37

Ca5/45

Can/50

L L1

C50/60

C55/6T

Ce0/75

CT0/85

Can/as

Can/105

C6/R (British BS-EN NA)
C8/10 (British BS-EM ...

£28/35 (British BS-EN...
C28/35 (Irish L5-EM MA)
£28/35 [Dutch NEM-E...

£100/115 (Gerrman Di..
C13/18[EN1992-2)
C16/20(EN1992-2)
C20/25[EN1992-2)
£25/30(EN1992-2)
£30/37(EN1992-2)
C35/45(EN1992-2)
C40/50(EN1992-2)
C45/88[EN1992-2)
Cs50/60(EN1992-2)
C55/6T[EN1992-2)
C60/75(EN1992-2)
CT0/B5[EN1992-2)
C80/95(EN1992-2)
C90/105[EN1992-2)
Ba00A

B sonA

B s00A

B 40oB

B S00B

B E00B

B 4ooc

BsooC

B&onC

B 4208 [Austrian OMO...
B 550A (Austrian ONO ...
B 5508 [Austrian ONO..

New | Insert | Edit

C32/40 (British BS-EN... ¢

as O ABD ™
Mame

4 Code independent
Material type
Thermal expansion [m/mE]
Unit mazs [kg/m"*3)
Density in fresh state [kg/m" 3]

« ¥

C30/37

Concrete
0.01e-003
2500.00
2600,00

| E modulus [MPa)

3.2500e+04 |

Polsson coeft.
Independent G modulus
G modulus [MPa)
Log. decrement (non-uniform damping only)
Colour
Specific heat [1/gK]
Therrmal conductivity [W/ mb]
Order in code
Price per unit [€/m"3)
EN 1992-1-1

0.2

LIGETer04
a.2

6000001
450008401
5

100

Characteristic compressive cylinder strength fek{28) [MPa)

Cakculated depended values

Mean compressive strength fem(28] [MPa)

fcrm(28] - fcki28] [MPa]

Mean tensile strength fokm(28) [MPa]

fieth 0,05(28) [MPa)

ficth 0,95(28) [MPa]

Design compressive strength - persistent [fed = fck / gamma ¢_p) [MPa)
Design compressive strength - accidental (fod = fck f gamma ¢_a) [MFa]
Strain at reaching maximum strength eps 2 [1e-4)

Ultimate strain eps cul [1e-4]

Strain at reaching maximum strength eps c3 [1e-4)

Ultimate strain eps cul [1e-4)

30.00
38.00
&.00
2.80
2.00
3.0
20.00
25.00
0.0
5.0
17.5
5.0

Stone diameter [dg] [mm]

32

Cerment clazs
Typj of aggregate

4 Measured values

N {nermal hardening - CEM 32,5 R, CEM 42,5 N)

S (slow hardening - CEM 31,5 Nj

R {rapiel harde ning CEM 42,5 B, CEM 52,5 N, CEM 52,5 R)

Measured values of mean compressive strength (influ Bl
4 Siress-strain diagram
Type of diagram
Picture of Stress-strain diagram

Delete

EBi-linear stress-strain diagram

The tensile strength refers to the highest stress reached under concentric tensile loading.
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The characteristic strengths for fex and the corresponding mechanical characteristics necessary for design, are

given in Table 3.1:

Table 3.1 Strength and deformation characteristics for concrete
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1.2.2. Design compressive and tensile strengths (art 3.1.6)

The value of the design compressive strength is defined as

fed = otec fek / Yc (315)

where:
* YC is the partial safety factor for concrete.
e oacc Isthe coefficient taking account of long term effects on the compressive strength and of
unfavourable effects resulting from the way the load is applied.
The value of acc should lie between 0,8 and 1,0. The recommended value is 1,0.

Remark: the Belgian National Annex recommends the use of the value 0,85.
The value of the design tensile strength, fcua, is defined as

fera = otet fetk0,05 / Y (3.16)

where:
e yC is the partial safety factor for concrete.
Ot is a coefficient taking account of long term effects on the tensile strength and of unfavourable
effects, resulting from the way the load is applied.
The recommended value of act is 1,0.

The values of the coefficients taking account of long term effects can be found in the Concrete setup of the
National Annex:

B Concrete setup X
4 Type of values Standard EN Name Standard EN -~
T [=)- Conurete
- A
MNA building 5 General Concrete
4 Type of functionality - Concrete 4 General
Hollow core beams - Mon-prestressed reinforcement 4 Concrete

- Prestressed reinforcement

. =
- Durability and concrete cover National annex

Prestressing

5 ULS 4 EN_1992_1_1
-~ General 4 rgy-partial factor for shrinkage actic
= Punching

Sosis Value [-] 1.00
- General g

rc - partial factor for design values o
- Prestressing
= Allowable stress
- Stress limitation during tensioning 4 fok maw - Maximum value of the char
SLS stress limitation Value [MPa] 90.00
=) Detailing provisions
Common detailing provisions

Values [-] 1.50/ 1.20

4 a.. - coeff. taking account of long ter

- Columns Value [-] 1.00
S;as’:rsuctures and slabs 4 a_, - coeff. taking account of long ter
Punching Value [-] 1.00
4 ki ,ed - coeff. for calculation of ratio
Value [-] 0.44
4 k3 ,eq - coeff. for calculation of ratio
Formula Formula
4 k3 ,eq - coeff. for calculation of ratio
Value [-] 0.54
4 kg ,eq - coeff. for calculation of ratio
Formula Formula
< > 4 kg ,oq - coeff. for calculation of ratio v
Select all Unselect all Refresh Load default NA parameters Cancel

If the concrete strength is determined at an age t > 28 days the values oacc and act should be reduced by a
factor k.

The recommended value of ki is 0,85.

MJ — 08/08/2024 11
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1.2.3. Elastic deformation (art 3.1.3)

The elastic deformations of concrete largely depend on its composition (especially the aggregates). The values
given in this Standard should be regarded as indicative for general applications. However, they should be
specifically assessed if the structure is likely to be sensitive to deviations from these general values.

The modulus of elasticity of a concrete is controlled by the moduli of elasticity of its components. Approximate
values for the modulus of elasticity Ecm, secant value between oc = 0 and 0,4fcm, for concretes with quartzite
aggregates, are given in Table 3.1.

For limestone and sandstone aggregates the value should be reduced by 10% and 30% respectively. For
basalt aggregates the value should be increased by 20%.

G'c“

04 fus

-

Eeq Eeut &
Figure 3.2: Schematic representation of the stress-strain relation for structural
analysis (the use 0,4f,,, for the definition of E., is approximate).

Variation of the modulus of elasticity with time can be estimated by:
Ecm(t) = (fcm(t) /fcm)o'3 Ecm (3.5)

where Ecm(t) and fem(t) are the values at an age of t days and Ecm and fcm are the values determined at
an age of 28 days. The relation between fem(t) and fem follows from Expression (3.1).

Poisson’s ratio may be taken equal to 0,2 for uncracked concrete and O for cracked concrete.

Another option to take into account cracked concrete, is to deactivate the option ‘Calculate dependent
values’. This allows you to set any user value for the E modulus.

12 MJ — 08/08/2024



1.2.4. Creep and shrinkage (art 3.1.4)

Creep and shrinkage of the concrete depend on the ambient humidity, the dimensions of the element and the
composition of the concrete. Creep is also influenced by the maturity of the concrete when the load is first
applied and depends on the duration and magnitude of the loading.

The value of the creep coefficient can be set in the concrete settings by using the “Code-based settings” view
or in the 1D member data. If the type input of the creep coefficient is “Auto”, the creep coefficient can be
calculated automatically by inputting the age of concrete and the relative humidity (see annex B.1. in EN 1992-
1-1).

If the type input of the creep coefficient is “User value”, you can directly input the creep coefficient.

IViews: Code-based settings VI View settings « Load default Find National annex: “
Description Symbol Value Default Unit  Chapter Code Structu... CheckT...
<all= ;“::' <all= ,C' =all= ‘C' <all= ,C' c:.“,\"::' <all= ,C' EN 1992-1 3 | <alk= ,C' Solver -

4 3.Materials

4 3.1 Concrete

4 3.1.4 Creep and shrinkage
Age of concrete at the moment considered t 18250.00 8250.00 | day 314B.1-2 |EM1992-1-1 (Al
Relative hurnidity RH 50 314B.12 |EN1992-1-1 Jal
Typeinput of creep coefficient Type@ltto) Auto Aurta 2.1.4(2) EN 1992-1-1 Al

Age of concrete at loading ty 28.00 dan 314(2)B1  EM 1@2-1-1 ol

Consider drying and autogenous shrinkage Type sesltts) Auto Auto 3.1.4(8) EN 1982-1-1 Al
=

Age of concrete at the beginning of drying shrinkage t. 7.00 7.00 da, 3.1.4(6),B2 |EN 1992-1-1 Al

4 5, Structural analysis
> 5.2 Geometric imperfections
4 5.3 Idealisation of the structure
4 5.3.2 Geometric cata
Moment reduction above supports 5322(4) |EN1962-1-1 |Beam.B..|Solver se
> 5.8 Analysis of second order effects with axial load
4 6. Ultimate limit states (ULS)
6.1 Bending with or without axial force
4 6.2 Shear

a_ £ 2 1 Nanaral varificatinn neacadura

OK Cancel
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Note that the concrete member data is automatically added on each 1D and 2D element. It can be accessed
by selecting the entity and going to the extra options below:

|#

1D ME = CONCRETE 1D DATA (1) Q

Alsle HE

Name CMD1D1

Member
Member type  Column s

¥ DESIGN DEFAULTS
REINFORCEMENT
COLUMN

Design of provided reinforcement
Rectangular section Column / Rectangle ]

LONGITUDINAL
Material B 500B o=
MAIN (M)
Type of cover  Auto L)
Diameter [mm] 16,0 i
DETAILING (DET)
Diameter [mm] 10,0 Gt
STIRRUPS (SW)
Material B 500B o=
Diameter [mm] 8,0 i

Number of cuts 2
MINIMUM COVER
Design working life [year] 50,00

B CMD et
Mame CMD1D -
Member BS
Member type Celumn v
4 Design defaults
- Reinforcement
F  Minimum cover

4 Solver setting

4 General

4 Creep and shrinkage
Age of concrete at the moment considered [day] 18250.00
Relative humidity [%] 50

Type input of creep coefficient Auto v
Age of concrete at loading [day] 28.00
Consider drying and autogenous shrinkage Auto v

Age of concrete at the beginning of drying shrinkage [day] 7.00

4 SLS
Use effective modulus of concrete
4 Internal forces

Isolated member
A

Actions

Load default values ===

OK Cancel
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Chapter 1: Materi

ials

(1) The creep coefficient ¢(t,t;) may be calculated from:

@ (th) = g - flt.lo) (B.1)
where:
o is the notional creep coefficient and may be estimated from:
@0 = r * Afem) - Alo) (B.2)
¢RI @ factor to allow for the effect of relative humidity on the notional creep
coefficient:
i IHI00 for fun < 35 MPa (B.3a)
01-yh,
%o [| ! d?!'!ilr:oo a,].a, for fun > 35 MPa (B.3b)

MJ — 08/08/2024

RH is the relative humidity of the ambient environment in %
F(f.) is a factor to allow for the effect of concrete strength on the notional creep
coefficient:

pitn)= l%'i (B.4)

f.n  is the mean compressive strength of concrete in MPa at the age of 28 days
(L) is a factor to allow for the effect of concrete age at loading on the notional

creep coefficient:
1
Blt) = 010 (B.5)
hy is the notional size of the member in mm where:
2
hy = -:I—“f- (B.6)

Ac is the cross-sectional area
is the perimeter of the member in contact with the atmosphere

/Ic(l ty) is a coefficient to describe the development of creep with time after loading,

and may be estimated using the following Expression:
(f L ‘0) Q)
ﬂc('~‘o)=[m] (B.7)

t is the age of concrete in days at the moment considered

L) is the age of concrete at loading in days

t -1t isthe non-adjusted duration of loading in days

Ay is a coefficient depending on the relative humidity (RH in %) and the
notional member size (h, in mm). It may be estimated from:

A =151+ (0,012 RH)""] ho + 250 < 1500 forfn<35 (B.8a)
£ =1,5[1+ (0,012 RH)"] hy + 250 a3 < 1500 aa forf.n, =35 (B.8b)
azrs  are coefficients to consider the influence of the concrete strength:

0.7 0.2 0s
o el

om om
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Where great accuracy is not required, a value found from a figure (Figure 3.1) may be considered as the creep
coefficient, provided that the concrete is not subjected to a compressive stress greater than 0,45 fe (to) at an
age to, the age of concrete at the time of loading.

16
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Figure 3.1: Method for determining the creep coefficient @0, t;) for concrete under
normal environmental conditions
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1.2.5.
For the design of cross-sections, the following stress-strain relationship may be used:
a dc
A
(% R e mmm————— -
rd | A —_——————— =
!
!
foa | A
!
f
7
I
f
/
7/,
_".:m '_".c 0 oz L S
Figure 3.3: Parabola-rectangle diagram for concrete under compression. Figure 3.4: Bi-linear stress-strain relation.
ec2 IS the strain at reaching the maximum strength in the parabola-rectangle diagram
ecuz IS the ultimate strain in the parabola-rectangle diagram
g3 is the strain at reaching the maximum strength in the bi-linear diagram
ecus IS the ultimate strain in the bi-linear diagram
You can choose in the material library which one of the diagrams should be used for the calculation:
4 Stress-strain diagram
Type of diagram Bi-linear stress-strain diagram A
Picture of Stress-strain diagram |Bi-linear stress-straindiagram
Parabola-rectangle stress strain diagram
X

Stress-strain relations for the design of cross-sections (art 3.1.7)

B Bi-linear stress-strain diagram - Concrete: C30/37

- stress[MPa]

| strain[le-4]

Close

8 Parabola-rectangle stress-strain diagram - Concrete: C30/37

- stress[MPa]

MJ — 08/08/2024

| strain[le-4]

Close
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1.3. Reinforcing Steel

The following clauses give principles and rules for reinforcement which is in the form of bars, de-coiled rods,

welded fabric and lattice girders. They do not apply to specially

1.3.1.  Properties (art 3.2.2)

coated bars.

The behaviour of reinforcing steel is specified by the following properties:

¢ vyield strength (fyk or fo,2«)

maximum actual yield strength (fy,max)
tensile strength (f;)

ductility (eu and fi/fy)

bendability

bond characteristics (fr)

section sizes and tolerances

fatigue strength

weldability

The steel properties can be found in the material library:

shear and weld strength for welded fabric and lattice girders

B Materials
= AT E 2 T & e [0 Reinforcementsteel
B 4004 Name
g 5002 4 Code independent

GO0 .
B 4008 Material type
B 500R Thermal expansion [m/mK]
B GOOB Unit mass [kg/m"3]
B 400C E modulus [MPa]
B 500C Poisson coeff.
B 600C

Independent G modulus
G modulus [MPa]

Log. decrement (non-uniform damping only)

B 420B (Austrian ONO...
B 550A (Austrian ONO...

B 5508 (Austrian ONO...
Colour

Specific heat [J/gK]
Thermal conductivity [W/mK]
Bar surface
Order in code
Price per unit [€/kg]
4 EM1992-1-1
Characteristic yield strength fyk [MPa]
Calculated depended values
Characteristic maximum tensile strength ftk [MF
Coefficient k = ftk / fyk [-]
Design yield strength - persistent (fyd = fyk / gar
Design yield strength - accidental (fyd = fyk / ga
Maximum elongation eps uk [1e-4]
Class
Reinforcement type
Fabrication
4 Stress-strain diagram
Type of diagram
Picture of Stress-strain diagram
Edit Delete

New Insert

B 5008

Reinforcement steel
0.01e-003

T850.00
2.0000e+05

0.2

£.3333e+04

0.2
|
6.0000e-01

4.5000e+01

Ribbed ¥
5

1.00

500.0

540.0

1.08

434.3

500.0

500.0

B

Bars ¥

Hot relled ¥

Bi-linear with an inclined top branch ¥

Close

The mean value of density may be assumed to be 7850 kg/ms.

The design value of the modulus of elasticity Es may be assumed to be 200GPa.

This Eurocode applies to ribbed and weldable reinforcement, including fabric.

18

MJ — 08/08/2024



The application rules for design and detailing in this Eurocode are valid for a specified yield strength range, fyk
= 400 to 600 MPa.

Table C.1 gives the properties of reinforcement suitable for use with this Eurocode:

Table C.1: Properties of reinforcement

Product form Bars and de-coiled rods Wire Fabrics Requirement or
guantile value (%)

Class A B C A B C -

Characteristic yield strength 400 to 600 5.0

or fD,2k (MPa)

Minimum value of k = (f/,)« =1,06 =1,08 =115 =1,05 =1,08 =>1,15 10,0
<1,35 <1,35

Characteristic strain at =25 =5,0 =7.5 =25 =5,0 =75 10,0

maximum force, &x (%)

Bendability Bend/Rebend test -

Shear sfrength - 0.3 ATy (Als area of wirg) Minimum
Maximum Nominal

deviation from bar size (mm)

nominal mass <8 +6,0 50
(individual bar >8 +45

or wire) (%)

1.3.2. Design assumptions (art 3.2.7)

For normal design, either of the following assumptions may be made:
B1) an inclined top branch with a strain limit of eus and a maximum stress of kfyk/ ys at euk,
where k = (fi/fy)«.
B2) a horizontal top branch without the need to check the strain limit.

The recommended value of €uq is 0,9 ew. The value of (f/fy)x is given in Table C.1.

O
kf"‘ Tttt """""“""-.-'_'-_--_:-._r-‘:'kf)‘1i
ﬁﬂ:ﬂkf;fs : — i -
B | k= (kIR
Idealised
Design
fy:i/l Es Sud “"uk €

Figure 3.8: Idealised and design stress-strain diagrams for reinforcing steel (for
tension and compression)
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In the material library you can choose between the two assumptions:

B Bi-linear without an inclined top branch - Reinforcement steel: B 5004 X

. stress[MPa)

noe] B . strain[le-4]

Close

1.4.
1.4.1.

B Bi-linear with an inclined top branch - Reinforcement steel: B 3004 X

. stress[MPa]

. strain[le-4]

Close

Durability and cover to reinforcement

Environmental conditions (art 4.2)

Exposure conditions are chemical and physical conditions to which the structure is exposed in addition to the
mechanical actions.

Environmental conditions are classified according to Table 4.1:

20

Table 4.1: Exposure classes related to environmental conditions in accordance

with EN 206-1
Class Description of the environment Informative examples where exposure classes
designation may occur
1 No risk of corrosion or attack
For concrete without reinforcement or
X0 embedded metal: all exposures except where
there is freeze/thaw, abrasion or chemical
attack
For concrete with reinforcement or embedded
metal: very dry Concrete inside buildings with very low air humidity
2 Corrosion induced by carbonation
XC1 Dry or permanently wet Concrete inside buildings with low air humidity
Concrete permanently submerged in water
XC2 Wet, rarely dry Concrete surfaces subject to long-term water
contact
Many foundations
XC3 Moderate humidity Concrete inside buildings with moderate or high air
humidity
External concrete sheltered from rain
XC4 Cyclic wet and dry Concrete surfaces subject to water contact, not
within exposure class XC2
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3 Corrosion

induced by chlorides

XD1 Moderate humidity Concrete surfaces exposed to airborne chlorides
xD2 Wet. rarely dry Swimming pools
Concrete components exposed to industrial waters
containing chlorides
XD3 Cyclic wet and dry Parts of bridges exposed to spray containing

chlorides
Pavements
Car park slabs

4 Corrosion

induced by chlorides from sea water

xs1 Exposed to airborne salt but not in direct Structures near to or on the coast
contact with sea water

X352 Permanently submerged Parts of maring sfructures

XS3 Tidal, splash and spray zones Parts of marine structures

5. Freeze/Thaw Attack

sea water

XF1 Moderate water saturation, without de-icing Vertical concrete surfaces exposed to rain and
agent freezing
XF2 Moderate water saturation, with de-icing agent | Vertical concrete surfaces of road structures
exposed to freezing and airborng de-icing agents
XF3 High water saturation, without de-icing agents | Horizontal concrete surfaces exposed to rain and
freezing
XF4 High water saturation with de-icing agents or Road and bridge decks exposed to de-icing agents

Concrete surfaces exposed to direct spray
containing de-icing agents and freezing
Splash zone of marine structures exposed to
freezing

6. Chemical attack

according to EN 206-1, Table 2

KA1 Slightly aggressive chemical environment Matural soils and ground water
according to EN 206-1, Table 2

XA2 Moderately aggressive chemical environment | Matural soils and ground water
according to EN 206-1, Table 2

XA3 Highly aggressive chemical environment Matural soils and ground water

In the Concrete settings, in the “Design defaults” view, you can choose the desired exposure class. All items
with a blue background colour can be overwritten in the 1D member data.

Concrete settings O *
IViews: Design defaults A IView settings = Load default Find National annex: “
Description Symbol Value Default Unit | Chapter Code Structure ' CheckTy...
=all= P <all P <all> Pl<al PO|<. O <al P <all | <all> O Designe X
4 Designdefaults
> Reinforcement
4 Minimum cover
Design working life 50.00  |50.00 i |44.1.2(5),t..|[EN 1962-1-1 |All (Bea.. |Design d
4 Risk of corrosion attack
Carrosion induced by carbonation Xc3 XC3 4.4.1.2(5) EN1992-1-1 JAll(Eea
Corrosion induced by chlorides MNaone Man 4.4.12(5) EN 1992-1-1 JAll (Eea
Corrosion induced by chlorides from sea water Mone Man 4.4.1.2(5) EMN 1992-1-1 JAll(Eea
Freeze [ thaw attack Mane Man 4412(12) EN1962-1-1 JAll(Eea =
Chemical attack Mone Man 4.4.1.2(12) |EN1922-1-1 JAll [Eea
Risk of abrasion attack Mone Ion 4.4.1.2(13) |EN1982-1-1 JAll [Bea
> Possibility of special control
Risk of casting on atypical surface Standard Standard 4.4.1.3(4) EMN 1992-1-1 |All(Bea.. |Design d
> Concrete characteristics
OK Cancel

MJ — 08/08/2024
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B CMD X

Name CMD1D ~
Member B1
Member type Column v
4 Design defaulis
4 Reinforcement
F Column
4 Minimum cover

Design working life [year] 50.00

4 Risk of corrosion attack
Corrosion induced by carbonation XC3 hd
Corrosion induced by chlorides None v
Corrosion induced by chlorides from sea water None v
Freeze [ thaw attack None v
Chemical attack Nene v
Risk of abrasion attack None v

4 Possibility of special control
Special geometric control
Special concrete quality control
Risk of casting on atypical surface Standard v

Actions

Load default values ===

OK Cancel

1.4.2. Methods of verification (art 4.4)

Concrete Cover: art 4.4.1
+ General (art 4.4.1.1)

The concrete cover is the distance between the surface of the reinforcement closest to the nearest concrete
surface (including links and stirrups and surface reinforcement where relevant) and the nearest concrete
surface.

The nominal cover shall be specified on the drawings. It is defined as a minimum cover, cmin, plus an allowance
in design for deviation, Acdev :
Cnom = Cmin + ACdev

+ Minimum cover, Cmin (art 4.4.1.2)

Minimum concrete cover, cmin, Shall be provided in order to ensure:
o the safe transmission of bond forces
¢ the protection of the steel against corrosion (durability)
e an adequate fire resistance

The greater value for cmin satisfying the requirements for both bond and environmental conditions shall be
used:
Cmin = Max {Cmin,b; Cmin,dur + ACdur;y - ACdur,st - ACdur,add; 10 mm} (4-2)

where:

Cmin,b minimum cover due to bond requirement

Cmin,dur MiNiMum cover due to environmental conditions

Acaury additive safety element

Acaurst reduction of minimum cover for use of stainless steel

ACdur,add reduction of minimum cover for use of additional protection

The recommended value of Acaur,y, ACdur,stand Acdur,add , Without further specification, is 0 mm.
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e In order to transmit bond forces safely and to ensure adequate compaction of the concrete, the

minimum cover should not be less than cminp given in table 4.2.

Table 4.2: Minimum cover, Cminp. requirements with regard to bond

Bond Requirement

Arrangement of bars

Minimum cover Cpnp”

Separated

Diameter of bar

Bundled

Equivalent diameter (¢,)(see 8.9.1)

*_If the nominal maximum aggregate size is greater than 32 mm, Crinp Should be increased by 5 mm.

e The minimum cover values for reinforcement and prestressing tendons in normal weight concrete
taking account of the exposure classes and the structural classes is given by Cmin,dur.

The recommended Structural Class (design working life of 50 years) is S4 for the indicative concrete
strengths (given in Annex E of EN 1992-1-1). The recommended minimum Structural Class is S1.

The recommended modifications to the structural class is given in Table 4.3N:

Table 4.3N: Recommended structural classification

Structural Class
Criterion Exposure Class according to Table 4.1
X0 XC1 XC2/XC3 XC4 XD XD2 /[ XS1|XD3/X52/X53
Design Working Life of | increase | increase increase increase | Increase | increase | increase class
100 years classby 2 |classby 2 | classby 2 [classby 2 |classby 2 | class by 2 by 2
Strength Class 9 = C30/37 | = C30/37 | = C35/45 | = C40/50 | = C40/50 | = C40/50 = C45/55
reduce reduce reduce reduce reduce reduce |reduce class by
classby 1 |classby 1| classby 1 [ class by 1 | class by 1 | class by 1 1
Member with slab reduce reduce reduce reduce reduce reduce |reduce class by
geometry classby 1 (classby 1 | class by 1 | class by 1 | class by 1 | class by 1 1
(position of reinforcement
not affected by construction
procass)
Special Quality reduce reduce reduce reduce reduce reduce |reduce class by
Control of the concrete | class by 1 [class by 1 | class by 1 [ class by 1 | class by 1 | class by 1 1
production ensured

The design working life and the special quality control can be defined in the concrete settings or in

the 1D member data:

MJ — 08/08/2024

Concrete settings O X
IViews: Design defaults hd I View settings « Load default Find National annex: -
Description Symbol Value Default Unit | Chapter Code Structure | CheckTy...
=<all= Pl=alz POf=<al> LPl<al P|=.P <ale O <al L <all> 0| Design e X
4 Designdefaults
> Reinforcement
4 Minimum cover
| Design working life 50.00 year | 4.4.12(5),t.. [EN 1982-1-1 JAll (Bea.. |Design d
4 Risk of corrosion attack
Corrosion induced by carbonation XC3 3 4.4,1.2(5) EN 1552-1-1 |All (Bea [esign de
Corrosion induced by chlarides Mane Mane 4.4.1.2(5) EN 1562-1-1  |All (Bea Design de
Carrosion induced by chlorides from sea water Mane Mane 4.4.1.2(5) EN 1992-1-1 |All (Bea Design de
Freeze / thaw attack None Man 44.1.2(12) |EN152-1-1 |All (Bea.. |Design d =
Chemical attack Mone Mane 4.4.1.2(12) |EN1282-1-1 |All(BEea Design de
Risk of abrasion attack Mone Mane 4.4,1.2(13) |EN1282-1-1 |All (BEea [esign de
4 Possibility of special control
Special geometric cantral 4.4.1.3(3) EMN1992-1-1 |All (Bea.. |Designd
| Special concrete quality control 44.1.2(5) EN 1992-1-1 JAll (Bea... |Designd
Risk of casting on atypical surface Standard Standard 4.4.1.3(4) EMN1992-1-1 |All (Bea... |Designd
> Concrete characteristics
OK Cancel
23
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24

B CMD X

Name CMD1D ~
Member B1
Member type Column v
4 Design defaults
4 Reinforcement
P Column

4 Minimum cover

I Design working life [year] 50.00 I
4 Risk of corrosion attack

Corrosion induced by carbonation XC3 v
Corrosion induced by chlorides None v
Cerrosion induced by chlerides from sea water None v
Freeze | thaw attack Mone w
Chemical attack None v
Risk of abrasion attack None ¥

4 Possibility of special control

Special geometric control

I Special concrete quality control I
Risk of casting on atypical surface Standard v

Actions

Load default values ===

OK Cancel

The recommended values of Cmindur are given in Table 4.4N (reinforcing steel):

Table 4.4N: Values of minimum cover, Cuindur. requirements with regard to durability for
reinforcement steel in accordance with EN 10080.

Environmental Requirement for Cmin,dur {mm)
Structural Exposure Class according to Table 4.1
Class X0 XC1 | XC2/XC3 XC4 XD1/7XS1 | XD2/XS82 | XD3/XS3
S1 10 10 10 15 20 25 30
S2 10 10 15 20 25 30 35
83 10 10 20 25 30 35 40
54 10 15 25 30 35 40 45
S5 15 20 30 35 40 45 50
S6 20 25 35 40 45 50 55

The concrete cover should be increased by the additive safety element Acdur,.

Where stainless steel is used or where other special measures have been taken, the minimum cover
may be reduced by Acaurst. FOr such situations the effects on all relevant material properties should
be considered, including bond.

For concrete with additional protection (e.g. coating) the minimum cover may be reduced by Acduradd.

For concrete abrasion special attention should be given on the aggregate. Optionally concrete
abrasion may be allowed for by increasing the concrete cover (sacrificial layer). In that case, the
minimum cover cmin Should be increased by ki for Abrasion Class XM1, by k2 for XM2 and by ks for
XM3.

Abrasion Class XM1 means a moderate abrasion like for members of industrial sites frequented by
vehicles with air tyres. Abrasion Class XM2 means a heavy abrasion like for members of industrial
sites frequented by fork lifts with air or solid rubber tyres. Abrasion Class XM3 means an extreme
abrasion like for members industrial sites frequented by fork lifts with elastomer or steel tyres or
track vehicles.

The recommended values of ki, k2 and ks are respectively: 5 mm, 10 mm and 15 mm.
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The abrasion class can be inputted in the concrete settings or the 1D member data:

Concrete settings O X
IViews: Design defaults ¥ I[‘u’iew settings v] [ Load default l [ Find ] National annesx: -
Description Symbol Value Default Unit  Chapter Code Structure | CheckTy...
<all> P|<al- O <l Pl<ale P|<.P|<ale  LPl<al  O|<al> L|Design« X
4 Designdefaults
 Reinforcement
4 Minimum cover
Design working life 50.00 50.00 year  (4.4.12(5),t.. |EN1962-1-1 |All(Bea.. |Design de.
4 Risk of corrosion attack
Carrosion induced by carbonation X3 p {oc) 4.4.1.2(5) EM1992-1-1 |All[Bea... |Design de.
Corrosion induced by chlarides Nene Maone 44.1.2(5) EN1962-1-1 |All(Bea.. |Design de.
Carrasion induced by chlorides from sea water Naone Mone 4.412(5) EN1992-1-1 | All (Bea... |Design de.
Freeze [ thaw attack Mone Mone 4412(12) |EMN1992-1-1 |All(Bea.. |Design de. =
Chemical attack Mone Mone 4412(12) |EM1992-1-1 |All(Bea.. |Design de.
I Risk of abrasion attack Mone Mone 4412(13) |EM1992-1-1 |All(Bea.. |Design de
4 Possibmiy of special control
Special geometric control 4.4.1.3(3) EN1992-1-1 |All(Bea.. |Design de.
Special cancrete quality contral 4.4.1.2(5) EM1992-1-1 |All[Bea... |Design de.
Risk of casting on atypical surface Standard Standard 4.4.1.3(4) EN1962-1-1 |All(Bea.. |Design de.
i Concrete characteristics
LENe "] x
Name CMD1D ~
Member B1
Member type Column v
4 Design defaults
4 Reinforcement
t Column
4 Minimum cover
Design working life [year] 50.00
4 Risk of corrosion attack
Corrosion induced by carbonation XC3 b
Corrosion induced by chlorides None hd
Corrosion induced by chlorides from sea water Mone b
Freeze | thaw attack Mone ¥
Chemical attack None h
I Risk of abrasion attack None h I
4 Possibility of special control
Special geometric control
Special concrete quality control
Risk uf Lasling vn alypical surface Standard ¥ v
Actions
Load default values ===
0K Cancel
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The values of ki, k2 and kz are available in the National Annex:

B Concrete setup

Standard EN
E- Concrete
[=)- General
i b Concrete
on-prestressed reinforcement
restressed reinforcement
‘- Durability and concrete cover
5
i General

[=-5LS
i General
: Prestressing
Allowable stress

i Stress limitation during tensioning|
LS stress limitation
iling provisions
ommon detailing provisions
olumns

4 Type of values
MA building
4 Type of functionality
Hollow core beams
Prestressing

4 Concrete

Select all Unselect all Refresh

Name Standard EN A

4 General
4 Concrete
4 MNational annex
B EN_1992_1_1
I Non-prestressed reinforcement
P Prestressed reinforcement
4 Durability and concrete cover
4 MNational annex

4 Clause 4.4.1.2(5)
Formula Tables 4.3N, 4.4N, 4.5N

.

Acyyr,, - additive safety element for concrete cover 4.4.1
Value [mm] 0.0

.

Acyr st - reduction of minimum concrete cover for use o
Value [mm] 0.0

S

Acyyr.add - Feduction of minimum concrete cover for use
Value [mm] 0-0

4 kyp - values of abrasion for classes XM 1,2,3 4.4.1.2(13)
Values [mm] 5-0/10.0 [ 15.0

4 Acy., - value of deviation for concrete cover 4.4.1.3(3)
Walues [mm] 5.0/10.0 5.0

- minimum value of concrete cover 4.4.1.3(4)
Values [mm] 40.0/75.0 /5.0

4 Kk,

'cmin

v

Cancel

= ULS

Load default NA parameters

+

Allowance in design for deviation (art 4.4.1.3)

To calculate the nominal cover, cnom, an addition to the minimum cover shall be made in design to allow for the
deviation (Acdev). The required minimum cover shall be increased by the absolute value of the accepted

negative deviation.

The recommended value of Acdev is 10 mm.

In certain situations, the accepted deviation and hence allowance, Acdev, may be reduced.

The recommended values are:

e where fabrication is subjected to a quality assurance system, in which the monitoring includes
measurements of the concrete cover, the allowance in design for deviation Ac4ev may be reduced:

10 mm 2 Acgev =2 5 mm

e where it can be assured that a very accurate measurement device is used for monitoring and non-
conforming members are rejected (e.g. precast elements), the allowance in design for deviation Acgev

may be reduced:

10 mm 2 Acgev =2 0 mm

26
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The special geometric control can be checked in the concrete settings or the 1D member data:

Concrete settings O *
IViews: Design defaults hd IVl'ew settings v | | Load default Find National annex: “
Description Symbol Value Default Unit  Chapter Code Structure | CheckTy...

<all> Pl=all 2 <all= Pl=all P|=.P|<al PO|=all> O <all- | Designcx
4 Designdefaults
> Reinforcement

4 Minimum cover

Design working life 50.00 50.00 year |44.12(5),t..|EN1962-1-1 |All (Bea.. |Design de...
4 Risk of corrosion attack
Corrosion induced by carbonation Xc3 XC3 4.4.1.2(5) EM 1262-1-1
Corrosion induced by chlorides MNone Mone 4.4.12(5) EM 1962-1-1
Corrosion induced by chlorides from sea water Mone Mane 4.4.1.2(5) EM 1262-1-1
Freeze [ thaw attack Mone Mane 44.12(12)  EM 1982-1-1 -
Chemical attack MNone Mane 4.4.12(12) | EMN1992-1-1
Risk of abrasion attack Mone Mane 44.12(13)  EM 1982-1-1
4 Possibility of special control
|Special geomnetric control 4.4.1.3(3) EN 1952-1-1
Special concrete quality contral 4.4.1.2(5) EM 1962-1-1
Risk of casting on atypical surface Standard Standard 4.4.1.2(4) EM 1962-1-1

- Concrete characteristics

OK Cancel
E7 cmD X
Mame CMD1D ~
Member B1
Member type Column v

4 Design defaults
4 Reinforcement
B Column
4 Minimum cover
Design working life [year] 50.00

4 Risk of corrosion attack

Corrosion induced by carbonation XC3 ¥
Corrosion induced by chlorides None ¥
Corrosion induced by chlorides from sea water None v
Freeze [ thaw attack Mone v
Chemical attack None v
Risk of abrasion attack Mone v
4 Possibility of special control
| Special geometric control |

Special concrete quality control
Risk uf Lasling on alypical surface Standard ¥

Actions

Load default values ===

OK Cancel
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The values of Acdev can be found in the National Annex:

B Concrete setup

4 Type of values
NA building
4 Type of functionality
Hollow core beams
Prestressing

Select all Unselect all

Standard EN
[=- Concrete

=]

=}

- General

i Conerete

Mon-prestressed reinforcement
Prestressed reinforcement
Durability and concrete cover

-ULS
- General
- 5L5
i General
Prestressing
- Allowable stress
Stress limitation during tensioning
5L5 stress limitation
- Detailing provisions
i Common detailing provisions
Columns
Beams

Refresh

4

4

X
Name Standard EN ~
Concrete
General
4 Concrete
4 National annex
P EN_1992_1_1
P Mon-prestressed reinforcement
P Prestressed reinforcement
4 Durability and concrete cover
4 National annex
4 Clause 4.4.1.2(5)
Formula Tables 4.3N, 4.4N, 4.5N
4 Aey,,,, - additive safety element for concrete cover 4.4.1
Value [mm] .0
4 Aey,, 5t~ reduction of minimum concrete cover for use o
Value [mm] 0.0
4 Aey,, add - reduction of minimum cencrete cover for use
Value [mm] 0.0
4 kypy - values of abrasion for classes XM 1,2,3 4.4.1.2(13)
Values [mm] 5.0/ 10.0/15.0
4 Acy,, - value of deviation for concrete cover 4.4.1.3(3)
VM [mm] 5.0/10.0/5.0
4 kg nin - Minimum value of concrete cover 4.4.1.3(4)
Values [mm] 40.0(75.0 /5.0
uLs e

Load default NA parameters

e

28
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Chapter 2: DesignandCheck

2.1 Analysis models

2.1.1 Eurocode

Structural models for overall analysis (art 5.3.1)

The elements of a structure are classified, by consideration of their nature and function, as beams, columns,
slabs, walls, plates, arches, shells etc. Rules are provided for the analysis of the commoner of these elements
and of structures consisting of combinations of these elements.

For buildings the following provisions are applicable:

1) Abeam is a member for which the span is not less than 3 times the overall section depth. Otherwise
it should be considered as a deep beam.

2) A slab is a member for which the minimum panel dimension is not less than 5 times the overall slab
thickness.

3) A slab subjected to dominantly uniformly distributed loads may be considered to be one way
spanning if either:
- it possesses two free (unsupported) and sensibly parallel edges.
- itis the central part of a sensibly rectangular slab supported on four edges with a ratio of the
longer to shorter span greater than 2.

4) Ribbed or waffle slabs need not be treated as discrete elements for the purposes of analysis,
provided that the flange or structural topping and transverse ribs have sufficient torsional stiffness.
This may be assumed provided that:

- therib spacing does not exceed 1500 mm

- the depth of the rib below the flange does not exceed 4 times its width.

- the depth of the flange is at least 1/10 of the clear distance between ribs or 50 mm, whichever
is the greater.

- transverse ribs are provided at a clear spacing not exceeding 10 times the overall depth of
the slab.

The minimum flange thickness of 50 mm may be reduced to 40 mm where permanent blocks are incorporated
between the ribs.

A column is a member for which the section depth does not exceed 4 times its width and the height is at least
3 times the section depth. Otherwise it should be considered as a wall.

2.1.2 SCIA Engineer
+ ASSIGNMENT OF ANALYSIS MODEL

In SCIA Engineer, several types of analysis models are available. It is up to the user to decide which model
should be used for which element.

For 1D members, there is the choice between Beam, Beam slab and Column calculation.

Each element has a property ‘Type’ assigned to it, to determine which type of calculation will be used:

MJ — 08/08/2024 29



Advanced Concept Training — Concrete

A
= MEMBER (1) A
g A
Name B1
Layer Layerl =
Lo column (100) v
Analysis model | general (0)
beam (80)
FEMtype | column (100)
Cross-section | gable column (70)
secondary column (60)
Alpha [deg] rafter (90)
Member system-lineat | purlin (0)
roof bracing (0)
ey [mm
it wall bracing (0)
ez[mm] | girt (0)
Lcs | trusschord (95)
truss diagonal (90)
LCS Rotation [deg] | peam slab (99)
¥ BUCKLING

Quetam lanothe and hiickline cattinoe Nafanlt ~ - _—

The Beam calculation is used for the Types ‘General’, ‘Beam, ‘Rafter’, ‘Purlin’, ‘Roof bracing’, ‘Wall bracing’,
‘Girt’, “Truss chord’ and ‘Truss diagonal’.

The Beam slab calculation is used only for the Type ‘Beam slab’. For this type, by default no shear
reinforcement is added (unless necessary in case of a slab thickness of 200 mm or more, as defined in the
Concrete Settings for slabs). As diameter for the longitudinal reinforcement, the default diameter for 2D
structures — and not for beams! — is taken from the Concrete Settings.

The Column calculation is used for the Types ‘Column’, ‘Gable column’ and ‘Secondary column’.

Also there, you have the choice for the 3 different analysis models, by means of the option “Member type”:

i CMD *

Name CMD1D ~
Member B5S
Member type Beam Ll

4 Design defaults
Col

4 Reinforcement B:aur:.:lab
' Beam [ Rib

P Minimum cover

4 Solver setting
4 General
P Creep and shrinkage
I SLS
P Internal forces
4 Design As
I Beam, Column, Rib, Beam Slab
P Conversion to rebars
P Interaction diagram
' Shear
F Tersion v
Actions
Update support width ===

Load default values  >>>

OK Cancel

The 1D member data overwrite both the element properties and the default settings in the Concrete
settings.
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+ DIFFERENCE BETWEEN BEAM AND COLUMN ANALYSIS MODEL

The most important difference between Beam and Column calculation is the difference in reinforcement area
per direction. A beam has an upper reinforcement area that differs from the lower reinforcement area. A column
always has the same reinforcement configuration for the parallel sides, per direction.

Iy
=

These configurations are obvious, and caused by the difference in dominant internal forces per calculation
type. For a beam calculation the bending moment is dominant, while for a column calculation the axial
compression force + bending moments (if present).

So in fact, when the axial pressure on a beam is too high, you should choose to calculate the element as a
column. In the concrete settings an option is available to consider if the member is in compression or not. If
the member is compressed, the second order effect is taken into account. Go to the Concrete workstation and
“Concrete settings”, on the “Complete setup” view :

Concrete settings O X
IViews: Complete setup Y I View settings « Load default Find National annex: “
Description Symbol Value Default Unit Chapter Code Struc... Check...
=all= Pl<ale PO<al L|<alz O <alb O|<alb L|<.. O|<ale O

4 Designdefaults
> Reinforcement
I Minimum cover
4 Solversetting

4 General

Limit value of unity check Lim.check | 1.0 0 Independ.. All (Be | Salver
Yalue of unity check for not calculated unity check Meal.check | 3.0 2.0 Independ.. Al TEe . Solver
The coefficient fo ulation effective depth of cross-section Coeffy 09 Independ..| Al (Be | Salver
The coefficient for calculation inner lever arm Coeff, 0.9 Independ..| Al (Be | Salver =
I The coefficient for calculation force, where member as under compression | Coeff_, |01 I 0.1 Independ..| Al (Be | Salver
4 Creepandshrinkage =
Age of concrete at the moment considered t 18250.00 825000 | day |3.1.4.B.1-2|EN 19€2-... | All (Be..| Salver
Relative humidity RH 50 3.14B.1-2/EN 1282-... | All (Be..| Solver
Type input of creep coefficient Typegltt..| Auto Auto 3.1.4(2) |EN1992-. All (Be..|Solver
Age of concrete at loading ty 28.00 day |[3.1.42),... [EN 1902-... |All [Be..| Solver
Consider drying and autogenous shrinkage Type s (tts Auto Auto 3.1.4(6) | EMN1902-.. |All (Be. | Solver
Age of concrete at the beginning of drying shrinkage tg 7.00 7.00 day |3.1.4(6),... EN 1902-... |All (Be..|Solver
4 SLS
Llsa sffactiia madulis of cancrata 71021 Eh oo, [AllBe | Sol
OK Cancel

This option ‘The coefficient for calculation force, where member as under compression’ will check how
important the contribution of the axial compression force is:
o |f the axial compression load Ned < 0,1*Ac*fcd, the member is not considered to be in compression,
which means the type ‘Beam’ is the right choice.
¢ If the axial compression load Ned > 0,1*Ac*fcd, the member is considered to be in compression, which
means the beam has to be modelled as type ‘Column’ and the second order effect will be taken into
account.
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2.1.3 Example

100,00
00,00

colurn (100)

Ly 4
T

2m
2m

20 mmA2
%Eﬁ
200 mmA2

Overall Design (ULS)
Linear calculation

Load case: LC2

Coordinate system: Member

Extreme 1D: Member

Selection: Al

Longitudinal required reinforcement

dx

Case  Member

& req+ ABZ req- ASV req+ %v req-

Aﬂ req

~100,00

g g8 &8

Asy req As req ReinfReq
[m] [mm?] [mm?] [mm?] [mm?] [mm?] [mm?2] [mm?]
A req bar+ A, req bar- Asv req bar+ Asv req bar- A req bar Asv req bar As req bar
[ mm 2] [ mm2] [ mm2] [ mm2] [mm2] [mm2] [ mm 2]
Bl 0,000 |LC2 Column 201 201 201 201 402 402 804 |[z]4d16*,
201 201 201 201 402 402 804 |[y]4d16*
B2 0,000 |LC2 Beam 0 0 0 0 0 0 0
0 0 0 0 0 0 0
B3 0,000 |LC2 Beam slab 108 108 108 108 215 215 430 |[z+]2d16*,
201 201 201 201 402 402 804 |[z-]12d16%,
[y+]12416%,
[y-12416*
Shear reinforcement
Name dx Case Member Aswm rea Aswm prov ShearReinf
[m] [mm2/m] [mm?2/m]
Bl 0,000 |LC2 Column 0 0
B2 0,000 |LC2 Beam 0 0
B3 0,000 |LC2 Beam slab 0 0 | Not required

Under internal forces, a warning will be displayed in the detailed output whether it is necessary to calculate an
element as column, to take into account the compression forces. If needed, the type has to be changed

manually to column in the member properties or via 1D member data.

Compression member
Limit axial force to consider member as compression:
Neom = - Coeffoom | fuaAc )= - 0.1 (6.410°.0,09 )= -57.6 kN
Check condition:

Meg < Negm = -T00 kN < -58 kN ..  compression member

(significant compressive normal force). Change type of member to Column.

Warning: First and second order eccentricities should be taken to account, member should be evaluated as column

32
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2.2 Beam design

2.2.1 Description of used example
The example that will be used to explain reinforcement calculation in a beam is called ‘beam.esa’.

The beam reinforcement calculation is explained by means of the following two span beam:

—100,00

‘D“ -27.00

=Dl
1
>H 2700

The length of the total beam is 10m and it has a dimension of 500x300mm.

The inputted loads are:
o BG1: self-weight
e BG2: permanent load
o Line load: -27 kN/m
o Point load: -100 kN at position x = 0,25
e BG3: variable load
o Lineload: -15 KN/m
o Point load: -150 kN at position x =0

2.2.2 Recalculated internal forces

Reinforcement calculation in SCIA Engineer is based on recalculated internal forces. The pure internal forces
calculated by the mechanical FEM calculation are transformed according to code regulation into ‘recalculated
internal forces’ to design the reinforcement.

These recalculated internal forces can be viewed in the Concrete settings of SCIA Engineer.

+ Shifting of bending moments (art 9.2.1.3)

Sufficient reinforcement should be provided at all sections to resist the envelope of the acting tensile force,
including the effect of inclined cracks in webs and flanges.

Additional tensile forces caused by shear and torsion are taken into account in SCIA Engineer by using the
simplified calculation based on shifting of bending moments according to clause 9.2.1.3(2). Shifting of bending
moments is calculated only for beams and beams as slab.

For members with shear reinforcement the additional tensile force, AFw, should be calculated. For members
without shear reinforcement, AFw may be estimated by shifting the moment curve a distance a = d (for beams
as slab). This "shift rule” may also be used as an alternative for members with shear reinforcement, where:

ar=z(cotB-cota)2 (for beams) (9.2)
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The additional tensile force is illustrated in Figure 9.2:

- Envelope of Meq/z + Neq - acting tensile force Fs - resisting tensile force Frs

Figure 9.2: lllustration of the curtailment of longitudinal reinforcement, taking into
account the effect of inclined cracks and the resistance of

reinforcement within anchorage lengths

In SCIA Engineer, you can review the recalculated internal forces. In the Concrete menu it is possible to view
the internal forces and recalculated internal forces. In the figure below the difference is clearly visible:

234, 28 kNm
234,38 kNm

The shifted moment line is taken into account for recalculated internal forces and by this also for the calculation
of longitudinal reinforcement, if activated in the concrete settings (for the global structure) or in the 1D member

data (individually per member):
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Concrete settings O >

IViews: Complete setup hd I View settings + Load default Find National annex: “
Description Symbol Value Default Unit Chapter Code Stru... Chec...
<all= Pl<al Pl<al O|<al> O <al> O|<ale Pl<. O|<a.. O

4 Designdefaults
I Reinforcement
 Minimum cover
4 Solversetting
I General
4 Internal forces
Shear force reduction above supports 62.1(8) |EN1982-1-1 |Eeam
Moment reduction above supports 5322 (4) |[EN 1982-1-1 | Eeam

==

¥

|

|
Shifting of mement curve to cover additional tensile force caused by shear 92.1.3(2) |EN 1992-1-1 II am |
Geometric imperfection in ULS guLs 52(2) EN 1282-1-1 | Colurnn| Solver
Geomnetric imperfection in 5L & sLs 5.2(3) EN 1962-1-1 | Colurmn| Salve
Minirmum eccentricity €min In first @...| In first 6.1(4) EN 1962-1-1 | Colurmn| Salve
First arder eccentricity with the equivalent moment 5.882(2) |EMN1902-1-1 | Column| Salve
Second order eccentricity ey 5.8.8 EN 1962-1-1 | Colurmn| Salve
i Internal forces modifications

Design As

Conwversion to rebars

Interaction diagram

7 v v v

Chaar

OK Cancel

i CMD x

Name CMD1D
Member BS
Member type Beam =
4 Design defaults
P Reinforcement
B Minimum cover
4 Solver setting
4 General
I Creep and shrinkage
[
4 Internal forces
Shear force reduction above supports

Moment reduction above supports

I Shifting of moment curve to cover additional tensile force caused by shear I

Chapter: 9.2.1.3(2)
Code: EN 1992-1-1
P Beam Remark : If the check box is ON, the additional tensile force caused by the shear force is taken into account using the shift rule

Design As

4 Internal forces m

Conversion to rebars
Interaction diagram

Shear

v v v 9

+ REDUCTION OF BENDING MOMENT (art 5.3.5.5 (3) & 5.3.2.2 (4))
Another typical case of recalculated internal forces is the moment capping at supports.

Where a beam or slab is monolithic with its supports, the critical design moment at the support should be taken
as that at the face of the support. The design moment and reaction transferred to the supporting element (e.qg.
column, wall, etc.) should be generally taken as the greater of the elastic or redistributed values.

Regardless of the method of analysis used, where a beam or slab is continuous over a support which may be
considered to provide no restraint to rotation (e.g. over walls), the design support moment, calculated on the
basis of a span equal to the center-to-center distance between supports, may be reduced by an amount AMeq
as follows:

AMeqs = FEd,supt/ 8 (59)
where:
e  Fedsup is the design support reaction
o It is the width of the support
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In SCIA Engineer this reduction of bending moment is only taken into account if it is activated in the concrete
settings (for the global structure) or in the 1D member data (individually per member):

Concrete settings O >
I\-fiews: Complete setup hd IVl'ew settings = Load default Find National annex: “
Description Symbol Value Default Unit | Chapter Code Structu... | CheckT...
<all> Pl<al PO <all> Pl<ale L]<.Pl<al  L<al  L<alr POf<al> L

4 Design defaults
> Reinforcement
= Minimum cover
4 Solversetting
- General

4 |Internal forces

Shear force reduction above supports 6.2.108) EN1962-1-1 |BeamB |
| Moment reduction above supports L L 5322 (4 EN 1992-1-1 JEeam B VEr S .

Shifting of moment curve to cover additional tensile farc... 9.2.1.3(2) EN1982-1-1 |BEeam ki ver se
Geometric imperfection in ULS guLs 52(2) EN 1992-1-1 | Column |

Geometric imperfection in SLS gisLs 52(3) EM 1992-1-1 |Column er s

Minimum eccentricity e In first arder .. [0 first o 6.1(4) EM 1992-1-1 |Column er s

First arder eccentricity with the equivalent moment 5.8.82(2) EM 1962-1-1 | Column i

Second order eccentricity e 588 EN 1992-1-1 |Column er s

> Internal forces medifications

Design As

Interaction diagram

[
- Conversionto rebars
=3
r Shaar

OK Cancel

1 CMD X

Name CMD1D
Member BS
Member type Beam v
4 Design defaults
P Reinforcement
P Minimum cover
4 Solver setting
4 General
P Creep and shrinkage
B SLS
4 Internal forces

Shear force reduction above supports

I Moment reduction above supports I
Shifting of moment curve to cover additional tensile fi Chapter: 5.3.2.2 {4)
Code: EN 1992-1-1
Remark : Bending moment above support is reduced if this item is set ON:
' Beam - for standard support, formula 3.9 is used
- for column support the reduced moment is the same as on the face of the column

4 Internal forces modifications

Design As

Interaction diagram

[
P Conversion to rebars
4
[

Shear

The way in which the moment reduction is performed, is based on the type of support. If a standard support is
defined, the reduction will be done following formula 5.9. If a column is defined, the reduction at the face of the
column is used.

At the face of the column (5.3.2.2 (3)) Using formula 5.9 (5.3.2.2 (4))
Mgq - Mgq 5"4 t
A AT Ed T Edswp g

' F

d, sup

e
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In SCIA Engineer, the width “t”, used for the moment reduction at supports, can be set in the properties of that

support:

4

SUPPORT IN NODE (1)

Name

Type
Angle [deg]

Constraint

X
¥
z

Rt

Ry

Rz

snl
Standard

Sliding ~
Free ~v
Free ~~
Rigid
Free
Free ~

Free ~

| Default size [m]

0.20

w GFOMFTRY

In the bottom of the 1D member data, there is an action button “Update support width”. This button collects all
linked members or supports of the selected member and reads their support widths.

=3
=3

v v ¥ vV v vV v ¥ v v v

OK Cancel

The reduction of moment by moment capping at supports is illustrated for our example below:

e t=0,2m

5] CMD

4 Design defaults

Reinforcement

Minimum cover

4 Solver setting

General

Internal forces
Design As
Conversion to rebars
Interaction diagram
Shear

Torsion

Stress limitations
Cracking forces
Crack width
Deflections

Actions

Name CMD1D
Member BS
Member type Beam

I Update support width === I

Load default values

B

B Supports width

Mame Position [m] Wicth [m] Shear reduction
1 B1 0.000 0.200
Note: The support width is loaded from construction without influence of angle Alpha
Load default 0K

Cancel

b

Mement recluction

o FEd,sup = 477,5|(N
e AMeq =477,5*0,2/8 =11,94kNm
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The original moment My at the support was 254,16 kNm:

—254 18 kNm

234,38 kNm

The recalculated moment clearly shows the shifting of the moment line.

— 254,15 kMNm

é

234,38 khm

With moment capping at support taken into account the recalculated moment is 242,22 kNm.

— 242,22 kN

234,38 khm
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+ REDUCTION OF SHEAR FORCES (art 6.2.1 (8))

For members subject to predominantly uniformly distributed loading, the design shear force does not need to
be checked at a distance less than d from the face of the support. Any shear reinforcement required should
continue to the support. In addition it should be verified that the shear at the support does not exceed VRrd,max.

In SCIA Engineer, this reduction of shear forces is only taken into account if it is activated in the concrete

settings (for the global structure) or in the 1D member data (individually per member):

4 Design defaults
> Reinforcement
I Minimum cover
4 Solversetting
> General

4 Internal forces

Concrete settings O X

Views: Complete setup ¥ |View settings « Load default Find National annex -
Description Symbol Value Default Unit  Chapter Code Structu... CheckT...

=all= 2 <all= 2 <all= Plall O <. 2 <all O <alls B2 =all O <al O

| Shear force reduction above supports 62.1(8) EN 1962-1-1 R Eeam b
b Reduce shear forces Ontheface & Onthefa 6.2.1(8) EM 1962-1-1 |Eeam B
Moment reduction above supports On the face (support/column) deam B -
Shifting of moment curve to cover additional tensile forc... On the face (support/column) + effective depth of cross-section JESIE
Geometric imperfection in ULS guLs 52(2) EM 1992-1-1 |Column
Geometric imperfection in SLS &sLs 52(3) EM 1992-1-1 |Column
Minimum eccentricity B In first order .. In first or 6104 EN 1992-1-1 | Column
First arder eccentricity with the equivalent moment 5.8.82(2) EM 1962-1-1 | Column
Secand arder eccentricity ez 588 EM 1992-1-1 | Column
> Internal forces medifications
- DesignAs
> Conversionto rebars
rIntaractinn diamean
OK Cancel
B CMD
4 Design defaults
I Reinforcement
B Minimum cover
4 Solver setting
4 General
I Creep and shrinkage
I SLS
4 Internal forces
I Shear force reduction above supports
Reduce shear forces On the face (support/column) A
Moment reduction above supports On the face (supportjcolumn)
Shifting of moment curve to cover additional tensile force caused by shear On the face {support/column) + effective depth of cross section
4 Internal forces modifications
P Beam
P Design As
P Conversion to rebars
P Interaction diagram
- Shear
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It is possible to choose the type of reduction of shear forces at the face of the support or at a distance d from
the face of the support:

he f fth | At the face of the column + effective
Atthe face of the column depth of the cross section (based on

.. Ved .. VEd

A i:‘;*' AN

Also for the reduction of shear forces, the support width “t” is taken into account, which is taken from the
properties of the support or the 1D member data. The reduction of shear forces at supports is illustrated for
our example below with t = 0,2 m.

The first image displays the original V::

m

VAN ld

| ? 305.00 kN

—272,50kN

The second image shows the reduction at the face of the support:

m

| ? 168 83 kN

- 266 33kN |

The last image shows the reduction at the effective depth from the face:

W, Hi—

180,33 kN

—247,83kN
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2.2.3 Theoretical reinforcement

+ CONFIGURATION

The theoretical reinforcement is calculated out of the recalculated internal forces. It gives the amount of
reinforcement needed to resist the internal forces induced by ULS loads. Since there are several workflows
possible to design concrete beam elements, the theoretical reinforcement design is not mandatory to perform.
Experienced users can directly jump to practical reinforcement to perform the checks on, but this theoretical
approach gives a good idea of how this practical reinforcement should look like. There are two types of

theoretical reinforcement:

¢ Required reinforcement: The required reinforcement is a numerical value (mm?2) of the reinforcement
that is necessary in every section of the beam.
e Provided reinforcement: The provided reinforcement is a template added to each beam/column
consisting of basic and additional reinforcement.

The configuration of theoretical reinforcement can be found in the Concrete settings, in the “Design defaults”
view. Templates of longitudinal reinforcement and stirrups for different shapes of beam are available. The
concrete cover can be set for upper, lower and side faces.

Concrete settings

IV\ews: Design defaults

hd I View settings v || Load default Fin

Description
=all>
4 Designdefaults
4 Reinforcement
4 Beam/Rib

Rectangular sectien
T section
L section
| section
Other and general
4 Lengitudinal
4 Upper (z+)
Type of cover
Diameter
4 Lower(z’)
Type of caver
Diameter
4 Side (yx)
Type of cover

r_Netailine idet)

Symbol Value

£ =all P <all=

Design of provided reinforcement

Beam_Rec.. ...

Beam_Tse

Beam_Lse... ... |Beam_Ls

Beam_|se.
Beam_Ot

Auto

dg, 16.0

Auto
dsy 16.0

Upper

d

Default

,’] <all>

Unit

Chapter

P <. O <all>

44.1

Code

P <al= yol

Independent
Independent
Independent
Independent
Independent

Independent

EN 1992-1-1

EN 1922-1-1

EN 1922-1-1
EN 1952-1-1

EN 1952-1-1

O x

National annex: -

Structure | CheckType
<al= ) Design de X

OK Cancel

Several default templates for longitudinal reinforcement and stirrups are available for the different section types
(provided reinforcement). These can be adapted or new ones can be made.

7 Provided reinforcement (design)

= -EEb “s AwB
Beam_Rect_Basic_AddList_All
Beam_Rect_Empty
Beam_Rect_Basic_Vertic
Beam_Rect_Basic_Horiz
Beam_Rect_Basic_Add_Vertic
Beam_Rect_Basic_Add_Horiz
Beam_Rect_Basic_AddList_Vertic
Beam_Rect_Basic_AddList_Horiz

Name Beam_Rect_Ba
Description Basic andlista
Member type Beam
Cross-section Rectangle

Mode Standlard

New Insert Edit

Upper

Side

&

Lower

X

Side

OK

This template exists of basic, additional and shear reinforcement. The purpose is to compare these templates
with the required reinforcement, to model the user reinforcement that is introduced later on or to convert it
automatically to user reinforcement.
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= Longitudinal reinforcement

The basic reinforcement is present along the whole length of the beam; the additional reinforcement is present
only at the zones where basic reinforcement is not sufficient to withstand (recalculated) internal forces.

A choice can be made between fixed additional bars (diameter and number) or a list with different numbers of
bars with a fixed diameter. SCIA Engineer uses the least amount of necessary additional bars or places the
maximum if this template is still not sufficient to resist the (recalculated) internal forces. Next to the basic and
additional reinforcement you can also set a diameter for the detailing reinforcement. The detailing
reinforcement is reinforcement that statically is not required but that needs to be added to the cross-section to

fulfil the detailing provisions.

Member Beam — Lengitudinal
| Cross-sectior Rectangle ‘ ‘ w By
| Mode Standard
Basic reinforcement Additional reinforcement Detailing
Upper Edge Diameter  Number Area Type Diameter  Number Area Diameter
[mm] [ [mm*2] [mm] [ [mm*2]  [mm]
| [ Upper 160 i 0 Fix 16.0 i 0
| Sid 16.0 o 0 Fix 16.0 o 0 10,0
Loweer 16.0 a 0 Fix 16.0 a 0
i z
| Side T Side Shear reinforcement
Number of ...  Diameter Spacing/m.. Symmetrical
Max. numb... Type of inp...
- [mm] [mm]
v
3 2 8.0 Multiple 50

Lower

OK Cancel

= Shear reinforcement

For the shear reinforcement the number of cuts, the maximum number of stirrup zones, the diameter and the
spacing can be set. For the spacing different types of input can be used: Multiple and User defined. Multiple
means that the spacing between the stirrups will be the multiple of a set value. With User defined reinforcement
you can set the spacings that can be used. SCIA Engineer will automatically select the spacing depending on
this template and the general settings in the design defaults. The option Symmetrical allows you to define
whether the zones in each span will be symmetrical or not.

Member Beam — Lengitudinal
| Cross-sectior Rectangle ‘ ‘ hd By | By
| Mode Standard
Basic reinforcement Additional reinforcement Detailing
Upper Edge  Diameter MNumber Area Type Diameter Mumber Area Diameter
mm] [mm*2] mm]  H (mm*2]  [mm]
IEm—— Upper 16.0 i 0 Fix 160 0 0
Sid 16.0 0 0 Fix 16.0 (1] o 10.0
Lower 16.0 i} 0 Fix 16.0 a 0
Z
S|de ? S|de Shear reinforcement
Number of ..  Diameter Spacing/m.. Symmetrical
Max. numek... Type of inp...
- [mm] [mm]
"TE 2 Multiple 50

Lower

OK Cancel
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+ CONFIGURATION FOR CONVERSION TO REBARS

The configuration for conversion to rebars can be found in the Concrete settings, in the “Complete setup” view.
Different options are available:

Concrete settings O *
I Views: Complete setup VI View settings « Load default Find National annex: “
Description Symbol Value Default Unit | Chapter Code Structu... CheckType
=all= 2 <all= 2 <all= a2 =l O <all 2 <alls 2 calls O <all= jo.

4 Designdefaults

> Reinforcement

I Minimum cover
4 Solversetting

> General
Internal forces
Design As

Conversion to rebars

[

==

Unify upper reinforcement above middle support Independent | Beam B.. | Solver s¢

Minimum length of long.reinforcement 1000 mrm Independent | 11 [Eea

Unifarmly distributed reinforcement for the column Independent | Calumn

[<J[< Tl ]

Mumber of corrected bars (neighbouring sections) Independent | 10 (Bea

Type of zone for corrected shear reinforcement Geometrical | Geometri Independent | 1D (Bea.. | Solver setti

Interaction diagram
Shear

Torsion

Punching

Stress limitations

vy v v v v v

Cearckine fareee

OK Cancel

= Unify upper reinforcement above middle support

Unifies the number of bars of upper reinforcement at the middle support. The maximum number of bars from
the left and right side of the support are taken into account.

= Minimum length of longitudinal reinforcement

Sets a minimum length for the longitudinal reinforcement.

e .\

X AN
| L2l |

MJ — 08/08/2024 43



Advanced Concept Training — Concrete

= Uniformly distributed reinforcement for the column

Uniform distribution of reinforcement along the whole length of the column, with maximum area from y and z
edges in all sections taken into account.

[] [

= Number of corrected bars (neighbouring sections)

Additional reinforcement is tested in each section for number of bars and diameter in neighbouring sections. If
the additional reinforcement can be distributed to the stirrup links between basic reinforcement bars, the
number of bars and diameter of additional reinforcement is increased to fulfil conditions. The reason for the
correction of the number of bars of additional provided reinforcement is to have logic and symmetrical
reinforcement in the cross-section along the beam.

3$10+2414
3$10+2$18
3410+2¢18
3$10+218
3$10+2418

3410
::: 3410
3§10
3910

391042914

X

= Type of zone for corrected shear reinforcement

None - Zones for shear reinforcement are not created. Conversion of provided reinforcement to real bars is
not possible.

(A) Geometrical — Member is in every span divided geometrically in zones with the same length.

(B) Spacing — Member is in every span divided in zones according to the most occurrent spacing.

(A)

(s, prov,minl) (s,prov,min2)

L1=0,5L L2=0,51

- LE]

-
lizone,1 =zone=xbeg,most x.end,most l,zone,2

(B)

5,prov,most

L

&, provminl )

(5,prov,min}

NN
A

L1=lzone,1 J L2=L-l,zone, 1

A
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+ CALCULATION OF LONGITUDINAL REINFORCEMENT As
The longitudinal reinforcement calculation is based on My recac represented in the previous chapter.

The only thing left to be set in the concrete setup is the material quality and default diameter:

e Material quality is set to B 500A. This can be changed in the project data or concrete 1D member
data.

e The default diameter is set to 16 mm. This parameter is taken from the additional reinforcement
diameter of the reinforcement template under Design defaults, or from 1D member data.

The following results are obtained with these settings:

1470 mm~2

é

1535 mmAZ

In the following image you can see the brief output in the preview:

Longitudinal required reinforcement

Name dx Case Member Asz_req+ Asz_req- Asy_reqg+ Asy_req- Asy_req As_req ReinfReq

[m] [ mm?] [mm?] [mm?] [ mm?] [mm?] [ mm?]

Asz_req bar+ Aszreq bar-  Asy req bar+  Asy_req bar 2 Asy_req bar  As_req bar

[ mm?2] | [ mm?2] [ mm?2] [ mm 2] [ mm?2]

2,333- 0 0 0 0 1335 |[z-17916
0 1407 0 0 1407 0 1407

51 4,833- |ULS |Beam 1470 0 0 0 1470 0 1470 |[z+]8016
1608 0 0 0 1608 0 1608

You can also ask a standard or a more detailed output where you can find more information about certain
parameters used in the calculation, for example about d = lever arm of reinforcement:

d = h — cover — Pstirrup — dlongitudinal beam /2 = 500 — 35 - 8 — 16/2 = 449 mm
(the cover is defined by the environmental class and is 35 mm for XC3)
The only internal force working on this beam is Mys. Na and Ta are zero.
Asy_req = 0 because there is no torsion on this beam.

Note that the detailing provisions are deactivated. Otherwise, no reinforcement of ¢ = 16 mm could be
proposed, since the detailing provisions are not met (bar distance too small).
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If the default diameter is set to 20 mm, the following results are obtained:

1479 mm*2

1343 mmA2

Longitudinal required reinforcement

Name dx Case Member Asz_req+ Asz_req Asy_req+ Asy_req- Asz Asy_req As_req ReinfReq

[m] [mm?] [ mm?] [mm?] [mm?] [mm?] [mm?] [mm?]

Asz_req bar+ Asz_req bar- Asy_req bar+  Asy req bar- Aszreqg bar  Asy reqg bar  As_req bar
[ mm?2] [ mm?2] [ mm?2] [ mm?2] [ mm?2] [mm 2] [ mm?2]

2,333- 0 0 1343 0 [z-15420
0 1571 0 0 1571 0 1571
51 4,833- |ULS Beam 1479 0 0 0 1479 0 1479 ([z+]5420
1571 0 0 0 1571 0 1571

If you take a close look at these results, you can see that also the value for Asreq has changed.
This is because the lever arm d has decreased:
d = h —cover —®stirup — Prongitudinal beam /2 = 500 — 35 - 8 — 20/2 = 447 mm

As you can see, the default diameter has also a slight effect on the amount of reinforcement that is required,
because of the changed lever arm.

Note: 1D member data can be used to change the default diameter for the bar to which these data are
assigned. It is obvious that the 1D member data have higher priority than the Concrete settings.

' CMD X

Mame CMD1D ~
Member BS
Member type Beam v
4 Design defaults

4 Reinforcement

4 Beam / Rib
Design of provided reinforcement
Rectangular section Beam_Rect_Empty [
4 Longitudinal
Material B 500B )
4 Upper (24)
Type of cover User v
User defined concrete cover of upper reinforcement [m 30.0
Diameter [mm] 16.0 ¥
4 Lower (z-)
Type of cover User v
User defined concrete cover of lower reinforcement [mi 30.0
Diameter [mm] 16.0 v
4 Side (y+)
Type of cover Upper ¥
4 Detailing (det)
Diameter [mm] 10.0 ¥
4 Stirrups (sw)
Material B 5008 ¥ .
Actions i
Update support width  >>>=
Load defaultvalues ===
Chapter :4.4.1

Code: EN 1992-1-1
Remark : Information about type of cover of lower reinforcement

OK Cancel

46 MJ — 08/08/2024



Next to the required reinforcement area, also the provided reinforcement can be viewed. Both can be displayed
as a value in reinforcement area (value As or Aswm) or as the amount of bars (value N¢ or Now). Also the
weight of the reinforcement can be shown (value Gl or Gw).

TT+;

RESULTS (1) A X

n <

RESULTS (1) m | x
Name Reinforcement 1D design Bl
Name Reinforcement 1D design
¥ SELECTION

-
Type of selection  All v SELECTION
Type of selection  All v
Filter No v
Filter No v
Results in sections  All v
Results in sections  All v
¥ RESULT CASE
-
Typeof load Combinations o RESULT CASE
Typeof load Combinations '
Combination ULS-Set B (auto) s
Combination ULS-Set B (auto) o
w EXTREME 1D
-
Extreme 1D Global v EXTREME 1D

. Extreme 1D Global s
Type of values v

Type of values v
Values m v
Interval I As.req I/}’ v m %
| As,prov
| Asreq () Interval a
¥ LIMIT STATE CONDITION Aswm,req i As,prov (E)
’ ¥ LIMIT STATE CONDITION
Design ULS | Ne,req Decion ULS :swm,prov
¥ QUTPUT SETTINGS Ne,req (x) g | No,prov
Output | NEwered ¥ OUTPUT SETTINGS Ne,prov (z)
Sk New,prov
| Glreg Output !
v DRAWING SETUP 1D Gw,req  SRANNG SETUR D | Gl,prov
Display value name | Components Gw,prov

§ Display value name | Components
Display values (" —

The option Required — not covered will show the amount of provided reinforcement that is missing. For
example: AAsreq = As,req - Asprov , thus the amount of reinforcement which still has to be added to the template
to resist the (recalculated) internal forces. If Asprov > Asreq , AAsreq = 0

(5]
= RESULTS (1) A X
Name Reinforcement 1D design ]
¥ SELECTION
Type of selection  All W
Filter Ne v
Results in sections  All i

¥ RESULT CASE

Typeofload Combinations v
Combination ULS-Set B (auto) v
¥ EXTREME 1D
Extreme 1D Global v
Type of values || Required - Not covered v
Values m %
interval || A4s.req
| AAs,req (%)
¥ LIMIT STATE CONDITION Ahswm,req
DesignULS | ANe,req
¥ OUTPUT SETTINGS ANow,req
Components

Qutput

- ADAWAKE CETHD 1R

Unity checks can be performed on the provided reinforcement compared to the required reinforcement. This
will give you an idea of the efficiency of the reinforcement.

(&
= RESULTS (1) A X
Name Reinforcement 1D design T
¥ SELECTION
Type of selection  All v
Filter No 2
Results in sections  All ~

> RESULT CASE

Typeofload Combinations v
Combination ULS-Set B (auto) ~
¥ EXTREME 1D
Extreme 1D Global ~
Type of values | Provided - Utilization N
Values N
nterval | UC(As,prov)
UC(Asw,prov)
¥ LIMIT STATE CONDITION As,req
Design ULS | As,req-prov
¥ OUTPUT SETTINGS As,prov
Output Aswm,req
| Aswm,req-prov
¥ DRAWING SETUP 1D Aswm,prov

Display value name | Components
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+ CALCULATION OF SHEAR REINFORCEMENT Aswm

Shear reinforcement

Name dx Case Member  Aqwm req Aswm_prov  ShearReinf

[m] [mm2/m] [mm?2/m]
51 7,333- |ULS Beam 298 309 |$8/325mm,
(ns=2)
51 4,900 |ULS Beam 1315 1340 | $8/75mm,
(ns=2)
VEd = design shear force resulting from external loading
VRd,c = design shear resistance of the member without shear reinforcement
VRd,s = design value of the shear force which can be sustained by the yielding shear reinforcement
Vramax = design value of the maximum shear force which can be sustained by the member, limited
by crushing of the compression struts
In general we can have three cases:
®  VEed > VRdmax Concrete strut failure
® Ved < VRdc Shear force carried by concrete. No shear reinforcement necessary
(minimum shear reinforcement according to detailing provisions)
® VEed > VRrdc and Ved < Vrd,max Shear reinforcement necessary in order that: Ved < Vrd

= Members NOT requiring design shear reinforcement: VEd < VRd,c (art 6.2.2)

VRd,c = [Crd,c k(100 pi fck)ll3 + K1 Ocp] bwd (6.2.a)
with a minimum of:
Vrd.c = (Vmin + K1 Ocp) bw d (6.2.b)
where:
o fex = characteristic concrete compressive strength [MPa]
o k = size factor: k = 1 + V(200/d) < 2,0 (with d in mm)
o D = longitudinal reinforcement ratio: pi = As/bwd < 0,02
e bw = smallest web width of the cross-section in the tensile area [mm]
o Ocp = concrete compressive stress due to loading: ocp = Ned/Ac < 0,2 fed [MPa]
o d = effective height of cross section

The recommended value for Crd,.cis 0,18/ye, that for ki is 0,15 and that for vmin is given by expression:
Vmin = 0,035 K372, f 12 (6.3N)
The shear force Veq, calculated without reduction by B, should always satisfy the condition:
Ved £ 0,5 bw d V fed (6.5)
where v is a strength reduction factor for concrete cracked in shear.

The recommended value for v follows from:

V=06 [12%0] (6.6N)
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In SCIA Engineer, it is possible to input following parameters:

B Concrete setup

4 Type of members
1D
2D
4 Type of values
MNA building
4 Type of functionality
Hollow core beams

Prestressing

Select all Unselect all

Standard EN
B Conerete

Bl General
Concrete
Mon-prestressed reinforcement
i Prestressed reinforcement
Durability and concrete cover

General
‘.. Punching

- General

Prestressing

wable stress

Stress limitation during tensioning
- 515 stress limitation

ailing provisions

Common detailing provisions
Columns

Beams

- 2D structures and slabs
Punching

Refresh

MName Standard EN

4 Concrete

P General

4 ULS
4 General
P Bg=1/x - basic value of inclination 5.2(5)
P Ay 5-8.3.1(1)
' Type of simplified method for analysis second order ef...
* Crd.c
Value[-] 0.18
4 Ky chea - coeff. for calculation Vrd,c 6.2.2(1)
Value [-] ©.15

v v v vV v ¥ v vV 9

¥ min - coeff. for calculation Vrd,c for shear 6.2.2(1)
Formula Formula
v - strength reduction factor for concrete cracked in s...
Formula Formula
k - Coefficient for calculation of longitudinal shear stre...
min - Min. angle between the concrete compression strut
min, prestressed - MiN- angle between the concrete compre
max ~ Max. angle between the concrete compression struf
min_c - Minimal angle between the concrete compression

- Minimal angle between the concrete compression <

max f - Maximal angle between the concrete compression
¥1a - strength reduction factor for concrete cracked in she

va - strensth reduction factor for concrete cracked in she

Load default MA parameters

>

A

v
Cancel

Note: the green values are according to EN code.

= Members requiring design shear reinforcement VEd > VRd,c (art 6.2.3)

The design of members with shear reinforcement is based on the theory of the concrete truss-model. In this
theory, a virtual truss-model is imagined in a concrete beam. This truss-model has a set of vertical (or slightly
diagonal), horizontal and diagonal members. The vertical bars are considered to be the stirrups, the horizontal
bars are the longitudinal reinforcement bars and the diagonal bars are the concrete struts.

/shear reinforcement

compression chord

]

tensile chord
compression strut

The angle 6 should be limited.

The recommended limits of cot 6 are given:

1<cot6=<25
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The angle 6 can be inserted in SCIA Engineer:

Concrete settings O >

Views: Complete setup hd I\ll'ew settings « Load default Find National annex: “
Description Symbol Value Default Unit = Chapter Code Structu... CheckT...

<all Pl=alle O =all Plzall P|<.Pl<al Ll <al  PO|=al O <alx O

4 Designdefaults
- Reinforcement
I Minimum cover

4 Solversetting

I General
- Internal forces
I DesignAs
I Conversion to rebars
I Interaction diagram -
4 Shear
Type calculation/input of angle of compression strut Type B User(angle) User(angle FEEY EN 1962-1-1
Angle of compression strut ;] 40.00 40.00 deg |623 EN 1952-1-1
Cotangent angle of compression strut cot(f) 1.2 1.2 62.3 EM 1962-1-1
Consider effect of axial force in nonprestressed shear che..| Type ag, 62.2(1) EN 1962-1-1
4 Shear betweenweb and flanges -
Type input of angle of compression strut Type & User(angle) User(angle 6.2.4(4) EN 1992-1-1 |[Eeam B.. | Solver se
Angle of compression strut % 40.00 40.00 deg 6.2.4(4) EN1992-1-1 |Eeam.B
Cotangent of angle of compression strut cotlf) 1.2 1.2 6.2.4(4) EN1992-1-1 |Eeam.B

r Tarcinm

OK Cancel

For members with vertical shear reinforcement, the shear resistance Vrd is the smaller value of:

A
VRd,s = % Z fywa cot © (6.8)
and
VRd,max = Gew bw Z V1 fea/(cot © + tan 6) (6.9)
where:
o Asw = cross-sectional area of the shear reinforcement
e s = spacing of the stirrups
o fywd = design yield strength of the shear reinforcement
o VI = strength reduction factor for concrete cracked in shear
® Oew = coefficient taking account of the state of the stress in the compression chord

The recommended value of vi1 is v (see Expression 6.6N)

If the design stress of the shear reinforcement is below 80% of the characteristic yield stress fy, vi may be
taken as:

vi=0,6 for fex < 60 MPa (6.10.aN)
vi=0,9 — fa/200 > 0,5 for fex = 60 MPa (6.10.bN)

The recommended value of acw is 1 for non-prestressed structures.
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These code related parameters can be found in the Concrete setup:

B Concrete setup

4 Type of members
1D
2D
4 Type of values
MNA building
4 Type of functionality
Hollow core beams
Prestressing

Select all Unselect all

Standard EM
[ Conerete

[=]- General
- Concrete
-~ Non-prestressed reinforcement
- Prestressed reinforcement
- Durability and concrete cover
- ULS
- General
= Punching
[=- 5L5
General
Prestressing
- Allowable stress
- Stress limitation during tensioning
- 5LS stress limitation
[=)- Detailing provisions
- Commaon detailing provisions
- Columns
- Beams
- 20 structures and slabs
- Punching

Refresh

MName Standard EN

4 Concrete

> General

4

4

uLs
General
b 8g=1fx - basic value of inclination 5.2(5)
P i 5-8.3.1(1)
P Type of simplified method for analysis second order ef...
" Cpd.c
P Ky sheas - coeff. for calculation Vrd,c 6.2.2(1)
P Vi - coeff. for calculation Vrd,c for shear 6.2.2(1)
P v - strength reduction factor for concrete cracked in s...
Pk - Coefficient for calculation of longitudinal shear stre...

N

N v v 9

.

v v W

8 hin - Min. angle between the concrete compression strut

Value [deg] 21.80
Omin.prestressed ~ Min- angle between the concrete compre
8 o - max. angle between the concrete compression strui

Value [deg] 45.00
8

min.c ~ Minimal angle between the concrete compression

Bmin,t - Minimal angle between the concrete compression s
8, auf - Maximal angle between the concrete compression
vq, - strength reduction factor for concrete cracked in she

Value [-] ©.60
¥4, - strength reduction factor for concrete cracked in she

Formula Fermula
a_, (non-prestressed structures)

Value [] 1.00
a,,, (prestressed structures)

Formula Formula
k - shear calculation factor for plain and lightly reinfo...
kycoefficient for calculation opy .., 6.5.4(4)

ko-coefficient for calculation op, ... 6.5.4(4)

Load default NA parameters

W

If we go back to our example in SCIA Engineer, we find the following Aswmreq for the whole beam:

1315 mmAZfm

Shear reinforcement

A

Name dx Case Member  Aswm_req Aswm_prov ShearReinf
[m] [mm2/m] [mm?2/m]
51 7,333- |ULsS Beam 298 309 | $8/325mm,
(ns=2)
51 4,900 |ULS Beam 1315 1340 | $p8/75mm,
(ns=2)

The maximum value of 1315 mm? corresponds to a two section stirrup of ¢ = 8mm every 75 mm.
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2.2.4 Practical reinforcement

We will now pass on to the level of practical reinforcement. This will allow us to specify the reinforcement

locally over the beam.

In the theoretical reinforcement design, we have calculated where reinforcement is needed.

This allows us to input manually the practical reinforcement by adding New reinforcement for the whole length

of the beam.

We can first select a template for the longitudinal reinforcement:

B Longitudinal reinforcement X

B E a2 O wi

LR_B_R1
LR_B_R2
LR_C_R1 -

e~ 7 N
LR_B_R3 @] O
LR_B_R4

in o onAe

Name LR_B_R1

Description Long. reir

Stirrup nam StirrupR9
Number of | 2
Diameter [m 16.0
Area [mm*2 S04

Type of bear beams an

New Insert Edit Delete OK

Next, we have to decide where the parameters of reinforcement are coming from:

Do you want to use parameters of reinforcement (diameter of long.reinforcement, stirrup and concrete cover)

from the Concrete member data
Ofrom the Design defaults
@from the defined template

OK

The practical reinforcement is shown graphically on the screen:

52
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Chapter 2: Design and Check

As a user, you can add locally New stirrups or New longitudinal bars.

For the stirrups, you can select a certain stirrup shape:

[ Stirrup shape manager *
HHREFE &« O @
StirrupR9
StirrupR10
StirrupR11
StirrupR12
StirrupR13
StirrupR14
StirrupR15
StirrupR16
StirrupR17
Mame StirrupR9
Description Stirrups temg
Number of stirre 1
Diameter [mm] 3.0
Number of cuts 2
| Wew | wnsert | Eait | | oK
The stirrup shape can be edited or a new one can be made. Therefore user points may be added.
Stirrup shape X
Delete || Deleteall
Name S1
Position number 1
Diameter [mm] 2.0
Color I
Number of vertex 4
Closed
Torsion
Shearinjoint Mo
Analysis model Structural mo...
SHEAR CALCULATION
STIRRUP USER DEFINED POINTS Number of cuts 2
[tem-ecige index Type Rela Abse [mm] ‘rom A
- Diameter of mandi 2.5 ~  dss
PCTURe PROPeRTIS
. B2 Draw intersection points
Diameter v Draw corners points
8.0 v _mm < 3 Texts & Points scal 0.5 E
Draw dimensions
[ add J[ peete [ peltean | || Redraw |
. Ok | Cancel |
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For the longitudinal reinforcement, we can define precisely where the extra practical reinforcement needs to
be putted:

842 mm”2

[Paintin 810 of length]|

U A N
o B
4 e
INPUT PANEL & Concrete
= All categories @ All tags ~
Foreeas ToBE0e .

f @EO@ o

The selected zone of the member can be modified by the properties panel or by the menu Library / Concrete,
Reinforcement / Longitudinal Reinforcement Library:

Lengitudinal reinforcement x
Filter All N
o 11-51E4
=
f-—.‘\"
Delete Delete all
Name L2-S1E2 "
3 1 Position numbe 2
Diameter [mm] 16.0
Number of bar: 2
Area [mm~2] 402
Layer type Uniform v
Cover type Surface to v
Cover [mm] 0.0
Left bar Before the v
\_n y OJ Right bar Before the v
T
Stirrup name 51 ¥
L . ] - &
Analysis model Automatic design
LOMGITUNIDAL REINFOR... | NEW REINFORCEMENT PARAMETERS TYPE OF BEAM REINFORCEMENT LAYERS AREA
New layer Number of bars 2 v beams and ribs ) Selected layers 402 mm®™;
Add barsto corners Diameter [mm] 8.0 ¥ All layers 804 mm*™:
SirrupTeme 51 v STIRRUPS PICTURE PROPERTIES
i ot Draw dimensions
; Edit stirrups
Bars positions EigEmiE g M E Texts scale 0.5 *
COLLISION OF BARS i
Collision * Between existing bars
Move laver Cancel
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Here can be set on which face extra reinforcement needs to be added:

Lengitudinal reinforcerment *
Filter All hd
a L1-51E4
= L2-51E2
X
(¢ O
Delete Delete all

MName L3-S1E4 -
Position numbe 7
3 1 Diameter [mm] 20.0
Number of bar: 3
Area [mm”2] 942
Layer type Mo corner v
Cover type Surface to v

Cover [mm] ©.0

Stirrup name S1 v
o & & @ O M— v
7T
Detailing no
- v
Analysis model Automatic design
LOMGITUNIDAL REINFOR... | NEW REINFORCEMENT PARAMETERS TYPE OF BEAM REINFORCEMENT LAYERS AREA
Number of bars 3 ¥ beams and ribs hd Selected layers 942 mm®"
Diameter [mm] 20.0 v All layers 1747 mm™
Stirrup name 51 v STIRRUPS PICTURE PROPERTIES
& ki Draw dimensions
: Edit stirrups
Bars positions [Egeils 4 M E Texts scale 0.5 t
COLLISION OF BARS Redraw
Collision
* Move laver OK Cancel

For reasons of simplicity, we will add 3 bars of 20 mm that are still needed over the whole area where extra
reinforcement is required. This can of course be done more detailed.

The same procedure will be repeated for the upper reinforcement over the support.

Also, the shear reinforcement needs to be increased in the zones over the support. This can be done by
increasing the diameter of the stirrups or by decreasing the distance between the stirrups.

Different stirrup zones can be created:

Stirrups zones x
2x]0d8.0-0.1p0  2x9d8.0-0.300 2x31d8.0-0.100 2x10d8.0-0.277 2x[,1d8.0-0.099
O.Pgmf} 0.050 2,500 0.050 0.004 3.000 0.004 0.004 2500 0.004 0[])886
[zane1 | Minimum stirrup reinforcemeant Text scale =
Zone |Length[m] Diameter [mm] Distance [m] JReal distance [m] Type By user Jistance to begin[m By user Distance toend[m]
one d X b b single v yes v K es d
§°ne? 1 (3 3.000 8.000 0.100 0.100 gl ¥ 0.004 ¥ 0.000

Additional stirrup reinforcement
Symmetrical

Parts from both points
Input type Numbers Diameter [mm] Distance [m] Total distance [m) Type

Newzone | Delete zone Newpart | | Delete part

To check if there is enough shear reinforcement, a capacity check needs to be performed. This will be
explained in the next chapter.
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By selecting the reinforcement it is always possible to change the parameters afterwards through the property
window.

Through view parameter settings a 3D representation of the reinforcement can be obtained:

View parameters setting - Concrete
Lock position

4 m Structure Labels @Model Concre’ce ]rComposite I‘-1odelling_.-'Drawing sAttributes I"r1i5c. ‘u‘iew g

[m] Check / Uncheck all

= | Service
Display on opening the service |7

| Concrete + reinforcement
Display v
Member data v
saT detail data v
Drawing directions for design i
Main reinforcement v
Style of main reinforcement all ;l
Stirrups v
Style of stirrups all -
Mumber of stirrups all -
Color of reinforcement colour by diameters 52
Scheme of reinforcement I_
Reinforcement drawing type 3D ;l
Rounded bends It

ncrete la

Display label v
Mame v
llcar dafinad rainfarramant (il

The total practical reinforcement of the beam is shown below:

A zoomed view shows the 3D representation:
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2.2.5 Conversion of theoretical reinforcement into practical reinforcement

Since SCIA Engineer 19 it is also possible to convert theoretical reinforcement into practical reinforcement. As
mentioned in previous chapter there are two types of theoretical reinforcmeent: Required reinfocement (=
mm2 necessary in each section) and Provided reinforcement (= template of reinforcement with various
ammounts of additional reinforcement possible). It is only possible to convert Provided reinforcement into

practical (=user) reinforcement.
Let's have a look at this example : open beam.esa

Set the template of provided reinforcement.

Provided reinforcement (design) edit - Beam_Rect_Empty

Member Beam — Longitudinal
Cross-sectior Rectangle ‘ ‘ - B, By
Mode Standard =
Basic reinforcement
Upper Edge Diameter Number Area
mm] [ [mm2]
Upper 20.0 2 628
Side 16.0 0 0
p Lower 20.0 2 628

Side - gide Shear reinforcement
Max. numb...
. -

Lower

Number of ...

Additional reinforcement Detailing

Type Diameter Number Area Diameter

[mim] [ [mm”*2]  [mm]
List by n.. 200 01234 0;31436...
Fix 16.0 [i] 0 10.0
List by n... 20.0 0:1;2:34 |[0:314:6...
Diameter Spacing/m... Symmetrical
Type of inp...
[mm] [mm]
8.0 Multiple 50
OK Cancel

Go to Reinforcement design and look at the value As,prov(¢). This is the provided reinforcement that will be

converted into practical reinforcement.

“ Overall Design (ULS)
Values: As,prov (¢b)
Linear calculation
Combination: ULS
Coordinate system: Member
Extreme 1D: Global
Selection: All
Note: Longitudinal reinforcement is o
designed in the centre of the edges of N
the cross-section. Checks use the real
position of the reinforcement. I

20920+ 2020

2020+ 2020

Press ‘Conversion for real bars’

ACTIONS >

@ Refresh

@ Edit provided reinforcement template
@ Concrete setup
I@ Conversion for real bars I

(G Preview
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The following reinforcement is generated.

The practical reinforcement is added as reinforcement data. You can edit the reinforcement by selecting it and
then click on ‘Edit reinforcement’.

ACTIONS
Edit reinforcement I

Now the parts of the reinforcement that needs edditing can be slected. The diameter, number of bars, length,
spacing , ... can be changed in the properties window.

Remark:

It might occur the error message ‘Conversion of reinforcement was not done because the Type of zone
of shear reinforcement is set to ‘None’ in the Design defaults’ appears within the summary after
conversion when converting the provided reinforcement into real bars. This behaviour is caused due to the

option ‘None’ is selected for the setting ‘Type of zone for corrected shear reinforcement’ within the design
defaults.

Summary after conversion

Member  Additional data  Status Explanation
Mat OF,

Conversion of reinforcement was not done because the Type of zone for shear reinforcement iz zet to ‘Mone' in the Design defaults.
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In the example, we will increase the length and diameter of reinforcement area 5.

¥ LONG REINFORCEMENT LAYER
GENERAL

Name Long5
Position number
Type W
Torsional  (@[¥)
BASIC PARAMETERS
No.of bars 2

Diameter [nm] 22.00
Area As [mmA2]
Edge type AV
Material B 600C v
GEOMETRY
Edge
Stirrup
Coord. definition  Absolute “~
Begin[m] 4.00
End[m] 6.00
Length [m]
Edge distance [mm)]
Anchorage length at begin [m]  0.00

Anchorage length atend [m]  0.00
DETAILED INFO
BAR-1
Info

BAR-2

Info

Note that the converted reinforcement cannot be put together with the practical user reinforcement on the
same element. You can either input your own reinforcement template using the first option or convert the
reinforcement template using the second option. In general, it is advisable to use the first option for elements
with a more difficult layout of the reinforcement (multiple reinforcement layers) as this is easier to adjust. For
elements that have a very similar reinforcement layout, the converted reinforcement can be a useful tool.
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2.2.6 Checks

In SCIA Engineer, checks can be performed in three different ways:

1. With practical reinforcement inputted on the member, checks can be done one by one for all sections
of the member

2. With practical reinforcement inputted on the member, overall ULS or SLS checks can be done for a
specific section of the member with the tool “Section check”

3. Without practical reinforcement, overall ULS or SLS checks can be done for a specific section of the
member with the tool “Section Check”. Reinforcement will then be added locally in the Section check
tool to be able to perform the various available checks.

First you get an overview of the input data for the checks:
e Internal forces: displaying the characteristic and design values
e Slenderness: determining if 2"d order effects need be considered (for member type ‘column’)
e Stiffnesses: displaying the values EA, Ely and El;

Available checks at the Ultimate Limit State are:
e Capacity check: for N-My-Mz interaction - based on resistance calculated from interaction diagram
Response check: based on check of ultimate stresses and strains for N-My-Mz interaction
Check of shear and torsion
Check of interaction of shear, torsion, bending and normal force

Available checks at the Serviceability Limit State are:
e Stress limitation (for concrete as well as reinforcing steel)
e Crack width limitation
e Simple check for deflection: based on calculation of stiffness ratio, without necessity to calculate Code
Dependent Deflection (CDD)

There is also an Overall check available. This will simply check all the checks you have activated, but for a
more detailed report, you will need to go into the check itself.

The capacity, response and shear + torsion check should be okay if no additional reinforcement is required.

However, these checks give interesting information on the efficiency of reinforcement. For instance, if in a
section only 50% of reinforcement is used, then we can conclude that here less reinforcement would have
been sufficient.

The detailing provisions and the crack limitation are extra checks that are not accounted in the reinforcement
design. If these checks are not okay, then the practical reinforcement needs to be changed.

In the following chapters, we will explain the checks one by one when practical reinforcement is inputted. It
corresponds to the 15t method to perform a check (see above).

Example 1: beam_practical reinforcement.esa

The last chapter will be focused on the Section check tool, corresponding to 2" and 3 methods to perform a
check (see above).

Example 2: beam_without practical reinforcement.esa

+ CAPACITY RESPONSE

The Capacity - response is based on the calculation of strain and stress in a particular component (concrete
fibre or reinforcement bar).

The check consists of the comparison of those strains and stresses with the limited values according to EN
1992-1-1 requirements.

However, this method does not calculate extremes (capacities of the cross-section) like the interaction diagram
but calculates the state of equilibrium for that section (response).

For capacities of the member, please refer to the “Capacity — diagram” check.

The following checks are performed:
e Check of compressive concrete (cc)
e Check of compressive reinforcement (sc)
e Check of tensile reinforcement (st)
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The Unity Check, UC, displayed on the screen will be the maximum value of those 3 checks.

Example: beam_practical reinforcement.esa

Run the Capacity — Response check in Design > Concrete 1D > ULS response check.

The maximum value of the check is given on the middle support. The Standard output gives:

Beam S1 RECT (500; 300)

ECEN 1992-1-1:2004/AC:2008 Section 26 [dx = 5m]

Member length: L=10m Concrete: C30/37
Bucklingy-y- Ly = 10 m (sway) Bi-linear stress-strain diagram
Buckling 77+ L, =10 m (sway) Exposure class: XC3

— Longitudinal reinforcement: B500A
Bi-linear with an inclined top branch

720 mm (A, = 2199 mm’)
p = 1466 % (17.3 kg/m)
Shear reinforcement: B 500A
z Bi-linear with an inclined top branch
<1_‘ $10/99.7 mm (ng = 2) (Agy = 157 mm:)
y pw = 1.051% (12.4 kg/m) (Asym = 1576 mmZ/m)
Cover (stirrup)

o ® 0 00 5¢20 (1571 mm2)

500

Top: 36 mm
Bottom: 36 mm
L ] (] 2¢20 (628 mm2) Left: 36 mm
Right: 36 mm
300 $10/100 mm, ns=2
Summary of check
Type of Fibre / Eotr  Oear Check Check ucr Limit Status
component  Bar [%c] [MPa] strain[-] stress[-] [-]
Concrete 1|-1.63| -187 0.47 0.93 0.95 1 oK
Reinf. 1] 217 434 0.10 0.95

In the Standard output you can read the UC, and the extreme strain and stress in the studied section.

In the Detailed output you will get all the strains and stresses and the limit strains and stresses:

Extreme values of stress/strain in component

Type of component Fibre/ =z Em O Oiim UC[-] Status
Bar [%0] [%e] [MPal [MPal

Concrete - compression 1 -163 -35 -187 -20 093 OK
Concrete - tension 3 264 0 a 0 000 OK
Reinforcement - compression 3 -1.16  -225 -233 -454 051 oK
Reinforcement - tension 1 217 225 434 454 095 oK

Note that the tensile stress in concrete is not considered, therefore the corresponding UC is O.

Stress and strain diagrams are also available in the Detailed output:

Stress and strain distribution

2.64
;2.17 433.898 LI B B
L
y
&
-1.16, -232.72 [ ] ]
-1.63 -18.67
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Settings that might influence the check:
e Effective depth of cross-section -d

It is usually defined as distance of the most compressive fibre of concrete to center of gravity of tensile
reinforcement. In SCIA Engineer, the effective depth of cross-section is defined as distance of the most
compressive fibre of concrete to position resultant of forces in tensile reinforcement.

oo d'eo o

I

z =383

=445

.

The effective depth d cannot be calculated in the following cases:
¢ The most compressive fibre cannot be determined (the whole cross-section is in tension)
¢ Resultant of forces in tensile reinforcement cannot be determined (whole section is in compression)
¢ Equilibrium is not found
o Distance of the most compressive fibre and Resultant of forces in tensile reinforcement is less than
0,5%h

In those cases, the effective depth is calculated according to formula :

d = Coeffa * hy
With:
e Coeffs by default 0,9 in Concrete settings, in “Complete Setup” view, and in “Solver settings” /
“General”
e h height of cross-section perpendicular to neutral axis
Concrete settings O *
Views: Complete setup ¥ |View settings = Load default Find National annex: “
Description Symbol Value Default Unit  Chapter Code Structu... | CheckT...
=all= L2 <al= 2 <all= a2 <. 20 <all= 2O <al= a2 =al O
4 Designdefaults
I+ Reinforcement
. Minimum cover
4 Solversetting

4 General
Limit value of unity check Lim.check | 1.0 0 Independent |All (Fea lver s
Value of unity check for not calculated unity check Meal.check |20 Independent |All Bea bver

I The coefficient for calculation effective depth of cross-sec..| Coeffy 09 I Independent | All Bea lver
The coefficient for calculation inner lever arm Coeff; 02 Independent |All (Fea lver s -
The coefficient for calculation force, where member asu.. | Coeff_g, 0.1 0.1 Independent | All Bea lver -
4 Creanandchrinkage

e |nner lever arm

z is defined in EN 1992-1-1, clause 6.2.3 (3) as the distance between position resultant of tensile force (tensile
reinforcement) and position of resultant of compressive force (compressive reinforcement and compressive
concrete).

The inner lever arm cannot be calculated in the following cases:
e The most compressive fibre cannot be determined (the whole cross-section is in tension)
e Resultant of forces in tensile reinforcement cannot be determined (whole section is in compression)
¢ Equilibrium is not found

62 MJ — 08/08/2024



In those cases, it is calculated according to formula:

z = Coeff, *d
With:
e Coeff; by default 0,9 in Concrete settings, in “Complete Setup” view, and in “Solver settings” /
“General”
Concrete settings O *
Views: Complete setup ¥ |View settings « Load default Find Mational annex: “
Description Symbol Value Default Unit  Chapter Code Structu... | CheckT..
<all> a2 <all= Plzal 2 <. O a0 <al= a2 =al O
4 Designdefaults
> Reinforcement
. Minimum cover
4 Solversetting
4 General
Limit value of unity check Lim.check | 1.0 0 Independent |All (Fea lver s
Yalue of unity ch r not calculated unity check Meal.check |20 Independent |All (Bea bver
The coefficient for calculation effective depth of cross-sec..| Coeffy 09 Independent | All Bea lver
IThe-:-;-eFfi-:ient for calculation inner lever arm Coeff, 0.9 I Independent |All (Fea lver s -
The coefficient for calculation force, where member asu.. | Coeff g, 0.1 0.1 Independent |All Bea bver
4 Creepandshrinkage

For additional information about this check and the theoretical background, please refer to our web help.
+* CAPACITY DIAGRAM

Capacity - diagram services uses the creation of interaction diagram (graph presenting the capacity of a
concrete member to resist a set of N + My + Mz).

This check calculates the extreme allowable interaction between the normal force N and bending moments My
and Mz.

Example: beam_practical reinforcement.esa

Run the Capacity — Diagram check in Design menu > Concrete 1D > ULS capacity diagram check

The standard output gives the summary result of the check:

Summary of check

N N Nes. M, My, Magy. Mag, UC  Status
Neas M. Mei:  Mao:. Mg
[kN] [kN] [kN] [kNm] [kNm] [kNm] [kNm] [-1
0 0 0 -261 -261 119 -278 0939 oK
0 0 1] 0 0 Meaz Mgz

The Detailed output gives additional info about how the check is performed:

Summary of check
Forces: Ngg=0kN Mg, = -267 kNm  Mgg: = 0kNm
Resistance: Npg = OkN  Mpg, = -278 kNm  Mpg; = 0 kNm

Calculation of unity check

1 1
C= \/ NEdz + ME:;,Z + MEdzz _ '\/ 0% +-2617+0°

u 7=0939 <=1 OK

= -
\} Nes + Mgy + Moz \j 0 +-278 +0°
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Interaction diagrams are also drawn in the Detailed output:

3D interaction diagram - Vertical section N-M,

£
z

-4000 —

My [kNm]

3D interaction diagram - Vertical section N-M;.,

£
Z 4000+

300

Settings that might influence the check:
e Interaction diagram method
e Division of strain

¢ Number of points in vertical cuts

For additional information about this check and the theoretical background, please refer to our web help.
+ SHEAR + TORSION

Check of Interaction shear and torsion consists of three checks according to clause 6.1 - 6.3 in EN 1992-1-1:
e check of shear

e check of torsion
e check of interaction of shear and torsion

This check can be performed if the following conditions are met:
e The material of all reinforcement bars and stirrups are the same

The angle between gradient of the strain plane and the resultant of shear forces is not greater than 15°
e Cross-section with one polygon and one material
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Example: beam practical reinforcement.esa

Run the Shear + Torsion check in Design > Concrete 1D > ULS Shear and Torsion check

Some parts of the beam do not satisfy:

Check shear+torsion (ULS)
Values: UC

Linear calculation
Combination: ULS

Coordinate system: Member
Extreme 1D: Global

Selection: All
(BN
HEA N [ [ [ I TF |
P saatata 11 ) 11 | N

The Standard output allows us to identify which specific check is not satisfied:

Forces
Content of combination: 1.35°LC1+1.35*LC2+1.50°LC3
Meg = 0 kN Meg, = 203 kNm Mzg = 0 kNm Vegy =0 kN Veg = -152 kN Teg= 0 kNm

Resultant of shear force Difference between angles oy and oy

! 1 = )= _ggl=p®
2 2 2 2 oy = abs| oy — oy )= abs(90 - 30)=0
VE:I:'JVE_A,_‘- + Veg ='JD +-152° =152 kN ! ( ! J ( }

Summary of check

d=445mm z=383mm b, =300mm bk, =300mm Vs =878kN Vg

= 66.5 kN Vegnay = 705 kN Vg, = 508 kN

Type of check Forces Resistances UC[-] Status
Check shear Vy+Vz 1517 kN B6.S kN 2.28 Not OK
Check torsion 0.0 khm 0.0 kNm 0.00 0K
Interaction check Vy +Vz+T (concrete) 0.00 oK
Interaction check Vy +Vz+T (shear) 0.0 kN 0.0 kN 0.00 oK
Interaction check Vy +Vz+T (long. reinf) 0.0 kN 0.0 kN 0.00 oK

St y of check 2.28 Not OK

Here the shear forces cause a unity check >1.

In the Detailed output we can read notes, warning and errors about the design. For example, for the shear
forces check not satisfied, the report clearly explains that the shear reinforcement is not sufficient and that we
have to increase it.

Shear check

Check demax
Veg = 152 kN £ Vrgmax & Voeg + Vi = 598 kN

|N01e: The check satisfies for crushing of the compression strut Veg £ Vadmax + Vg + V) |

Check VEdr‘nax
Veg = 152 KN £ Vegmax + Veed + Veg = 705 kN

|N01e: The check satisfies for shear force near the support (Ve £ Vedmax + Vid + Vo). |

Check Vrge and Vrge
Veg = 132 kN = Vpg, = 87.8kN and Wiy = 152 kN = Vg, + Wy + Wiy = 665 kN

Error: The check does not satisfy, because of shear reinforcement (Ve > Vage + Vees + Vaa). It s necessary to increase
area of shear reinforcement or to increase dimensions of the cross-section or quality of shear reinforcement.

Unity check

_ abs(Veg) _ abs(152 kn)

uc
Vg 66,5 kN

=2.28
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Various actions can be done to fix this issue. In this example, we choose to decrease the spacing of the stirrups

in the section where there is an issue.

Select stirrups and click on “Edit stirrups distances” at the bottom of the Properties of the stirrup layers:

REINFORCEMENT LAYER (1)

#
Name
Type of zone
Detailing
Position number
Material
Calculation of cuts number
Number of cuts
Diameter of mandrel dm =x*ds(s), x =

¥ ANCHORAGE

Torsion type
Anchorage L [mm]
Keep formwork

¥ GEOMETRY
Test of overlapping stirrups
Member
Whole length beam/span
Coord. definition
Position x;
Position x,
Origin
v DESCRIPTION POSITIONS
Vertical [m]
SCHEME OF REINFORCEMENT
Horizontal position in X direction [m]
Vertical position in Z direction
ACTIONS >»
@ Edit stirrup shape
(>) Edit covers

(>) Editstirrups distances

™

RL

stirrups

oD

B 500A \/ =

User v

2.00

D v
120.00
@
op,
«©
Rela v
0.000

1.000

From start v/

-0.40

Select “Zone 2” and change the distance between stirrups from 0.3 m to 0.1 m. Apply the same procedure for

“Zone 4” and modify the spacing to 0,2 m:

Stirrups zones

66

);des,o 0% LSle 0-0,100 2x%31d10,0-0,100 2x14d8,0-0,192 2x[1d8.0-0,099
|0,10 | 0,05 2.500 0,050 0,005 3.000 0,005 0,004 2.500 0,004 0{1)&%1
1 1
| Minimum stirrup reinforcement Text scale 1 =
1 Zone | Length [m] | Diameter [mm]| Distance [m] | Real distance [m] Type By user | Distanceto begin [m] | By user  Distance to end [m]
1 2,500 10,000 0,100 0,100 single - yes 0,050 yes 0,050
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We could also have added more stirrups like below:

Stirrup shape X

S1

Delete Delete all

Name S2
oy
3 1 Number of verte 4

Closed @f;
Detailing no
Torsion no

Shear in joint no

= = o v ‘
r: 8
Analysis mo...
SHEAR CALCULATION
STIRRUP USER DEFINED POINTS Numberofcats
New stirrup em-edge inde Type Rela \bso [mm From
Diameter of mand 4 dss
2.Ed, v 0.3 { v
=l RS % Begtn PICTURE PROPERTIES
2 2.Edge Rev 0.300 End v = g
£4 Draw intersection points
Diameter 3 4Edge Re v 0.300 Begin v 2 Draw corners points
< L 4 4Edge Re v 0300 End ¥ Texts &Pointsscz 05 -+
Add Delete Delete all Redraw

OK Cancel

Changing the stirrup shape allows us to keep a bigger distance of 0.2m between stirrups in “Zone 2”.

After modification, the shear + torsion check is satisfied:

N

I EEERNRY TTI] i T [T ””HHHH

PUIRERRZARAL! | LT ﬁ\ HEEEEEEE N l&

Settings that might influence the check:
o Coefficient for calculation of effective depth of cross-section
Default value 0,9 in Concrete settings > Complete Setup view > Solver settings > General
e Coefficient for calculation of inner lever arm
Default value 0,9 in Concrete settings > Complete Setup view > Solver settings > General
e Angle of concrete compression strut
3 types of input in Concrete settings > Solver settings > Shear:

o User (angle) user input of the angle — by default
o User (cotangent) user input of the cotangent
o Auto automatic calculation of the angle fulfilling equation 6.29
Concrete settings m] X
Views: Complete setup ¥ |View settings v | | Load default Find National annex: -
Description Symbol Value Default Unit  Chapter Code Structu... CheckT...
<all> Pl<alr O <al> Plar Ll<.P|<ale Pl<alr Ol<alr O <al> O

4 Designdefaults
P Reinforcement
& Minimum cover
4 Solversetting

- General
& Internal forces
© Designhs
> Conversion to rebars
b Interaction diagram -
4 Shear
» Type calculation/input of angle of compression strut Type @ Userfangle) & URerlangls 623 EN 1992-1-1 |A er
Angle of compression strut a9 Auto deg |623 EN1992-1-1 |4 rer s
Cotangent angle of compression strut cot(f) User(angle] 1 62.3 EN1992-1-1 | All (Bea ver s
Consider effect of axialforcein nonprestressed shear che.. Tupe Userlcotangent) 6.2.2(1) EM 1962-1-1 0
4 Shear betweenweband flanges
Type input of angle of compression strut Type 8 User(angle] | User(angle 6.2.404) EN1992-1-1 |Beam B | Solver s
Angle of compression strut B 40.00 40.00 deg 6.2.404) EN1992-1-1 |Beam.B...|Solver se
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The angle should be between 6min and 6max defined in the NA for EN1992-1-1.

Standard EN k - Coefficient for calculation of longitudinal shear stress resisted by
= C:oncrete Value [-] 0.40
[=- General
i Concrete Bin - Min. angle between the concrete compression strut and the bear
Mon-prestressed reinforcement Value [deg] 21,80
Prestressed reinforcement - -
T d concrete cover Omin.prestressed -~ MiN. angle between the concrete compression strut an
Value [deg] 21,80
B2z - Max. angle between the concrete compression strut and the axis
Value [deg] 45,00
General — -
- Prestressing e,,,i,,_e - Minimal angle between the concrete compression strut and the
[=)- Allowable stress Value [deg] 0,00
-~ Stress limitation during tensioning O min_ - Minimal angle between the concrete compression strut and the
- 5LS stress limitation Val ) d 0.00
[=- Detailing provisions alue [deg] .
.- Commeon detailing provisions 0,3z ¢ - Maximal angle between the concrete compression strut and th
Columns Value [deg] 0,00
B . ~
eams ¥y, - strength reduction factor for concrete cracked in shear (fck<60MF
Value [-] 0,60

e Angle of shear reinforcement
Practical reinforcement can only be introduced at 90°.

e Type for determination equivalent thin-walled cross-section

For additional information about this check and the theoretical background, please refer to our web help.

+ STRESS LIMITATION

Stress limitation is based on the verification of:

compressive stress in concrete - the high value of compressive stress in concrete could lead to
appearance of longitudinal cracks, spreading of micro-cracks in concrete and higher values of creep
(mainly nonlinear). This effect can lead to a state where the structure is unusable.

tensile stress in reinforcement - stress in reinforcement is verified due to limitation of unacceptable
strain existence and thus appearance of cracks in concrete.

Example: beam_practical reinforcement.esa

The stress limitation check is done according to the following steps:
Verification of crack appearance
Verification of the stresses

The Standard output shows those 2 steps:

Verification of cracks in cross-section

Load Type of E: Combi. Ngg Mgy Meg: [ h forer Cracks
module [MPa] [kN] [kNm] [kNm] [MPa] [mm] [MPa] appear
Short  E. 0 Char. 0 -188 0 126 500 29 VES
Stress limitation in concrete
Check type Load MNeg Mesyy, Mes: i zZ [ O im OO Status
[kN] [kNm] [kNm] [mm] [mm] [MPa] [MPa] [-]
§7.2(2) Char. Short 0 -188 0 OFF
§7.2(3) Q.-P. Short 0 -188 0 015 -0.25 -212  -135 1.57 Not OK
Stress limitation in non-prestressed reinforcement
Check type Load Ng; Mg, Me,. v, z; o, O lim oo, Status
[kN] [kNm] [kNm] [mm] [mm] [MPa] [MPa] [-]
§7.2(5) Char. Short 0 -188 0 0.09 0.2 300 400 0.75 0K
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Verification of crack appearance

Crack appearance is verified for characteristic load combination in accordance to chapter 7.1(2) in EN1992-1-
1

o o S<fuaer nocrack appears

o 0O >fuaer crack appears

With:
e Og maximal tensile stress in concrete fibre
o foteff effective concrete tensile strength

Verification of stresses

There are 3 stress limitations checked:
e Occharim S ki *fok  concrete stress under Char. load — 7.2(2) - exposure classes XD, XF, XS
e Ocaplim < K2 * fok concrete stress under Quasi Perm. load — chapter 7.2(3)
e  Oschariim < ks *fyk  reinforcement stress under Char. Load — chapter 7.2(5)

Values of ki, ko, ks, are defined in the NA, standard values are respectively 0.6, 0.45, 0.8

Additionally, when the stress in the reinforcement is caused by an imposed deformation, then the maximal
strength is increased to ks * fyk, where ks is NA parameter with standard value ks = 1,0.

This option can be activated in Concrete settings > Stress limitations:

Concrete settings m} x
Views: Complete setup ¥ |View settings « Load default Find Mational annex -

Description Symbol Value Defa.. U.. Chapt.. Code Stru... Chec.. Remark
=all= Pl <al. O] <al O <. O <al.. 2| <all> 2| <. O] <. O

4 Design defaults
> Reinforcement

& Minimum cover D
4 Solversetting
I General
k X f Kk
I Internal forces 3 y
i DesignAs
- Conversion to rebars
B Interaction diagram = E
> Shear
r Torsion
— k X f k
4 Stress limitations 4 y
p Indirect load (imposed deformation 7.2(3) EN 1922... All (B[ Solver
Stress limit in the reinforcement Auto futo 7.2(5) EN 1992...[ All (.| Solver
b Cracking forces When the stress in reinforcement is caused by the
I Crack width indirect load (imposed deformation) then the stress
& Deflections should not exceed different maximal value
& Detailing provisions

0K Cancel

By default, stress limitation check is done for short-term state.

It is possible to perform a long-term state. Effective E modulus of elasticity is calculated as follows, using the
creep coefficient:

Eceff = Ecm / (1+0)

Long-term behaviour can be activated in Concrete Setting > Complete Setup view > Solver settings > General
> SLS > Use effective modulus of elasticity.
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The creep coefficient can whether be calculated by the software or inputted manually in the Concrete settings.

Concrete settings [m| X
Views: Complete setup ¥ |View settings + Load default Find National annex: “

Description Symbol Value Defa.. U.. Chapt.. Code Stru... Chec... Remark
=all= Pl <a.. Pl <al Pl=. O <a.. 0| <al O <. P|<. O

4 Designdefaults

I Reinforcement

I Minimum cover D
4 Solversetting

4 General

Limit value of unity check L0 1.0 Indepe.. 2R I cm
Walue of unity check for not caleulated.. | Mealc... | 3.0 2.0 Indepe.. 2B |
The co ulation effective... 0.9 Indepe.. AllE |
The coefficient for calculation inner le... 0.9 Indepe.. AR | E
The coefficient for calculation foree, w.. 0.1 0.1 Indepe.. AllTE |
i Creep and shrinkage = E cm
Age of concrete at the moment co.. |t 1825.00 |18250.. day |3.1.4.B.. EN 1962 J Al (B | _
Relative hurmidity RH 50 3148 EN 152 JAllE | 1 + ¢|
Type input of creep coefficient Typeq..| Auta Auto 3.1.4(2) |EM 1992 QA (B I
Age of concrete at loading to 28.00 2800 |day |31.4(2)... EN 1992, JAll (B ! Possibility to use effective E modulus of concrete. It
Consider drying and autogenous s... | Types.[ No Auto 3.1.4(6) |EM 1992 QA0 I means the longterm behaviour of concrete is covered
. SLS in the analysis of the crackwidth and stiffness
b Use effective modulus of concrete 7.1(2) |EN 1992 JAIL(B..| Solve Tz
4 Default sway type
S round y axis Indepe.. 2R I
Sway arcund z axis Indepe.. AlLTE. Sl

I Internal forces

r:_Desien As

oK Cancel

Note: SCIA Engineer is not able to use characteristic or quasi-permanent combinations together in one step.
Therefore, the same forces (load combination) are used for crack appearance and final stress values.

+ CRACK WIDTH
The crack width is calculated according to clause 7.3.4 in EN 1992-1-1.

The following preconditions are used for calculation:
e The crack width is calculated for beams and columns and for general loads (N + My + Mz)
e Cross-section with one polygon and one material is considered in version SEN 17
e The material of all reinforcement bars must be the same in SEN 17
e Appearance of cracks should be calculated for a characteristic combination according to EN 1992-1-1,
clause 7.2(2). A simplification is made in SEN 17 that the normal stress is calculated for the same type
of combination as used for the calculation of crack width, inputted in service Crack control.

Example: beam_practical reinforcement.esa

First a determination whether the section is cracked or un-cracked is performed by comparing:
e Oua<0Oc Uncracked
e Ou>0cq Cracked
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Value for ocr can be set in the Concrete settings > Cracking forces. Two options can influence this value:

Concrete settings
Views: Complete setup

Description

<all>

4 Designdefaults
& Reinforcement
[ Minimum cover

4 Solversetting

¥ |View settings v

Load default

Symbol Value

Defa...

P <al. P <al O] <.

v

v v v w v ww

General

Internal forces
Design As
Conversion to rebars
Interaction diagram
Shear

Torsion

Stress limitations

=

ol

Find

u..

Cracking forces
Type of strength for calculation of crac...| foy o

» Value of strength for calculation cracki

Totm

fotet

v v w

Crack width
Deflections

Detailing provisions

Chapt...

<al... 2

7.1(2)
7.1(2)

m}

National annex _

Code Stru... Chec... Remark

<al- O <. O <.

k. It is possible to select between

occurs in the eross-sec
2] feteff —the first
strength of concreteis reached in the cross-section

jo Value of strength which is used for calculation of first
ears when tensile stress

ears when tensile effective

EN 1992..
EN 1992

x

0K

Cancel

Value of strength for calculation of
e Oc=0MPa

cracking forces:

cracks appear when tensile stress occurs in the section
o 0o = feerf cracks appear when tensile effective strength of concrete is reached in the section

Type of strength for calculation of cracking forces:

If previous option is set on ocr = feterr, Which is the default value then:
o fuef = fum Mmean tensile strength of concrete at 28 days set in the material properties.

° fct,eff = fctm,fl

mean flexural tensile strength (EN 1992-1-1,clause 3.1.8(1)). This value should be

used if restrained deformations such as shrinkage or temperature movements are considering for

calculation crack width.

B Materials
= -8 & el
C30/37

B 50DA
B s00C

a4

Mew Insert Edit

“« o O & A

X

E modulus [MPa] 3-3000e+04 ~
Poisson coeff. ©-2
Independent G medulus
G modulus [MPa] 1.3750e+04

Log. decrement (non-uniform damping only) ©-15

Colour |
Specific heat [J/gk] ©.0000e-01
Thermal conductivity [W/mK] 4.5000e+01

Order in code 5
Price per unit [€/m"3] 1.00
EN 1992-1-1
Characteristic compressive cylinder strength fcl 30.00
Calculated depended values
Mean compressive strength fem(28) [MPa] 38.00
fem(28) - fck(28) [MPa] $.00
I Mean tensile strength fctm(28) [MPa] 2.90 I
fctk 0,05(28) [MPa] 2-00
fctk 0,95(28) [MFa] 3.80

Design compressive strength - persistent (fed =1 20.00
Design compressive strength - accidental (fcd = 25.00
Strain at reaching maximum strength eps c2 [1 20.0

Ultimate strain eps cuz [1e-4] 35.0 v

Close

Note: The value presented in material properties (picture above) is the mean tensile strength at 28 days. If
cracking is expected earlier than 28 days, it is necessary to input this value fem(t) into the material properties

(EN 1992-1-1,clause 3.1.2(9)).
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The check of crack appearance, with values of cracking forces (Ner, Mery, Mcrz) can be read in the Detailed
output:

Material characteristics

Effective strength of concrete: Modulus of elasticity of concrete:
fooot = fotm = 2.9 MPa E.=E.y =33 GPa
Strength in concrete , when crack is appeared:
G = 2.9 MPa
Forces Cross-section characteristics
Content of combination: Type Css-uncracked  Css cracked
LC1+LC2+LC3 tiy [m) 0 0
Characteristic values tiz[m] 6.82.10" -0.117
Nenar = 0 kN Mycnar = -188 kNm  Mzenar = 0 kNm Aj [mﬁ 0.163 0.0533
Quasi-permanent values liy mY 363107 191107
Ngp= O kN Mg, = -188kNm  M_g, = 0 kNm eim' 119107 370-10°

Angle of bending moment resultant

ay = -90°

Calculation of cracking forces (uncracked section)
Maximal stress in concrete
g =12.6 MPa
Cracking forces
= OkN  Mery = -43.3 kNm Mg = 0 kNm
og¢ = 12.6 MPa > o, = 2.9 MPa => Cracks appear

Note: The crack is appeared, because maximal tensile stress is greater than cracking strength.

Here, modulus E is taken for short-term state. As mentioned previously, long-term state with an effective
modulus Eeft can be chosen in Concrete settings > Complete Setup view > General > SLS > Use effective
modulus E.

In this example, cracks appear.
Crack width is then calculated according to EN 1992-1-1, formula 7.8:
W = Srmax * (€sm - €cm)

For further details about the calculation, the Detailed output can be analysed. The following picture shows only
a part of the report:

Maximum crack spacing

Smax = 45 mm < 5%(c+0.5%d.g) = 275 mmor ppes= 0, therefore:

ke ko ka- 0.8 0.5-0.425-0.02
Kkekereq 5, 045, 08:0.5:0425:002 5 @11

Srmax= k- + Dpet 0.0428

Mean strain in the reinforcement

fetest
as — kt- AT+ oE-
T ( Poett J (1+aepper) o.s-cj

Esm_cm = Max E. E } (7.9)
5 2.910°
300-10°-0.46- | —= -(1+6.06-0.0428) 5
0.0428 0.6-300-10
=max f 2 =1.3 %o
200-10° 20010° |
Calculated crack width

W = Esm_cm Srmax = 1.3+ 232=0.303 mm (7.8)

Limit value of crack width

Wnay = 0.4 mm
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Unity check
Calculation unity check

w 0.303 mm
uw==——=———
Wmax 0.4 mm

=0.757

Check crack width

w=0303mm = <wg; =04mm

Note: Check crack width satisfies, because the crack width is lesser than limit value.

Standard output will give the summary values:

Summary of check

Ner=0kN Mey = 433 kN Mez=0kN 0. =300 MPa  Spmax = 232 MM £cmcm = 1.3 %0
i Limit check
Oct e Cracked W Wim UcC [-] imit chec Status
[MPa] [MPa] [mm] [mm] [-1
12.6 2.9 YES 0.303 0.4 0.76 1 oK

The limit value of the crack width wmax is by default automatically calculated according to EN 1992-1-1 (Table
7.1N). The allowable crack width can be seen in the NA setup:

B Manager for National annexes

H-EZEE a2 O BB A

Standard EM

Austrian ONORM-EN NA
Belgian NEN-EN NA
British B3-EN NA

Cypriot CYS-EN NA
eack CEAEN KA

Name Standard EN
National annex Standard EN
References
EN 1990: Basis of structural design
EN 1290 (Basis of structural design)
EN 1991: Actions of structures
EN 1991-1-3 (General actions - Snow loads)
EM 1991-1-4 (General actions - Wind actions)

EN 1992: Design of concrete structures
EN 1992-1-1 (General rules and rules for buildings:l

EN 1992-1-2 (General rules -Structural fire design)
EN 1292-2 (Concrete bridges - Design and detailing rules)
EMN 1168 (Precast concrete products - Hollow core slab)
EN 1993: Design of steel structures
EN 1993-1-1 (General rules and rules for buildings)
EN 1993-1-2 (General rules - Structural fire design)
EN 1993-1-3 (General rules - Supplementary rules for cold-f
FM 1993-1-5 (Plated strurtural elements)
New Insert Edit

OK

MJ — 08/08/2024

73



Advanced Concept Training — Concrete

|87 Concrete setup

4 Type of values Standard EN

NA building B Cé’”é':::ral
4 Type of functionality L. Concrete
- Mon-prestressed reinforcement
- Prestressed reinforcement
- Durabili
=~ ULS

Hollow core beams
Prestressing

and concrete cover

- General

i General
- Prestressing

llowable stress

- Stress limitation during tensioning
i+ 515 stress limitation

Detailing provisions

i Common detailing provisions

- Columns

i Beams

| Select all | | Unselect all | | Refresh |

-

X
Name Standard EN
Concrete
P General
F ULS
4 51S8
4 General
4 National annex
4 K3 grack - coefficient for calculation maximal final crack
Value[-] 3.40
4 Ky crack - coefficient for calculation maximal final crack
Value [] 0.43
4w, ., - for non-prestressed structure 7.3.1(5)
Values [mm] 0.3 /0.4/0.4
P Prestressing
P Allowable stress
P Detailing provisions
| Load default MA parameters ‘ | oK || Cancel |

You can manually input the limiting crack width in the 1D member data:

"l cMD

4 Design defaults

4 Reinforcement

F Beam [ Rib

P Minimum cover
4 Solver setting
General
Internal forces
Design As
Conversion to rebars
Interaction diagram
Shear
Torsion
Stress limitations

v v vV v 9V VY 9 9 9

Cracking forces

Member 51
Member type Beam

Name CMD1D

.

Crack width

Type of maximal crack width User
User defined crack width [mm] 0.300

Deflections

Actions

3>

Update support width

Load default values >=>

OK Cancel
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+
The

Two
[ ]

The

DEFLECTION
calculation of deflection is done according to chapter 7.4.3 from EN 1992-1-1.

kinds of deflection calculations are possible in the software:

Simplified method where the calculation is done twice, assuming the whole member to be uncracked
and fully cracked, and then interpolating formula 7.18 according to clause 7.4.3(7). This is the default
used method.

Code dependent deflection. This is the most rigorous method to calculate deflection by computing the
calculation of curvatures at frequent sections along the member and then calculate the deflection by
numerical integration. More information about this method can be found in the chapter Code dependent
deflections.

calculation procedure for the simplified method can be described in the following steps:

1. Calculation of short-term stiffness using E modulus at 28 days.
2. Calculation of long-term stiffness using effective E modulus based on creep coefficient.

In the current version of the software, it is not possible to distinguish between the short-term and long-
term part of the load in a combination. Therefore, some preconditions have been established for
determination of the long-term part of the load. The long-term part of the load (LongTermPercentage)
is estimated based on the type of combination. There are three main SLS combinations:

e SLS characteristics - LongTermPercentage = 70 %

e SLS frequent - LongTermPercentage = 85 %

e SLS quasi-permanent- LongTermPercentage = 100 %
The creep-factor is calculated by the software depending on the relative humidity, outline of the cross-
section, reinforcement percentage, concrete class, etc. It can also be manually inputted in the
Concrete setup > Complete setup view > General > Creep:

Concrete settings [m] x

Views: Complete setup ¥ View settings v | | Load default Find National annex “
Description Symbol Value Default Unit  Chapter Code Structure CheckTy...

<all> Pl=zal PO <all> Plzal O|=. 0| <al LO=al> Pl zal Of<al O

4 Designdefaults
> Reinforcement
I Minimum cover

4 Solversetting

4 General
Limit value of unity check Lim.check |10 ] Independent | Al (Bea et
Value of unity ch not calculated unity check Mealcheck |20 3.0 Independent | All[Bea et

I

I

The coefficient for calculation effective depth of cross-secti... | Coeff4 09 Independent | Al Bea | Sol
|

I

The coefficient for calculation inner lever arm Coeff, 09 09 Independent | Al Eea et
The caefficient for calculation force, where member as un... | Coeff 20 0.1 0.1 Independent | Al [Eea t i
4 Creep and shrinkage
Age of concrete at the moment considered t 1825.00 250,00 Jda 314B.1-2 |EMN1%82-1-1 | All (Bea lver set
Relative humidity RH 50 314B.1-2 |EMN1992-1-1 | All [Bea lver set
b Typeinput of creep coefficient Type gltto) Auto A Auto 3.1.4(2) EN1992-1-1 | All (Bea.. |Solver -
Age of concrete at loading ty da 3.14(2),B1  |EN1992-1-1 |All (Bea lver set
Consider drying and autogenous shrinkage Type scsl:[,li:m-illln 3.1.4(6) EM1982-1-1 | All (Bea lver set
4 SLS I
Use effective madulus of concrete 7.1(2) EM1992-1-1 |All(Bea.. |Solver s

a4 Default sway type
Sway

Sway around z axis

aroundy axis Independent | AllTEea. | Solver -

Independent |All (Bea.. |Solver
I Internal forces

= Design s

OK Cancel

3. Calculation of stiffness ratios between each state, short and long term.

It is the ratio of linear stiffness of the concrete component divided by the resultant stiffness taking
cracks into account. The calculation of resultant stiffness is based on clause 7.4.3 (3), formula 7.18.
bending stiffness around y-axis (Ely) = 1 / [C/(Ely)n + (1-C) / (Ely)|]
bending stiffness around z-axis (Elz) = 1/ [C/(Elz)u + (1-C) / (Elz)i]
axial stiffness (EA) = 1 / [(C/(EA) + (1-C) / (EA)]
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In this formula (El): is the linear stiffness, (El)u is the stiffness of the cracked element (= long term
stiffness = Ein / 1 + @) and ¢ is the distribution coefficient.

=1-p

2
O'sr

Os

ratio = Stiffnessiin / Stiffnessres, for example ratiouz = Elz,iin/ Elzres

4. Calculation of deflection components
Several components are needed to calculate the total and additional deflection.
In the following part we will note “s” for short term and “I” for long term.
The components are:
. Oin linear (elastic) deflection, 8in = Oiins + Oin
. Oimm immediate deflection, &imm = Oin, - ratios
e  Js short-term deflection, &s = &iins - ratios
e  Oicreep lOng-term deflection + creep, Oicreep = Oiin,i - ratio
o Ocreep creep deflection, Screep = Biin,i - (ratio) - ratios)
° o] Iong-term deflection, o= 6I,creep- 6creep
. 0Oadd additional deflection, dadd = Os + Oicreep - Oimm
e Ot total deflection, Ot = Os + Oicreep
5. Check of deflections

Two deflections are checked:

Total deflection: The appearance and general utility of the structure could be impaired when the

calculated sag of a beam, slab or cantilever subjected to quasi-permanent loads exceeds span/250.
6tot,|im =L/250

Additional deflection: Deflections that could damage adjacent parts of the structure should be limited.
Oadd,iim = L / 500

L is the buckling length multiplied by a B factor of the member in the corresponding direction.

Final unity check is:

Stot dadd

Unity check = max {

Stot, lim ' 8add, [im

The limits of deflection can be changed in Concrete settings > Complete setup view > Deflections:

Concrete settings

Views: Complete setup ¥ |View settings = | | Load default

Description Symbel

=all= L <al
4 Designdefaults

> Reinforcement

E Minimum cover
4 Solversetting

General

v

Internal forces
Design As
Conversion to rebars
Interaction diagram
Shear

Torsion

Stress limitations
Cracking forces
Crack width

Deflections

LY ¥ Y Y Y Y Y YW

Coefficient for increasing the amount of reinforcement Coeff g
=

Find

o]
jo

O

National annex -

Structure | CheckTy...

Pl<al> P <al>

X

Value Default Unit | Chapter Code

=all> Pl<alr O <. O <al> P <al= jo)

=

L0 Independent | All Bea

Maximal total deflection L/x; x = Xtot

Maximal additional deflection L/x; x = Xadd

7.4.104) EN1962-1-1 |1 (Bea
7.4.1(5) EN1962-1-1 |1 (Bea

500.0

Type ol vanable load coefhicient Tor the automatic generatr..

v

Detailing provisions

Use Paiz tactor | Use Peiz | Independent | All (Bea

OK Cancel
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Example: beam practical reinforcement.esa

Look at deflection check for the “SLS qp” combination.

Various results can be displayed on the screen: UC, total and additional deflection or limits for total and
additional deflection.

Open the Standard output for the UC. At position dx = 2,5 m we have the following result:

Basic values of deflections

Type of  Ratio Ratio  &in Smm  8add  Bshot  Biong  Blongicreep  Screep
deflection short[-] long[-] [mm] [mm] [mm] [mm] [mm] [mm] [mm]
Uy 2.88 5.22 0 0 0 0 0 0 0
Uz 2.5 3.38 -3.08 7.7 -2.69 0 -7.7 -104  -2.69

Check of additional and total deflections

Type of L 8add  Oaddim UCadd St Siotim UG ver Limit Status
deflection [m] [mm] [mm] [-] [mm] [mm] [-] [-]

uy 10 0 0 0 0 0 0 0 1 oK
U, 10 -2.69 20 013  -104 -40.1 026 0.26 1 0K

List of errors/warnings/notes: NO

All ratio of stiffnesses and deflection components are resumed in a table.
Open the Detailed output, for the same position dx = 2,5 m.
All previously mentioned steps for the calculation of the deflections can be found here.

For example for the long-term stiffness, we can obtain the long-term part of the loads and the calculated creep
coefficient:

Long-term stiffnesses and curvatures under total load

Settings
Long-term part of applied load = 100%
Creep coefficient ¢ =2.21

Uncracked (state 1) and cracked (state Il) cross section properties are also shown in a table:

Cross-section characteristics
Type of t, 5 A I, I, X Ay e A
1w 1 w1
component [m] [m] [m [m] [m] [m] [m7] [m [m
Linear 0 0 015 313107 113100 025 - -
Uncracked 0 -0.019 0193 46910° 135107 027 157107 e2810° 22107
Cracked 0 0053 0102 28910° 667.10° 0197 157.10° 62810° 22.10°

Check of concrete stresses and calculation of cracking forces
Maximal tensile stress in concrete fibre
Oet=7.76 MPa
Cracking status
et > ferer = 7.76 MPa > 29 MPa => Cracks appear.
Stress in reinforcement for cracking load
Ogr = 99.3 MPa
Stress in reinforcement for acting load
05 = 262 MPa

Distribution coefficient

o1 2] 2 e o1 - 05 [222)]2 e
C—max(ﬂ.'l B [ . ]’)—max(ﬂ.'l 0.5 (262 ]]— 0.928 7.19)

N, My cr M. et fct eff Cracked section Osr o p ( E.
[kN] [kNm] [kNm] [MPa] [MPa] [MPa] [MPa] [-] [-] [GPa]
0 59.6 0 7.76 2.9 YES 99.3 262 0.5 0.928 33
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Which allows to calculate the stiffness’s ratio, for example the bending stiffness’s ratio:
Bending stiffness Ely
Elyjin = Ec-ly = 33-3.13-10° = 103 MNm®
Elyi= Ecerlyi = 10.3-4.69-10° = 48.1 MNm®
Elyn = Eceslyn= 10.3-2.89-10g =29.7 MNm2

1 1 ,
El, = = =30.5 MN+m 7.18
YTTZ T 1-¢ T 0928 1-0928 m 18

+ +
Elyn ~ Ely 297 48.1

El )
RatioEly = E_I{T: = % =0.296

Bending stiffness Elz
Elzfin = Ec-lz = 33-1.13-10° = 37.1 MNm

Elz = Ecet ki = 10.3-1.3510° = 138 MNm®

Bl = Ece bzl = 10.3+667-10° = 6.85 MNm”
Bl = L - ! =791 MNem” (7.18)
L 1-0 0928 1-0828 e
. 0928 1-0528
Ely  Ely 6.85 13.8
e 7
RatioElz = _El;lm = —3?.1 =0.191

And final the short and long-term ratios:

Short-term ratios Long-term ratios
Bending stiffness Ely Bending stiffness Ely
Ratiolys = EEll—l‘ = :;::gﬁ =04 RatioElyl = EElj_*"'“ = % =02%
Bending stiffness Elz Bending stiffness Elz
Ratiolzs = EE||_,,S, : %: 0.347 Ratioklzl = EE'i:h'n - % -0.191
Ratios Ratios
ratio,. =m= 0_;4? =2.88 ratioy, = m = 0,:91 =5.22
ratiog = Rati:Tys = 0..|—4: 2.5 ratiog = Fh;TIyI: 0.2]?: 3.38

Then all deflection components are calculated together with the limit deflections:
Deflections Long-term deflection

Siongy = Slongcreepy— Ocreepy=0—-0=0 mm

Siongz = Stong creepz — Ocreepz = -104 - -2.69 = -7.7 mm

Linear deflection
Sjiny =Uys + Uy =0+0=0mm
Oz = ug ¥ Ug~0+:3.08=-3.08 min Additional deflection

Saday = Oshorty + Olong creepy = Oimmy=0+0~-0=0 mm

Saddz= Sshortz + Slong creepz = Oimmz =0 +-104 - -7.7 = -2.69 mm

Immediate deflection

Simmy = Uy ratioy; = 0-2.88=0 mm

Simmz= Uz ratioe; =-3.08:2.5=-7.7 mm Limit additional deflection
. 5, y=0mm
Short-term deflection e
Ssnorty = Uy *ratioy,s = 0:2.88 =0 mm S L;Tlo;az %: 20 mm

Ssnortz = Uzs *atiogs = 0-2.5 =0 mm

Total deflection

Long-term + creep deflection
9 P . Sroty = Ssnorty + Siongcreepy=0+0=0 mm
énmg creepy= Uy Fatioy, = 0-5.22=0 mm
; Stotz = Senortz + Slong creepz = 0 + -10.4 =-10.4 mm
Siong creepz = Uz * ratiog = -3.08-3.38 =-10.4 mm

Limit total deflection

Creep deflection
” . \ Stottimy =0 mm
Screepy = Uy - ratiou - ratioys )=0- (5.22 - 2.88)=0 mm :
le: _ -10
Screep: = Ua*( ratio - ratios ) =-3.08+ (3.38-25)=-2.69 mm Siotim:z = T ™ 350~ 40 MM

Limitations of the deflection check:

o Deformation caused by shrinkage is not automatically considered.

e Verification based on limiting span / depth ratio according to 7.4.2 is not implemented.

e Calculation of deflection depends on the internal forces used for the reduced stiffness.
Therefore, the check of deflection doesn’t work for cases where the internal forces are equal to
zero but deflections are not zero. Typically, this is the case for a cantilever structure with free
overhang.
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+ DETAILING PROVISIONS

SCIA Engineer distinguishes three types of member with their detailing provisions:
e Beam - verification of longitudinal and shear reinforcement
e Column - verification of main and transverse reinforcement
e Beam slab - verification of longitudinal reinforcement only

All detailing provisions are taken into account automatically in Concrete settings > Complete setup view >
Detailing provisions:

Concrete settings o x

Views: Complete setup *  |View settings = | | Load default Find National annex -

Description Symbol Value Default Unit | Chapter Code Structure CheckTy...
<all= L <al P <ali Dl L|«. O <al D <l P o<l O] <al S
4 Designdefaults

r Reinforcement

b Minimum cover
4+ Solversetting

b General

p Internal forces

b Designis

r Conwersion to rebars

I Interaction diagram

b Shear

b Torsion

b Stress limitations

b Cracking forces

b Crack width

r Deflections

a D\-ummpﬂwisiom
4 Beam | Rib

+ Longitudinal

Check min. bar distance 8212 EN 1952-1-1

Check max. b

Check max. b

2.1101 EM 199 1-1
1 For secandary memb 3.2.1.1(1 EN 155-1-1

Check max. tr

Check min. perce

Check max. perc

r Beamslab
p Column

oK Cancel

Following table shows which checks of detailing provisions are performed:

T DET Longitudinal (main) Shear (transverse)

type

8.2(2) - Minimal clear spacing of bars 6.2.3(3) - Maximal percentage of shear reinforcement
9.2.1.1(1) - Minimal area of longitudinal reinforcement 9.2.2(5) - Minimal percentage of shear reinforcement
Beam 9.2.1.1(3) - Maximal area of longitudinal reinforcement | 9.2.2(6) - Maximal longitudinal spacing of stirrups (shear)
9.2.3(4) - Maximal center-to-center bar distance based | 9.2.2(8) - Maximal transverse spacing of stirrups (shear)

on torsion 9.2.3(3) - Maximal longitudinal spacing of stirrups (torsion)

Code-Independent - Maximal clear spacing

8.2(2) - Minimal clear spacing of bars 9.2.3(3) - Maximal longitudinal spacing of stirrups (torsion)

9.5.2(1) - Minimal bar diameter of longitudinal|9.5.3(1) - Minimal diameter of transverse reinforcement

reinforcement 9.5.3(3) - Maximal longitudinal spacing of transverse
Column | g 5 2(2) - Minimal area of longitudinal reinforcement reinforcement

9.5.2(3) - Maximal area of longitudinal reinforcement
9.5.2(4) - Minimal number of longitudinal reinforcement
bars

Beam |8.2(2) - Minimal clear spacing of bars

Slab 9.3.1.1(3) - Maximal bar distance of longitudinal |-
reinforcement
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- SECTION CHECK

The Section check tools can be used in two different ways: with or without practical reinforcement inputted
beforehand.

Section check can be launched:
¢ In the properties window for an individual check

L INPUT PANEL | & Aluworkstations (&)
| BB All categories v | @ Basic modelling RESULTS (1) ¥
I~ % 1D member ctri+B i Name  Section Check - results
I & Beam v SELECTION
ﬂ* Type of selection  All v
2 v RESULT CASE
i N Typeofload Combinations \/
i*_ Combination ULS v
~ OUTPUT SETTINGS
& _ £ I
— i ﬁ Print combination key
=4 Print checks per section
5 > v CHECKS
ﬁ_ AN ! Capacity-response (ULS)
@ g Capacity-diagram (ULS)
E=1 & & Shear+Torsion (ULS)
I:— s Detailing provision (%)
= n o | ACTIONS >»
A W e ® Refresh |
= ' (® section Check
: Preview
& B
O~ &
mﬁ' ] ULS SHEAR & TORSION CHECK 3
& ® ve o aes
(e i
¢ Inthe properties window for the Section Check — results service
| INPUT PANEL | & Allworkstations (S E
E All categories |‘ Basic modelling RESULTS (1) V]
2 ‘ tri+B i Name  Section Check - results
v SELECTION
Type of selection  All v
! v RESULT CASE
Typeofload  Combinations
< Combination ULS v
v OUTPUT SETTINGS
Q_ fr Output  Brief \/
= N Print combination key
g/ Print checks per section  (@[%)
. v CHECKS
! & Capacity-response (ULS) (@)
Capacity-diagram (ULS)
Shear+Torsion (ULS) @Y
N Detailing provision
ACTIONS >»
® refresh
Section Check
Preview
C- &
- 3

‘0
‘W\\ﬁl P . T ae s

2
Il 1
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= With practical reinforcement

Example 1: beam_practical reinforcement SC.esa

Section check can be opened from all individual checks.

In this example, select Design > Concrete 1D > SLS reinforcement stress limitation check (SLS) and click on
“Section check” in the Properties window:

Select the beam and then click on the position for which the check should be done. Choose section 20 at the
middle of the beam:

E

Multiselect object

The Section check tool opens:

St A
| section : 20

5N %5 0= R

Interval
¥ OUTPUT SETTINGS
Output
Print combination key
v DRAWING SETUP 1D
Display value name
Display values
Display units
Display case
Display section dx
Display combination key
Display combination name
Color scheme
Graph type
Envelopes drawing
Label colour by graph
Drawing plane

Label orientation

§

Brief \/

@@
(oD
«@

[ Q)

SISISIS

Defined by result \/
Filled light

0 to extreme v/
o)

EDRV

Perpendicular to axis \/

¥ ERRORS, WARNINGS AND NOTES SETTINGS

ACTIONS >

@ Refresh

ae () New combination from Combination key
o ®
Q) Preview

Home

Section Check (tool)

T AC M ED W X
} = ’ [ . Save  Cancel
R . &dose &dlose

T

Longitudinal reinforcement Stirrups Application
Section | Info Report Check
ly B @ Grdsze: 100 mm/ | 4 pesmm— g:ck: S";E linkation (515 Checkvalue: () GG o Name Value Status
=T S T aGALE B S) 7 Internal forces (check)
» = _ = _
4 | Section SC1 RECT (500; 300)
EC EN 1992-1-1:2004/AC:2008 Beam S1 [dx = 5 m] 7 Stress limitation (SLS) 089 &
Member length: L=10m Concrete: C30/37 S
Bucklingy-y- L, = 10 m (sway) Bi-linear stress-strain diagram | 0k Yt 6L}
- Buckling z-z1 L = 10 m (sway) Exposure class: XC3 b | Deflection (SLS)
+— Longitudinal reinforcement: B 500A Detailing provisions
R ey Bi-linear with an inclined top branch
- » 8% % @& | s¢20a571mm2) 2 P Extreme
7¢20 mm (A, = 2199 mm°)
i E N0 A Y o) = 1.466 % (17.3 kg/m) Name Value Status
Shear reinforcement: B 500A + SLS/2(SLS) 08 «
Reinforcement (layout) | Reinforcement (free) z Bi-linear with an inclined top branch & | SeES 0 @
Longitudinal 3 g $10/99.7 mm (n, = 2) (As, = 157 mm’)
Y Pw = 1.050 % (12.4 kg/m) (Aswe = 1575 mn]
Diameter
Bar Yimm]  Z[mm]  fmm) Material  Detailing Cover (stirrup)
9 Top: 36 mm
90 195 20 - | Bottom: 36 mm
-%0 195 20 ') o | 2420 (628 mm2) Left: 36 mm
90 -195 20 oA - RightS6mm
% 05 2 “ | 300 $10/100 mm, ns=2
B 45 195 20 B S00A
0 195 20 J0A »
45 195 20 - - d
9 A Overall check status:
N ["8 so0a - = * satisfied 0.89 v
Ready

This window is composed of 3 mains parts:
¢ Definition / modification of the reinforcement
e Preview of the report

e Checks to be performed according to the previous selected combinations or load cases. By default, only
the individual selected check will be performed. You can activate more checks if wanted.

When selecting a SLS combination in the Properties windows, only SLS checks will be available.

When selecting a ULS combination in the Properties windows, only ULS checks will be available.
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In this example, stress limitation in the concrete is not OK. One solution is to redesign the longitudinal
reinforcement to satisfy the SLS stress limitations. We could then close the Section check tool and change the
practical reinforcement for this beam or we can adapt locally the reinforcement in the studied section (Section
19). We will choose to adapt the reinforcement in the Section check tool itself.

When practical reinforcement was already inputted, it can be edited in the tab “Reinforcement (free)”:

Section

T_, El B Grid size:

Reinforcement (layout) ll Reinforcement (free)

Info

100 | mm /

Bar Y [mm] Z [mm]
BO 90 195
B1 -90 195
B2 -90 -195
B3 90 -195
B4 45 195
B5 0 195
B6 -45 195

i?:nnﬁ;er Material | Detailing

20 B 500A

20 B 500A 4
20 B 500A |
20 B 500A

20 B 500A

20 B 500A

20 B 500A M

Each present bar, position and diameter, is listed in the table. They can be modified, deleted or new bars can

be added.

Increase the diameter of top layer bars BO, B1, B4 and B6 from 20 mm to 25 mm:

Section | Info
1y B B crdsize:, 100 | mm/ 4
P e s S Y
FTTeN
B _
L
» w 0 - - -
Reinforcement (layout) | Reinforcement (free)
Longitudinal
8ar Yimm) | Z (mm) g"'"“]"' Malznal‘ Detailing
90 195 2 0A
%0 195 25 T
%0 -195 20
90 195 20
4 95 2
0 95 25
B 45 95 25
New
Ready

Standard -

Check

Check: Stress limitation (SLS) Check value: = Name
Extreme : SLS/2 [SLS] 0.76 «
ternal forces (check)
Section SC1 RECT (500; 300)
EC EN 1992-1-1:2004/AC:2008 Beam $1[dx = 5m] e
Member length: L=10m Concrete: C30/37 : s
Bucklingy-yL- L, = 10m (sway) Bi-linear stress-strain diagram Srack whith SL3)
Buckling z-zL L. = 10m (sway) Exposure class: XC3 b Deflection (SLS)
4 Longitudinal reinforcement: B 500A Detailing provisions
— Bi-linearwith an inclined top branch
‘K N NN 5¢25 (2454 mm2) " Extreme

1|

y

200 $10/100 mm, ns=2

2420 (628 mm2)

2¢20 mm + 5625 mm (A, = 3083 mm°)
pI = 2.055 % (24.2 kg/m) Name
Shear reinforcement: B 500A b SIsR L)
Bi-linearwith aninclined top branch
$10/99.7 mm (n. = 2) (Asy = 157 mm’)

Puw = 1.050 % (12.4 kg/m) (Asum = 1575 mn
Cover (stirrup)

Top: 36 mm

# | SLS/1(5LS)

Bottom: 36 mm
Left: 36 mm
Right: 36 mm

Overall check status:
Satisfied

Value Status

Value Status
076 o
058 o

0.76 &

82
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= Without practical reinforcement

Example 2: beam_without practical reinforcement SC.esa

When no practical reinforcement was inputted beforehand, it is possible to run the section check tool in order
to check a specific section of a member with a local reinforcement on this specific section.

In the Concrete menu, select “Section check results”.

In the properties window, choose the ULS combination to perform all ULS checks:

RESULTS (1)

Name

v SELECTION
Type of selection

4

RESULT CASE

A

Section Check - results

All v

Type of load Combinations -

Combination ULS

4

OUTPUT SETTINGS
Output

Print combination key

Print checks per section

4

CHECK,

Brief v
&«
@

Capacity-response (ULS)
Capacity-diagram (ULS)

Shear+Torsion (ULS)

Detailing provision

&«
&
@
L O

ACTIONS >
Refresh

@ Section Check

Select Section 9, in the middle of the first span.

All checks are not satisfied, and the overall UC is 3. The value 3 means that the check could not be performed
due to an error in the calculation. In this case, it is because there is no reinforcement yet.

We will start by inserting the reinforcement. First choose the reinforcement template:

Home

:

Longitudinal reinforcement

Then change the diameter of the reinforcement template.

mm in the tab “Reinforcement (layout):

Section | Info

«
e

t r T f

For bottom longitudinal bars, change diameter to 20

L EI E Grid size: | 100 | mm / 4
i £d ovzm
- el 2e16 -
LA |
#; i 220 -
b= 2
Reinforcement (layout) fReinforcement (free)
Longitudinal
s Bars Diameter . -
Layer Position Nx o Material Detailing
L top 2 16 B 500A 1
12 bottom | 2 B 500A
Shear
. Diameter Spacing . -
Stirrup | Legs count @ [mm] s [mm] Material Detailing
$1 2-lea 8 200 B 500A M
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Note that it is also possible to define the shear reinforcement in this window.

The results for all ULS checks are now:

Report Check
Ganios—] | CHECRt e 19 et 085 o [Pl
| Internal forces (check)
7| Capacity-response (ULS) 085}
= 7] Capacity-diagram (ULS) 0.81
SeCtlon SC1 RECT (500; 300) 7| Shear+Torsion (ULS) 057
EC EN 1992-1-1:2004/AC:2008 Beam S1[dx = 2.5 m] -
Member length: L=10m Concrete: C30/37
Buckling y—y—L Ly = 10 m (sway) Bi-linear stress-strain diagram
Buckling z-z- L, = 10 m (sway) Exposure class: XC3
“+— Longitudinal reinforcement: B 500A 7| Detailing provisions 0.71
[ (3 2416 (402 mm2) Bi-linear with aninclined top branch =
2¢:16 mm + 2620 mm (A, = 1030 mm?) Bdieme
p| = 0.687 % (8.09 kg/m) [ Name Value
Shear reinforcement: B 500A + ULS/2 (ULS) 0.85
L Bi-linear with aninclined top branc}; [ 5 ULS/ (ULS) 059
8 - $8/200 mm (ns = 2) (Asy = 101 mm°) | Gl — o
Pw = 0.335 % (3.95 kg/m) (Asym = 503 mm
Cover (stirrup)
Top: 25 mm
Bottom: 25 mm
Left: 25 mm
| (] [ ) 2¢20 (628 mm2) Right: 25 mm

300 " $8/200 mm, ns=2
*I%'/ 5

< n

Once the section is reinforced and checks are satisfied, you can save the design of this section with the option

“Save and close”:
| EH | X

Restore Save Cancel
default | & close | & close

| Application

A label will then be added on the beam:

>

It is possible to run the Section check for SLS combination as below:

(E1]

T¥T

RESULTS (1)

Name Section Check - result:

DR

x

P
=

O

=2
I3

x

18

ey
;E:ﬁ-u@@?@ &

Q 211}

If required, Section check tool can still be opened to redesign the section to satisfy the SLS checks by clicking
on Section check in the Properties window.
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2.3 Column design

2.3.1 Reinforcement design methods

For column design, there are 3 types of calculation:
e Axial compression only
e Uniaxial bending
¢ Biaxial bending

When taking a closer look at the column calculation, 2 different approaches can be distinguished:
e For the ‘Axial compression only’ and ‘Uniaxial bending’ calculation, SCIA Engineer uses the same
computing heart as for beams.
o For ‘Biaxial bending’ calculations, SCIA Engineer uses a combination of the computing heart for beams
and the so-called interaction formulas.

Furthermore, the uniaxial bending calculation always has as result a 1-directional reinforcement configuration,
with the same number of reinforcement bars at parallel sides.

The biaxial bending calculation has as result a 2-directional reinforcement configuration. The number of bars
may differ per direction, but is always the same for parallel sides:

As1 As1

As2
|

The uniaxial bending calculation is a relatively simple calculation type, while the biaxial bending calculation
requires an iterative process.

Keep this in mind as the reason why the uniaxial bending calculation will go a lot faster.
+ DESIGN WITH AXIAL COMPRESSION ONLY

F

l

\j

rrr7

= No reinforcement required: Neq < Nrg

Example: Axial compression only.esa

Studied column: B1

Geometry

Column cross-section: RECT 350x350 mm?2
Height: 4,5 m

Concrete grade: C45/55
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Concrete Setup

Item Concrete settings > Internal forces ULS: ‘eccentricities’ are not taken in account.

Concrete settings
Views: Internal forces ¥ |View settings «

Description
=all>
4 Solversetting
4 Internal forces
Shear force reduction above supports

Mament reduction above supports

Load default

Symbol

P <al=

Shifting of mement curve te cover additional tensile forc...

Geometric imperfection in ULS
Geometric imperfection in 5LS
Minimum eccentricity

SiuLs
SisLs

Smin

p First order eccentricity with the equivalent moment

Second arder eccentricity
4 Internal forces modifications
Limit ratio for uniaxial methad
> Beam

4 Calumn

Plim

Find

Value Default

Unit  Chapter

S =all= Pl <al O| <. O <al>

In first order .J1n first or

0.10 0.10

62.1(8)
53232 (4)
9.2.13(2)
52(2)
52(3)
6.1(4)

e

Code

<all> 2 =zal= O Interna X

EN 12962-1-1
EN 1962-1-1
EN 1992-1-1
EN 1562-1-1
EN 1562-1-1
EN 1562-1-1
EN 1962-1-1
EN 1962-1-1

Independent

National annex: “

Structu,

[m] x

. CheckT...

==

The Detailing provisions are not taken in account, in order to view the pure results (according to the Eurocode,
always a minimum reinforcement percentage must be added).

Concrete settings

Views: Complete setup ¥ |View settings =

Description

<all=
P OLTacK WITKn

i Deflections
4 Detailing provisions
r Beam [Rib
> Beam slab
4 Column
4 Longitudinal
Check min. bar distance
Check max. bar distance
Check max. bar distance (torsion)
Check min. reinforcement area
Check max. reinforcement area
Check min. bar diameter
Check min. number of bars
4 Transverse
Check max. percentage of stirrups
Check min. mandrel diameter
Check max. longitudinal spacing

p  Check min. bar diameter

Load default

Symbol

’C] <all=

Find

Value Default

2 =all= Pl <al>

Unit  Chapter

L <. O <al>

P

Code

=all= Ll <ale O <all> O

EN 1962-1-1

Independent |

EN 1962-1-1
EN 1862-1-1
EN 1962-1-1
EN 1862-1-1
EN 1962-1-1

EN 1962-1-1
EN 1862-1-1
EN 1962-1-1
EN 1862-1-1

Mational annex: -

Structu

O X

«. CheckT...

VEl S >

OK Cancel

Loads

e LC1: Permanent load > F = 1100 kN
e LC2: Variable load > F = 1000 kN

This means the column is loaded with a single compression force.

Combination according to the Eurocode:

ULS Combination =1,35* LC1 + 1,50 * LC2

Design normal force Neds = 1,35 * 1100 + 1,50 * 1000 = 2985kN

86
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Bar diameter

The bar diameter is taken from the Concrete Settings > Complete setup View, or from 1D member data if
applied (1D member data always overwrite the Concrete Settings data, for the specific member they are

assigned to).

Concrete settings O *
Views: Complete setup ¥ |View settings = Load default Find National annex: “
Description Symbol Value Default Unit | Chapter Code Structu... CheckT...
=all= L <al O <all> P salle O =l O el O =all L) <al O <al O
4 Designdefaults
4 Reinforcement
> Beam [Rib
- Beamslab
4 Column
Design of provided reinforcement Independent | Column
Rectangular section Column_... Column Independent | Column
Circular Column_.. .. Caolumn Independent | Column
Owal Column_.. .. Calumn Independent | Calumn -
Other and general Column_... .. Column Independent | Column
4 Longitudinal
4 Main(m)
Type of cover Auto Auto 44.1 EM1992-1-1 |Column | Design d
Diameter dem 16.0 mm EM1992-1-1 |Column | Design d
- Detailing (det)
4 Stirrups (sw)
Diameter deg &0 mim EM1992-1-1 |Column | Design d
Mumber of cuts ng 2.0 Independent |Column | Design d
o Minimuin cocare
OK Cancel

By default, the diameter for the main column reinforcement is put to $16mm. Based on this diameter and the
exposure class (by default XC3), the concrete cover is calculated. This information is necessary to be able to
calculate the lever arm of the reinforcement bars.

87 Provided reinforcement (design)

= il A - B

Column_Rect_Empty
Column_Rect_Basic_EdgeY
Column_Rect_Basic_EdgeZ
Column_Rect_Basic_Add_E...
Column_Rect_Basic_Add_E...

+ Danic

- s

Tl (ot At i

Name Column_Rect

Description Empty reinfor
Member type Column
Cross-section Rectangle

Mode Standard

Edge z

New Insert I Edit I

X
Provided reinforcement (design) edit - Column_Rect Empty o X
Member Column [ Longitudinal
Cross-sectior Rectangle ~| |H || E
Mode Standard
Basic reinforcement Additional reinforcement Detailing
Edge Diameter MNumber  Area Type [Diameter| Number  Area  Diameter
[mm] 1 [mm*2] [mm] 1 [mm*2]  [mm]
Ed 16.0 o 0 Fix [16.0 L] 0
10.0
Edge z Edge 16.0 o 0 Fix 16.0 o 0
Edge z Edg’e z Shear reinforcement
Number of .. Diameter Spacing/m... Symmetrical
Max. num. Type of inp.
- [mm] [mm]
R Multiple
Edge y
oK oK Cancel

Note: To change the default diameter from ¢16mm to ¢$20mm for example, edit the template
“Column_Rect_Empty” (or the corresponding empty template for the specific columns shape), and change the
value of the diameter to be taken into account (additional provided reinforcement).
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Results

Go to Steel workstation > 1D Reinforcement design:

s
 *

¥

t
M e

Tl

1D REINFORCEMENT DESIGN

v B )@ 8 Ym P

|

E

Ask the value of Asreg for member B1, and click the action button [Refresh].

(&1

w SELECTION

Type of selection

Results in

w RESULT CASE

Type of load

RESULTS (1)

Name Overall Design (ULS)

Filter No v~

sections  All

Combination ULS v~

Current *~

Combinations

¥ EXTREME 1D
Extreme1D Global
Type of values  Required ~~
Interval CD
* OUTPUT SETTINGS

» DRAWING SETUP 1D

» ERRORS, WARNINGS AND NOTES SETTINGS

Run using Model Data files (Debug) (O )

ACTIONS

b

@ Edit provided reinforcement template

@ Concrete setup

@ Preview

R

The graph appears to be null on the screen. The Brief output (Preview button), gives As,req = 0.

88

Overall Design (ULS)

Linear calculation

Combination: CO1

Coordinate system: Principal

Extreme 1D: Global

Selection: All

Longitudinal required reinforcement

Name | dx |Case | Member Asz_req+ Asz_req- Asy_req+ Asy_req Asz_req Asy_req As_req ReinfReq
[m] [mm?2] [mm2] [mm?2] [mm?2] [mm?2] [mm32] [mm?]
Asz_req_bar+ | Asz_req_bar- | Asy_req_bar+ | Asy_req_bar- | Asz_req_bar | Psy_req_bar | As_req_bar
[mm?] [mm?] [mm?] [mm?] [mm?2] [mm?] [mm?]
Bl 0,000 |CO1 Column 0 0 0 0 0 0 0
0 0 0 0 0 0 0
Shear reinforcement
Name | dx |Case | Member | Aswm_req | Aswm_prov | ShearReinf
[m] [mm2/m] | [mm?/m]
B1 0,000 |CO1 Column 0 0
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If you set output settings on Detailed, you can see the explanation that reinforcement is not necessary.

S
RESULTS (1) A
Name Overall Design (ULS)

¥ SELECTION
Type of selection  Current “~

Filter No “~
Results in sections  All ~~

¥ RESULT CASE
Typeofload Combinations

Combination ULS ~~

w EXTREME 1D
Extreme 1D Global

Type of values Required ~~

Values As,req “~

Interval CZ)
* OUTPUT SETTINGS

Output  Detailed v~

P DRAWING SETUP 1D
» ERRORS, WARNINGS AND NOTES SETTINGS

Run using Model Data files (Debug) (O )
ACTIONS 35

() Fefresh

(® Editprovided reinforcement template

() Concrete setup

@) Preview

Explanation errors/warnings and notes

Index Type Description Solution

Statically required reinforcement: The
N1/1 Note . .
reinforcement is not neccessary.

Chaar dacian: Nacian ic nat dana hacanca

Remark: this result is obtained only because all detailing provisions are deactivated in the Concrete
Settings!

Check of reinforcement

Nrd = fed - o0 - Ac =30 * 1 * 3502/ 1000 = 3675kN

Since Nrd = 3675kN > Neq = 2985kN, indeed no theoretical reinforcement is required.
= Reinforcement required: Neq > Ngq

Example: Axial compression only.esa

Studied column: B2

For this example, the same configuration as above is used, only the permanent point load is increased to
2000kN.

Loads

e LC1: Permanent load > F = 2000kN
e LC2: Variable load > F = 1000kN

Combination according to the Eurocode:
ULS Combination =1,35* LC1 + 1,50 * LC2
Design normal force Ned = 1,35 * 2000 + 1,50 * 1000 = 4200kN
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Results

Remark that SCIA Engineer shows on the screen the reinforcement per direction. The total reinforcement area
is in fact 750 + 750 = 1500mm?,

v
:::_:I 3
A 375 mm=,
375
m -~
oy w2
&
&

Overall Design (ULS)

Linear calculation

Combination: ULS

Coordinate system: Principal

Extreme 1D: Global

Selection: B2

Longitudinal required reinforcement

dx Case Member Asz_req+ Asz_req- Asy_req+ Asy_req- Asz_req Asy_req As_req ReinfReq
[mm?] [mm?] [mm?] [mm?] [mm?] [mm?] [mm?]

k‘z_req_ba r+ k—z_req_bar- M_req_ba r+ M_req_ba r- k‘z_req_bar kv_req_bar As_req_ba r

[mm?2] [mm?2] [ mm?2] [ mm?] [ mm?] [ mm?] [ mmZ]
1500 | [z]6¢16,
402 402 402 402 804 804 1608 | [y]l6d16

Shear reinforcement
Name dx Case Member Aswm_req Aswm_prov  ShearReinf

[m] [mm?/m] [mm?/m]
B2 0.000 [ULS _|[Column 0 0
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When asking for the Standard output for Reinforcement design, the proposed configuration can be found:

Overall Design (ULS)

Linear calculation
Combination: CO1
Coordinate system: Principal
Extreme 1D: Global

Selection: Al
Column B1
ECEN 1092-1-1:2004/AC:2008
. Member length Ld=45m
Buckling length y Ly=9.01m
Buckling length z Lz=9.01m

Longitudinal reinforcement

& =16mm, c =30 mm,

Design of longitudinal reinforcement

Rectangle (350; 350)
Section 0 [dx =0 m]
Materials

Concrete C45/55
Reinforcement B 5008

Shear reinforcement

Nirgg = 2, Bargg =8 MM, 0y = 90°

A 1.35"LCT+1.50*LC2 : Ngy = -4200 kN, Mgg, = 0 kNm, M g = 0 kNm

Required
¥y z A s Asgermin Asderma DAsrgr  Aspzg A;reqbar .
e = —l
1 1 ] -0.129 375 ] 0 ] 375 402 3016
2 1 0120 ] 375 ] 0 ] 375 402 3pl6
3 1 ] 0.129 375 ] 0 ] 375 402 3016
4 1 -0.129 0 375 ] 0 ] 375 402 3016
Required bars Provided bars
3 3
» > >
=1 z =1 z
B = - J_" L ] ™ = =r —T—b— rJ
y y
L ] L ] L ]
L L
350 350

Explanation of the number of reinforcement bars

Default bar diameter has been set to $16 in Design default.

The table indicates that each edge needs 3¢16.

On the final picture, this leads to a total of 8¢16 in the section of the column.
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DESIGN WITH BENDING MOMENT AND AXIAL FORCE

Four calculation methods are available in SCIA Engineer in concrete settings > Design As > Beam, Column,
Rib, ... > Design method:

e Auto (by default)
e Uniaxial around y axis
¢ Uniaxial around z axis
o Biaxial (always used for circular and oval columns)
Concrete settings [m] X
Views: Complete setup ¥ |View settings v | | Load default Find National annex: “
Description Symbol Value Default Unit Chapter Code Struc... Check...
zall= POl <al O|<al  LO<al= O <al> O <al O <a.. 0| <a.. O
First order eccentricity with the equivalent moment 5.882(2) [EN1992-... | Column | Solver
Second erder eccentricity e 5.88 EM 1922-... | Column | Solver
4 Internal forces modifications
Limit ratic for uniaxial method Piim 0.10 010 Independ...| 1D (Be | Salver
I Beam
4 Column
> Type Auto A fgo Independ...| Calumn | Salver
Axial force (Mgg) Mgy Auto Independ...| Calumn | Salver
Bending moment about ¥-axis (Mgg,) Megy Uniaxial Y Independ... Column Solver -
Bending moment about Z-axis (Mgg,) Mgz gr“a_mfl zz Independ...| Calumn | Salver
iaxia
Torsional moment (Tgg) Tea User Independ...| Calumn | Salver
Shear force in Y-axis (Vgg,) VEdy User with limit Independ...| Calumn | Salver
hear tarce in -axis (Vegg) VEdz Independ...| Calumn | Salver
r Beamslab
4 Designfs
4 Beam, Column, Rib, Beam Slab
Coefficient increasing statically required reinforcement in beam for u... | Coeffyyy o 0.00 Independ... Bearmn,..| Salver
Coefficient increasing statically required reinforcement in beam for lo.. Coeffoyzy Independ...| Beam,..| Solver
Caafficiant incrascing chaticalb rannirad reinfarcemeant in colimn o nnn Indanan d I CalimnlSaha
OK Cancel

The “Auto” selection of the design method is based on the limit ratio of bending moment for the uniaxial method.
The program will automatically select the uniaxial or biaxial method depending on the values of bending
moments around y and z axis.

Rule for automatic selection of the design method:

_ Min{|MEdy, max|,

MEdy max|}

With:

o If pm < pmiiim Uniaxial method =
Pm Max{|MEdy,max|,|MEd; max|}
o If pm 2 pwmjim Biaxial method
®  Medy.max maximal design moment around y axis from all combinations in current section
®  Medzmax maximal design moment around z axis from all combinations in current section
®  PMmlim limit ratio of bending moments for uniaxial method loaded from Concrete settings
Settings for limit ratio:
Concrete settings O X
Views: Complete setup ¥ |View settings = | | Load default Find Mallunalanne)c-
Description Symbeol Value Default  Unit Chapter Code Struc... Check...
<all> LPl<al O <al O <al= O <al> O <al> 0| <a.. 0| <a.. O
4 Solversetting
I General
4 Internal forces
Shear force reduction above supports 52.1(8) | EM1962-... |Beam, | Solver
Mament reduction above supports 5322 (4) EM1903-... |Beam, alver
Shifting of moment curve to cover additional tensile force caused by shear 9.2.1.3(2) |EM1962-... [Beam,. | Solver
Geemetric imperfection in ULS BULS 52(2) EM 1982-... | Column | Solver
Geometric imperfection in SLS &8s 5.2(3) EM 1982-... | Column | Salver
Minimum eccentricity emin Infirst ord.. In fir=t 61(4) | EN1982-...|Column | Solver -
First erder eccentricity with the equivalent moment 5.8.82(2) EM 1982-.. | Column | Solver
Second arder eccentri € 588 EM 1282-... | Column | Salver
4 Internal forces modifications
ILinm ratio for uniaxial method Plim 0.10 0.10 I Independ... 10 Be | Salver
r Beam -
4 Column
» Type Auto huto Independ... Calumn | Salver
Axial force (Neg) Heg Independ..| Column | Solver
Bending moment about Y-axis (Megy) Meay Independ...| Column | Solver
OK Cancel
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= Uniaxial bending calculation

7777

Principle

The reinforcement is designed for Nes and one bending moment Meg,y Or Med,z:
¢ Uniaxial around y: Meg; is ignored, the reinforcement is designed only for Neds and Medy
e Uniaxial around z: Meay is ignored, the reinforcement is designed only for Nes and Med,z

If Auto selection of design method is selected and pm < pwm,im, the rule to choose between uniaxial method
around y or z is:

o If Medy > Medz > As = Ay is designed for forces Ned and Meq,y

o If Medz> Medy 2 As = Asz is designed for forces Ned and Meq,2

Example: Uniaxial bending.esa
Geometry

Column cross-section: RECT 350x350mm?2
Height: 4,5 m

Concrete grade: C45/55

Concrete Setup

Item Concrete settings > Internal forces ULS: ‘eccentricities’ are not taken in account (only 15t order moments
are considered).

Concrete settings [m} X

Views: Complete setup ¥ |View settings = | | Load default Find National annex -
Description Symbol  Value Default Unit Chapter Code Struc.. Check..

=all= Ll<alr PO|<al LO<al> O <ale P|<al P|=<a.. O|<a. 2

4 Designdefaults
I Reinforcement
> Minimum cover
4 Solversetting
I General

4 Internal forces

Shear force reduction above supports 62.1(8) |EM1%982-... |[Beam...|Solver
Moment reduction above supports 5322 (4) |[EM1%82-... |Beam . . |Solver
Shifting of moment curve to cover additional tensile force caused by shear 9.2.1.2(2) |EM 1962-... |[Eeam S olhver =
Geometric imperfection in ULS SuLs 5.2(2) EM 1982-... | Column | Solver
Geometric imperfection in 5L gos 5.2(3) EN 1982-... | Column | Sohver
Minimum eccentricity e In first ord & I first 6.1(4) EM 1982-... | Columin | Solver
First order eccentricity with the equivalent moment 5.882(2) |EM1992-.. [ Column [ Sober
» Second arder eccentricity e 588 EM1982-... | Column | Solver
4 Internal forces modifications
Limit ratio for uniaxial method Diim 0.10 010 Independ... 10 (Be | Solver
> Beam
4 Column
Tuna Aok Auite, lndanan Il FONTIN .
OK Cancel
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Item Detailing provisions are not taken in account, to view the pure results (according to the Eurocode, always
a minimum reinforcement percentage must be added).

Concrete settings O *

Views: Complete setup ¥ |View settings = Load default Find Mational annex: -
Description Symbol Value Default Unit  Chapter Code Structu... CheckT..

=all= Ll<al L2 <al Ll <alr P|<.L|<al LO|<al> Ll <ale O <al> O

PoLrack wiaon

> Deflections

4 Detailing provisions
r Beam [Rib
> Beam slab
4 Column

4 Longitudinal

Check min. bar distance 82(2) EN1952-1-1 | Column
Check max. bar distance Independent | Column =
Check max. bar distance (torsion) 9.2.304) EN1952-1-1 | Column
Check min. reinforcement area 9.52(2) EM 1952-1-1 | Column
Check max. reinforcement area 9.52(2) EN1952-1-1 | Column
Check min. bar diameter 9.52(1) EM 1952-1-1 | Column
Check min. number of bars 9.52(4) EN1952-1-1 | Column
4 Transverse
Check max. percentage of stirrups 6.2.3(3) EN1952-1-1 | Column
Check min. mandrel diameter 8.3(2) EM 1952-1-1 | Column
Check max. longitudinal spacing 9.5.3(3) EN1952-1-1 | Column
p Check min. bar diameter 9531 EM 1952-1-1 | Column

OK Cancel

Loads

Column B1:
e LC1: Permanent load > F = 500 kN; My = 100 kNm
e LC2: Variable load > F = 1000 kN; My = 100 KkNm

Column B2:
e LC1: Permanent load > F =500 kN; My = 100 kNm
e LC2: Variable load > F = 1000 kN; My = 100 kNm; Mz = 10 kNm

Combination according to the Eurocode:
ULS Combination =1,35* LC1 + 1,50 * LC2
Design normal force Nes = 1,35 * 500 + 1,50 * 1000 = 2175 kN
Design moment Myq = 1,35 * 100 + 1,50 * 100 = 285 kNm
Additional design moment in column B2 Mzq= 22,5 KNm
Results

Go to Reinforcement design > 1D members > Reinforcement design, ask the value for Asreq, and click the
action buttons [Refresh] and [Preview].

Looking at the Detailed output for column B1.:

Determination type of calculation
Calculation maximum bending moments arcund y and z axis

My mze = -285 kNm Moo = 0 kNm
Calculation maximum ratic of bending moments

pt_r = D
Determinaticn type of calculation
pr =0 < puse = 0.7 and [Mymad = 285 kNm = [M2ra] = 0 KNm ==

= = Uniaxial method around y axis. Moment M ; will not take into account (M, = 0 kiNm).
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The numerical results of the calculation are as follows (standard output):

Column B1 RECT (350; 350)
EC EN 1992-1-1:2004/AC: 2008 Section 0 [dx=0m] J
_I\-‘Iember length d=43m Materials
Buckling length y Ly=901m Concrete C45/55
Buckling length z lz=901m Reinforcement B 500A
Longitudinal reinforcement Shear reinforcement

¢ =16 mm, ¢ =30 mm, Nireq = 2, ¢s.r5q =& mMm, Ogreq = 90°
Design of longitudinal reinforcement

Azz 1.35°LCT+1.50°LC2 1 Neg = -2173 KM, Megy = -285 KNm, Mzgz = 0 kNm

Ao 13501+ 50°LC2 ¢ Ny = -2175 kN, Mg = -285 kNm, Mz, = 0kNm

Required
Edge Layer y z Asstat As.dat_m'ln As.dat_max Ms_tar As_req As_req.bar Reinf
[m] [m] [mm®] [mm] [mm] [mm] [mm] [mm]
1 1 o -012% 1552 0 0 0 1552 1608 8d16
3 1 1] 0129 1552 0 1] 1] 1552 1608  8dl6

Summary of reinforcement

Top: Az prows = E}mm1
Bottom : = :
Right : = 0mm?
Left: :
Total vertical:
Total horizontal: Y
Total: Asreq = 3104 mm?
Required bars Provided bars
3 3
U VI
s e B e ene
z z
g - L O i ~
 J  J
LI BB I B BN
! M- - S -
I, 350 I, I, 350 l,
7 7 7 1

Looking at the Detailed output for column B2:

Determination type of calculation
Calculation maximum bending moments around y and 7z axis

My.max = -285 kNm Mzrmax = -22.5kNm
Caleulation maximum ratio of bending moments

pm = 0.0789

Determination type of calculation
pm = 0.0789 < pmiim = 0.1 and |My.max| = 285 kNm > [Mzma| = 22.5 kNm =>

= > Uniaxial method around y axis. Moment M; will not take into account (M: = 0 kNm).
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And the Standard output:

RECT (350; 350)
Section 0 [dx=0m]

Column B2

EC EN 1882-1-1:2004/AC:2008

Member length d=45m Materials
Buckling length y y=901m Concrete C45/55
Buckling length z Z=901m Reinforcement B 500A

Longitudinal reinforcement Shear reinforcement

¢ =16 mm, c =30 mm,

Design of longitudinal reinforcement
Aszai 1355LC1+1.50°LC2 1 Neg = -2175 kN, Mgy = -285 kNm, Mgz = 0 kNm
Aszi 135°LCT+1.50°LC2 ¢ Ngg = -2175 KN, Mgg, = -285 KNm, Mgy, = 0 kNm

Nireq = 2, ¢s.rs:| =8 MM, Oreq=90°

Required
Edge Layer y z Asstat Asdatmin Asdat.max A-“smm AsJeq Askreq.bar Reinf
[m] [m] [mm’] [mm’] [mm’] [mm7] [mm7]  [mm]
1 1 0 -0.128 1552 0 0 0 1552 1608 2416
3 1 0 0128 1552 0 0 0 1552 1608 2416

Summary of reinforcement
Az prov- =0 mm1

Top: Azre

Bottom : Az, Aszpon-=0 mm’
Right : A, Aspprove = 0 mm’
Left: A oo =0 mm’
Total vertical: A ooy = 0 mm®

Total horizontal: A =0 mm ] mm®

Total: Asreq = 3104 mm’ Asproy = 0 mm?

Provided bars

3 N 3

M —

Required bars

2l < il . 2| < £ ~
- y - y
[ BE BN BE BN B BN B )
- =
) o L | o ]
-1 <1 <1 T

Even if an additional bending moment in the z direction is present in column B2, according to the limit ratio the
uniaxial method was used, and the same amount of reinforcement is required for columns B1 and B2.

You have the possibility to force the biaxial method design on column B2 using 1D member data:

W7 CMD *

Name CMDI1D ~
Member B4
Member type Column v
> Design defaults
4 Solver setting
P General
4 Internal forces
Isolated member
Geometric imperfection in ULS
Geometric imperfection in SLS.
Minimum eccentricity Infirst order ecc. v
Second order eccentricity

4 Internal forces modifications

<" Column
Type Biaxial v

‘Axial force (Ngg)
Bending moment about -axis (M)
Bending moment about Z-axis (Mg ;)
Torsional moment (Tg)
Shear force in Y-axis (Veq,)
Shear force in Z-axis (Vg )

b Design As

b Conversion to rebars

b Interaction diagram

Actions

Load default values  >>=

0K Cancel
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Amount of required reinforcement will be slightly higher in this case since Meq: is also considered.

Column B2 RECT (350; 350) J
EC EMN 1992-1-1:2004/AC:2008 Section 0 [dx =0 m]
 Member length d=45m Materials
Buckling length y Ly =9.01m Concrete C45/35
Buckling length z lz=9.01m Reinforcement B 500A
Longitudinal reinforcement Shear reinforcement
& =16 mm, ¢ =30 mm, Nereg = 2, Qhreq = 8 MM, Cpreq = 90°

Design of longitudinal reinforcement
Asz. 1.355LC1+1.50°LC2 ¢ Neg = -2175 kN, Mgy, = 285 kNm, Mg = -23 kNm
Azt 135°LCT+1.50°LC2 : Ny = -2175 kN, Mgy, = -285 KNmM, Mgy, = -23 kNm

Required
Edge Layer z As.statz As.:lsu;in As.:lsu;ax A‘\s.t::ur2 As.rsq 5 As.rsqbzar Reinf
m] [m] [mm7] [mm] [mm] [mm] [mm] [mm]
1 1 0 -0.129 2046 ] 4] 0 2046 2212 11¢16
2 1 o 0,129 2046 0 4] o 2046 2212 11¢16

= Biaxial bending calculation
E
<
DL
A

y

VAV AN AV

This method allows to design reinforcement for a normal force (Neq) and biaxial bending moments. This method
is based on an interaction formula, equation 5.39 in EN 1992-1-1.

a
(@)ﬂ(@) <10 (5.39)

MRdz MRdy

where:
e Medzy design moment, including a 2"® order moment (if required)
e Mrdzy moment resistance
e a exponent:
for circular and elliptical cross sections: a =2
for rectangular cross sections:
Ned/NRd 0,1 0,7 1,0

a= 1.0 1,5 2,0

with linear interpolation for intermediate values
o Nea design value of axial force
o Nra =Ac- (fad + s - fya), design axial resistance of the section, where:
= Ac gross area of the concrete section
= fa design value of concrete compressive strength
= fya design yield strength of reinforcement
= s mechanical reinforcement ratio in the calculation of limit slenderness
obtained with an iterative calculation
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CIRCULAR COLUMN

For circular and oval columns, the design method is always the biaxial calculation, regardless of the design
method set in the Concrete settings.

For circular and oval columns, the required number of reinforcement bars is spread equally along the face of
the column.

Example: Circular column.esa

Geometry

Column cross-section: CIRC diameter 400mm
Height: 4,5 m
Concrete grade: C45/55

Loads

Load configuration:

Ned = 2175,00kN
Myd = 142,50kNm
Mzd = OKNm

Concrete Setup

Geometrical imperfection and 2" order moments are deactivated: Concrete settings > Complete Setup view :

Concrete settings

Views: Complete setup ¥ |View settings v | | Load default Find
Description Symbol Value
<all> Pl<al Pl<al L
4 Designdefaults
P Reinforcement
P Minimum cover
4 Solversetting
I General
4 Internal forces
Shear force reduction above supports
Moment reduction above supports
Shifting of moment curve to cover additional tensile force caused by shear
Geametric imperfection in ULS & uLs
Geametric imperfection in SLS &sis
Minimum eccentricity e In first ard
First order eccentricity with the equivalent moment
» Second arder eccentricity ey
4 Internal forces modifications
Limnit ratie for uniaxial method Plim 0.10
I Beam
4 Column
Tune Aorke

Default

<alk O

Unit Chapter

<ale O <alk P|=<a.. O <a. O

6.2.1(8)
5322(4)
9.2.13(2)
52(2)
52(3)
6.1(4)
5.8.82(2)

5.8.8

Code

EN 1262-...
EN 1262-...
EN 1992-...
EN 1992-...
EN 1992-... | Cal

ER 1562

EN 1962-..  Cal
EN 1262-... | Cal

National annex -

Struc...

Independ...| 10 (E

Indanend | Calume | Salia:

0K

[m] X

Check...

=

Cancel

All detailing provisions are considered.
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Design defaults

The bar diameter is set to $20 mm in Reinforcement design > Design defaults > Tab Columns, or from 1D
Member data if applied.

Concrete settings O X

Views: Complete setup ¥ View settings Load default Find National annex: -
Description Symbol Value Default Unit  Chapter Code Structure CheckType

“all> Pl <al> L <al> Plzale L= L <al> L <al> Pl<al O|<al L

4 Design defaults
4 Reinforcement

 Beam | Rib
I Beamslab
4 Column
Design of provided reinforcement Independent | Calumn Design def
Rectangular section Column_R... ... | Column_R. Independent | Column Design def
Circular Column_C... ... | Column_{ Independent | Column [resign def
Owval Column_... . |Column_O Independent | Calumn Design def
Other and general Column_... ... Column O Independent | Column Design def
4 Longitudinal
4 Main(m)
Type of cover User Auto 4.4.1 EN1992-1-1  |Column  |Design def
Concrete cover (c) c 35.0 mm 441 EN1992-1-1  |Celumn  |Design def
Diarmneter il 20 16.0 mm EM 1962-1-1 Column Design def

- Detailing (det)
4 Stirrups [sw)
Diameter deg 80 mm EM 1962-1-1 Column Design def
Humber of cuts ny 2.0 2.0 Independent | Column  |Design def
P Plate
 Wall/ Deep beam

OK Cancel

Results
Go to Reinforcement design > 1D members > Reinforcement design.

Choose Standard output in the Properties window and open the Preview at the bottom of the Properties
window:

Required
Edge Layer y z As‘stat2 As.det.nzﬁin As.det.nzﬁax M:.to; A:‘req2 A:.req.b;r Reinf
[m] [m] [mm7]  [mm] [mm7] [mm] [mm] [mm]
- - - - 1142 1257 5001 0 1257 1571 5¢20*

Summary of reinforcement
Total : Agreq = 1257 mm*

Required bars

RN

G400

In this example Asreq is determined by the minimum amount of reinforcement according to the detailing
provision, As detmin.

Since Asreq = 1257mm?2, the software will propose 5 bars of $20mm (5*314mm2 = 1571mm2 = As reqbar) Which
is the closest amount of bar with As reqbar > As req.

Note that SCIA Engineer uses the real area of the bars to calculate the required reinforcement area.

So, the final required reinforcement displayed on the screen is As req bar.
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Remark 1: If you choose a template without bars predefined in Design Default, for example “Column_Circ-
Empty”, the software will display only the Asreq and not Asreqbar s mentioned above.

[m] X

Views: Complete sstup ¥ |View settings v | | Load default Find National annex: -
|
i A ale g B Provided reinforcement (design) x
<all> Pl O] <al= P
4 Designdefaults HAEFE «2 &
4 Reinforcement Column_Circular_Basic_AddList
© Beam /Rib Column_Circ_Empty
 Beamslab Column_Circ_Basic
4 Column Column_Circ_Basic_Add
Design of provided reinforcement B Column_Circ_Basic_AddList
Rectangular section Calumn_R.. ¢
- Mame Column_Circ_
W[ Greatar Column,. ¥
Oval Column_0... Description Empty reinfor
Dther and general Calumn_0 ¢|  Member type Column
4 Longitudinal Cross-section Cireular
4 Main{m) Mode Standard
Type of cover Auto A
Diameter - 16.0 1
P Detailing (det)
4 Stirrups (sw)
Diameter deg 8.0 El
Number of cuts N 2.0 3
r Plate
> Wall/Deep beam
p Minimum cover
New Insert Edit Delete OK
Remark 2:
According to EN1992-1-1 art 9.5.2(4), there is a minimum number of bars in a circular column.
H H wAN ; o .
This parameter is set by default to “4” in Concrete Settings > Complete setup view.
Concrete settings | X
Views: Complete setup ¥ |View settings « | | Load default Find Mational annex: -
Description Symbol Value Default Unit | Chapter Structure | CheckType
<all Pl<al- PO <al= Pl=al 0= O <ale P <all= Pl O <alz P

i Deflections

4 Detailing provisions
r Beam [Rib
I Beamslab
4 Column

4 Leongitudinal

an

100

Check min. bar distance 8.2(2)
Minimal bar distance Sic. min 20 mm 82(2)

Check max. bar distance
Maximal bar distance St max 350 3 mm

Check max. bar distance (torsion)
Maximal bar distance (torsion) Siot,max 350 i mrm

Checlk min. reinfarcement area

Check max. reinforcement area

Check min. bar diameter

Check min. number of bars 5

| Minimal number of bars in circular col... ni g 20 o 1
4 Trarsverse - -
Check max. percentage of stirrups 6.2.3(3)
Check min. mandrel diameter 2302

EM 1562-1-1 [
EN 1962-1-1 e
Independent
Independent
EM 1962-1-1
EM 1562-1-1
EN 1962-1-1
EM 1952-1-1
EM 1562-1-1
EM 1962-1-1
EM 1562-1-1

EM 1562-1-1
EN 1962-1-1

lumn >
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If we increase the loads:
F, = -1250kN
M = 50kNm

The results are as follows.

Example: Circular column_increase.esa

Overall Design (ULS)

Linear calculation
Combination:

co1

Coordinate system: Principal
Extreme 1D: Global

Selection:

Al

Longitudinal required reinforcement

Name dx | Case | Member Az req+ Ay reg- Asy req+ Asy req- Asz req Ay req As req ReinfReq
[m] [mm?2] [mm?] [mm?2] [mm?] [mm?2] [mm?2] [ mm?]
A<z req bart | Asz req bar- | Psy req bar+ | Psy req bar- | Asz req bar | Asy req bar | As req bar
[ mm2] [mm2] [mm2] [mm2] [mm2] [mm2] [ mm2]
B1 0,000 |CO1 Column 1041 1041 1041 1041 2082 2082 4164 | 14620
1100 1100 1100 1100 2199 2199 4398

The corresponding bar configuration is:

MJ — 08/08/2024

Required bars

o

$400

—

101



Advanced Concept Training — Concrete

2.3.2 Calculation of internal forces
DETERMINING IF MEMBER IS IN COMPRESSION

+

2d order effects, geometrical imperfection and minimal eccentricity are considered only if:

¢ Member type = Column

e Compression in the column is relatively high

In SCIA Engineer, there is a parameter which allows to decide whether a member is in compression or if the
compression is too small to be considered.

In Concrete settings > Complete setup view:

Concrete settings

Views: Complete setup ¥ |View settings = | | Load default Find
Description Symbol Value Default Unit | Chapter
<all= Ll <alz O <al> LOl<ale P|=<.Ll<alr L
4 Designdefaults
> Reinforcement
B Minimum cover
4 Solversetting
4 General
Limit value of unity check Lim.check |1 Lo
Walue of unity check for not calculated unity check Meal.check | 2.0 3.0
The coeffi ion effective depth of cross-sec.. Coeffy 09
Thec culation inner lever arm Coeff, 09
I The coefficient for calculation force, where member as u... C-;-el"fcw 0.1 1 I
4 Creepandshrinkage
Age of conerete at the moment considered t 18250.00 18250.00 | da 214B.12
Relative humidity RH 50 314B.1-2
Type input of creep coefficient Type gltta) |Auto Aute 3.1.4(2)
Aoenf rancrate at nading e IR 0N T dan 1471 R

Condition is:

e If Ned < - Coeffeom * fed * Ac
e |f Ngd > - Coeffeom * fed * Ac

Member is in compression
Compression is not sufficient (zero or relatively small)

Code

=all= jo

Independent | A
Independent | A
Independent | A
Independent | A

Independent | A

EM 1952-1-1
EM 1993-1-1
EM 1952-1-1
FHN 1960-1-1

This result can be viewed in Reinforcement design > 1D member > Internal forces.

The

102

Detailed output gives:

Compression member

Limitaxial force to consider member as compression:

MNegm = - Coeffom '{f:d A ] =

Check condition:

Meg < MNegm = -1100 kM < -388 kN ...

-0.1-(3010°-0.123) =368 kny

compression member

m} *

Mational annex: -

Structu... | CheckT...

<al> O|<al> O

==

Mote: First and second order eccentricity shall be taken into account, because the member is considered as a

compression member (significant normal force is presented).
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+ CHOICE BETWEEN 1%t and 2"¥ ORDER CALCULATION

Slenderness — Check of the criteria A < Aiim
o If A < um, 15t order effects have to be taken into account with geometric imperfection (art 5.2)
e If A > Aim, 2™ order effects have to be taken into account with geometric imperfection (art 5.2)

The values for A and Aim, and the corresponding check, can be found in the main menu Deign > Concrete 1D
> Slenderness for design :

r

= RESULTS (1) A
Name Slenderness(Design)

w SELECTION

Type of selection  Current ~~
Filter No ~~
Results in sections  All -~

w RESULT CASE
Typeofload Combinations ~~

Combination ELU-Set B (auto) v~

v EXTREME 1D
Extreme1D Global ~~
Interval () )
» OUTPUT SETTINGS
Output  Brief v

Print combination key

» DRAWING SETUP 1D
P ERRORS, WARNINGS AND NOTES SETTINGS

Run using Model Data files (Debug) (O )
ACTIONS 3

(® Refresh

@ New combination from Combination key

® Preview

The Standard output shows the check of A > Aim and indicates whether a 15t or 2" order calculation should be
done.

Slenderness(Design)

Linear calculation

Load case: LC1

Coordinate system: Principal
Extreme 1D: Global

Selection: All
Column B1 RECT (350: 350)
EC EN 1992-1-1:2004/AC:2008 Section 0 [dx = 0 m]

Slenderness

Axis Braced LMl Bapy b1 by Iml Ayl My [ Ay > Ny |
vy No 45 2 9.01 89.2 46.5 2" order
27 No 45 2 9.01 89.2 6.5 2" order
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* 15t ORDER EFFECTS
1st order effects (eccentricity) are always considered.

There are 2 ways to calculate the 15t order moments and eccentricity in SCIA Engineer depending on check
box First order eccentricity with the equivalent moment in Concrete Setup > Solver setting > Internal
forces.

Concrete settings m] X
Views: Complete setup v |View sett... v | | Load default Find Nationalannex:-

Description Symbol  Value Default Unit Chapter Code Struc... Check... Remark
<all> Pl<al> O <all> O <al> O <all> O <al> 0O <a.. O <all> O

4 Design defaults
P Reinforcement
b Minimum cover

4 Solver setting

b General
4 Internal forces My, =0,6- Mgz +0,4 - Mpy = 0,4 My,
Shear force reduction above supports 6.2.1(8) EN 1992-... |Beam lver
Momentreduction above supports 5.3.2.2(4) |[EN 1992-... | Beam lver
Shifting of moment curve to cover additional tensi... 9.2.1.3(2) EN1992-... Beam lver s =
Geometricimperfection in ULS € uLs 5.2(2) EN 1992-... | Column |Solver
Geometricimperfection in SLS eisLs 5.2(3) EN 1992-... | Column | Solver
Minimum eccenftricity €min Infirstord... In first 6.1(4) EN 1992-... | Column |Solver Tt eI RIS
> IFnstc:-rdm eccenftricity with the equwalentmomentl 5.8.8.2(2) |EN1992-... |Column |Solver accountas equivalent firstorder moment, if
Second order eccentricity e ] 5.8.8 EN 1992-... | Column |Solver this parameter is ON.
b Internal forces modifications
b Design As
b Conversion to rebars
b Interaction diagram
b Shear
b Torsion

OK Cancel

The 2 options are:
e First order eccentricity with the equivalent moment = YES, bending moments at the ends of
the column will be taken to calculate an equivalent 15t order bending moment. This leads to the
same 18t order bending moment along the whole length of the member.

Coy = Mge,/Ngq and eq, = MOey/NEd

With
Mye = (0,6 * Myy) + (0,6 *x My;) = 0,4 * My,

o First order eccentricity with the equivalent moment = NO, 1st order eccentricity is calculated
from bending moments in current section. As a result, bending moments in each section can be
different.

eOy = MZ/NEd and €oz = My/NEd

Values of the 1st order eccentricities and moments can be viewed in Design > Concrete 1D > Internal forces
for design.
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Standard output gives:

Internal forces (Design)

Linear calculation

Combination: ULS

Coordinate system: Principal

Extreme 1D: Global

Selection: All

Column B1
ECEN 1992-1-1:2004/AC:2008

RECT (350; 350)
Section 0 [dx = 0m]

Internal forces (FEM-based)
Extreme: ULS/1 (ULS)

Type: Combination (linear)

Design situation: EN-ULS (STR/GEQ) Set B

N M, M. v, V. M,
Type of load
[kN] [kNm] [kNm] [kN] [kN] [kNm]
Internal forces (FEM-based) -300.0 -30.0 0.0 0.0 0.0 0.0
Content: LC1
Slenderness
| Axis Braced Ly [ml  Bayy [l gy [m] Ay [l Ay ] Ay > Nimzyy
vy 45 2 9.01 89.2 465 2" order
zz-L 45 2 9,01 89.2 46.5 2" order
Unfavourable direction
Second order effect and imperfections
e Ney Moeayz  Mayz Meayz  €ozy €izyy Cominzy  ©0Edzy  Soay Ctdzy
[kN] [kNm] [kNm] [kNm] [mm] [mm] [mm] [mm] [mm] [mm]
Yy -300 -30 0 -30 100 0 0 100 0 100
zz- -300 0 0 0 0 0 0 0 0 0
Design forces (recalculated)
Neg Mg, Meq Vegy VEqz Mg,
T f load ) ’
M [kN] kNm]  [kNm]  [kN] IkN] [kNm]
Design forces (recalculated) -300.0 -30.0 0.0 0.0 0.0 0.0
+ GEOMETRICAL IMPERFECTION (art 5.2)

The effect of geometric imperfections always have to be taken into account: both in a 1st and 2" order

calculation.

Geometrical imperfection is by default activated in Concrete settings > Internal forces

Concrete settings

I Internal forces modifications

> DesignfAs

= Conversion to rebars

MJ — 08/08/2024

Views: Complete setup ¥ |View settings « Load default Find
Description Symbol Value Default Unit
=all= L <all= D <al= LOl<al Pl O
4 Design defaults
- Reinforcement
= Minimum cover
4 Solversetting
- General
4 Internal forces
Shear force reduction above supports
Moment reduction above supports
Shifting of moment curve to cover additional tensile forc...
I Geometric imperfection in ULS SULS I
Geometric imperfection in SL5 gsis
Minimum eccentricity B In first order ..l first o
First arder eccentricity with the equivalent moment
Second order eccentricity ey

Chapter

=all= jo,

6.2.1(8)
5322 (4)
92.13(2)
52(2)
52(3)
G.1(4)
58.82(2)

588

Code

=all=

EM 1552
EM 1552
EM 1952
EM 1952
EM 1952
EM 1952
EM 1952
EM 1952

Mational annex: “

Structu...

O

CheckT...

Ll <ale O <all> O

-1-1
-1-1
-1-1
-1-1
-1-1
-1-1
-1-1
-1-1

s

==
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In SCIA Engineer, the geometrical imperfection is represented by an inclination according to clause 5.2(5) in
EN 1992-1-1.

For both axis (y and z of LCS), the inclination is calculated as followed:
Oy = B0 0h* Umy(z) (5.1)

e 6o basic value of inclination
® 0Oh reduction factor for length of column or height of structure: a, = 2/V1;2/3 < a, <1

* Omy@ reduction factor for numbers of members: a,, ,(,) = \/(0,5 (1+ 1/my(z)))

o | length of column or height of structure depending on:
o isolated member | = L, where L is the length of the member
o notisolated member | = H, where H is the total height of building (buckling system)
e myz humber of vertical members contributing to the total effect of the imperfection perpendicular
to y(z)

Values of | and my) will be defined in the buckling data.

The effect of imperfection for isolated column and for structure is always taken into account as an eccentricity
according to clause 5.2(7a) in EN 1992-1-1:

Ciy = ei,z ’ lO,z/Zr €iz = ei,y ’ l(),y/2

The imperfection shall be taken into account in ultimate limit states and does not need to be considered for
serviceability limit states, see clause 5.2(2P) and 5.2(3) in EN 1992-1-1.

You can set independently if the imperfection will be taken into account for ULS or SLS in the Concrete settings.
A minimum 1st order eccentricity is also calculated according to clause 6.1(4) in EN 1992-1-1.

This can be viewed in Concrete settings > Internal forces > Use minimum value of eccentricity

Concrete settings m} >
Views: Complete setup ¥ |View settings + Load default Find National annex: -
Description Symbol  Value Default Unit Chapter Code Struc.. Check.. Remark
=all> Pl <al> Of<al L <ale O <ale O <ale O <a.. O <al.. O
4 Design defaults A) No ep=e+8g;
P Reinforcement —
ein e=epte,
B Minimum cover
4 Solversetting B) Min. ecc. to first order ecc.
B G al = L .
enera €p max(el+e|re0m\n)
4 Internal forces e=e t+e
Shear force reduction above supports 62.1(8) [EN 1902-1..(Beam,..|Salver TEotE2
Moment reduction above supports 5322 (4) |EM 1992-1..| Beam alver C:' Min. ecc. to final ecc.
Shifting of mement curve te cover additional ... 9.2.1.3(2) |EN 1992-1.)Beam,...|Solver ep=e+e
Geometric imperfection in ULS SULs 52(2) EN 1902-1... Column | Salver
Geometric imperfection in SLS 515 52(3) EN 1992-1..| Column | Solver €= max( eD+EZJeDm'\IT}
‘ Minimurm eccentricity Emin I first ard...| I first I 6.104) EN 1992-1..| Column | Salver
.
First arder eccentr |-:|t-)j- with the equivalent mao.. 5.882(2) |EM1292-1.| Column | Solver EOm\n:mSK[ h/301 20mm)
Second arder eccentricity ey 588 EN 1992-1..| Column | Salver
P Internal forces modifications The minimum value of the eccentricity can be set as
r DesignAs follows:
¢ Conversion to rebars Al Switched OFF, no minimum value is accounted for
- - B) The minimum is cansidered for the calculation of
B Interaction diagram . -
the first arder eccentricity
P Shear C) The minimum is considered for the final value of the
-3

Tersion eccentricity
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Buckling data for | and my(z)

Settings for | and my(z) for the calculation of the geometrical imperfection can be set in the properties of the

columns.

Properties > System lengths and buckling settings

%
MEMBER (1) [
Name B8
Layer Calquel =
Type column (100)
Analysis model  Standard -~
FEMtype standard -~
Cross-section €S2 - Rectangle (350; 356) 1—
Alpha [deg] 0.00
Member system-line at  Centre
ey[mm] 0.00
ez[mm] 0.00
LCS  standard
LCS Rotation [deg] 0.00
¥ BUCKLING
hrstem lengths and buckling sett... Default -___—:
Material and no. of parts
Secondary member () ) I
w GFOMFTRY
8 | System lengths and buckling settings o
FRLEVFS S
Settings Results
Name BG1
Buckling span Deflection span
Tj . yy Deflectionz = yy ¥
oAt s Deflectiony = zz ¥
b Active buckling constraints
4 Spansettings
Buckling length factors Settings per span for y-y axis
Beta yy factor Calculate v Sway y-y
Sway y-y From setup v 2
Member imperfection in 2nd order analysis
Total height Calculate v
my 1
ke
«
Save Cancel
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When opening the buckling menu, you need to define both the ‘Active buckling constraints’ and ‘Span
settings’ for buckling around the local y-axis (buckling span y-y) and local z-axis (buckling span z-z).
e Total height determination: set type of calculation of total height of building or length of the isolated
columns.
o Calculate: H tot will be calculated automatically as sum of lengths of all the members in the
buckling system
o Input: manual input value for Hiwt in edit box Tot. height
e my/z: number of vertical members contributing to the total effect of the imperfection perpendicular to
y/z axis of LCS.

Eccentricities due to geometrical imperfections can be viewed in Reinforcement design > 1D member > Internal
Forces:

Second order effect and imperfections

e N Moesy: Moy Megy:  €ozyy €0Edzry €z ecdzyy
[kN] [kNm] [kNm] [kNm] [mm] [mm] [mm] [mm]

y-y— -405 -49.1 0 -49.1 100 121 0 121

7-7— -405 8.1 0 8.1 0 -20 0 -20

After calculation of 1%t order eccentricity including effect of imperfection, the 1st order moment, including the
effect of imperfections around y (z) axis of LCS is calculated:

Mogdyz) = Ned " €oEdz(y) €0Ed,z(y) = €0y(z) T €iy(z) = €ominy(z)

e €0y 1storder eccentricity
® eiy@ eccentricity caused by geometrical imperfection
e eomn Minimum first order eccentricity

+ 2" ORDER EFFECTS

The EN 1992-1-1 defines several methods for 2™ order effects with axial loads(general method, simplified
method based on nominal stiffness, simplified method based on nominal curvature...).

In SCIA Engineer the following methods are available:
e General method according to clause 5.8.2(2) — based on a nonlinear calculation
¢ Simplified method based on nominal curvature according to clause 5.8.8
¢ Simplified method based on nominal stiffness according to clause 5.8.7

The simplified method is taken into account:
e For ultimate limit state
e For Member type = Column with compression according to "Determination if member is in
compression”
o |[f option “Use second order effect” in switched ON, see Concrete settings > Internal forces.
This option is activated by default.
o If slenderness A > Aim, See chapter "Slenderness criteria"

Simplified method based on nominal stiffness

The total design moment, including second order moment, may be expressed as a magnification of the bending
moments resulting from a first analysis, namely:

§
(&) 1
Ngq
Where:
e Moed is the first order moment
e is a factor which depends on distribution of 15t and 2" order moments:
2
p="T /c0
° ¢ is a coefficient which depends on the distribution of first order moment

e Nea isthe design value of axial load
e Ns is the buckling load based on nominal stiffness
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Simplified method based on nominal curvature

The nominal 2" order moment is calculated according to clause 5.8.8.2(3) in EN 1992-1-1:

M2,y(z) = Ngq €2,2(y)

With:
e Nesa design axial force
e e2zy 2" order eccentricity

When all mentioned criteria above are met for the simplified method, the 2™ order eccentricity is calculated
according to formula:
€2y = (1/Ms) Loz /Caty)
Otherwise:
€2y(2)=0
With:
o (1/r)zycurvature around z(y), calculated according to clause 5.8.8.3
Czy) factor depending on the curvature distribution around z(y) axis according to clause 5.8.8.2(4)
o = 8, for constant 15t order bending moment (non zero) along the column and in case that
equivalent bending moment is taken into account (“Use equivalent first order value” ON).
o =10 otherwise.
o Azy Slenderness
®  Azy)im limit slenderness
o lozy effective length of the column around z(y) — buckling length

Effective length

The effective length, or buckling length, is by default calculated by SCIA Engineer. Be aware that formulas for
automatic calculation are only valid for simple structures!

Otherwise, it is also possible to input the value of the effective length manually.
Automatic calculation of effective length
Calculation of effective length depends on the type of structure, sway or non-sway.

Two approximate formulas are used: one formula for a non-sway structure (resulting in a buckling factor 8 <
1) and one formula for a sway structure (resulting in a buckling factor § = 1):
e For a non-sway structure:
(p1p2z + 5p1 + 5pz + 24)(p1p2 + 4p1 + 4p, + 12)2

B (2p1p2 + 11p; + 5p; +24)(2p1p2 + 5p1 + 11p, + 24)

e For a sway structure:
B L
=X |[—
P1X

With:

e B buckling factor

o L system length

e E modulus of Young
o | moment of inertia
o Cj stiffness in node i
e M moment in node i
o O rotation in node i

<= 4p.p, + T[2p1
2 (p1 + p2) + 8p1p;

_CiL
1™ gl

_ M

C =
N

The values for Mi and ¢i are approximately determined by the internal forces and the deformations, calculated
by load cases which generate deformation forms, having an affinity with the buckling form.
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The calculation of the B ratios is automatically done when calculating the structure linearly. For this, two
additional load cases are calculated in the background:

e Load case 1:

o on the beams, the local distributed loads qy=1 N/m and qz=-100 N/m are used

o on the columns the global distributed loads Qx =10000 N/m and Qy =10000 N/m are used
Load case 2:

o on the beams, the local distributed loads qy=-1 N/m and gqz=-100 N/m are used

o on the columns the global distributed loads Qx =-10000 N/m and Qy=-10000 N/m are used

Since these load cases, and thus the buckling ratios, are calculated during the linear calculation, it is necessary
to always perform a linear calculation of the structure.

Note: The used approach gives good results for frame structures with perpendicular rigid or semi-rigid beam
connections. For other cases, you must evaluate the presented bucking ratios.

By default, the structure is considered as sway in y and z direction. It can be modified for the whole project in
Concrete settings > General > Default sway type.

[m]

Maticnal annex -

Structu...

Concrete settings x

Views: Complete setup ¥ |View settings v Load default Find

Description Symbol Value Default Unit  Chapter Code CheckTy...

<all> Ll <al O <al= Pl<al O|<. L0 <alr LOf<al= Pl<al O <al O

4 Designdefaults
> Reinforcement
F Minimum cover
4 Solversetting
4 General

Limit value of unity check Lim.check |10 L0 Independent |4

Meal.check
oeffy
oeff,
oeff

Value of unity che: t calculated unity check Independent |4

lculation effective depth of cross-sec. Independent | A

of o

lculation inner lever arm Independent | A

The co ==

o

efficient for calculation force, where member asu Independent |4

com
I Creepandshrinkage
B SLS
4 Default sway type
S

Sway around z axis

ay around y axis Independent |4

Independent | A

nternal forces
Design As
Conversion to rebars
Interaction diagram
Shear

Torsion

OK Cancel

You can easily modify these default settings for a specific column in the project within the buckling menu. This
menu can be accessed — as explained in the previous section — by navigating to the option ‘System lengths
and buckling settings’ within the properties of the member.

-

MEMBER (1)

E F

Name B8

Layer Calquel »~

Type  column (100)

Analysis model  Standard ~~

FEMtype standard

Cross-section  CS2 - Rectangle (350; 356) i—

Alpha [deg] 0.00

Member system-line at  Centre
ey [mm] 0.00

ez [mm] 0.00

Lcs
LCS Rotation [deg]
¥ BUCKLING

standard v

0.00

Fystem lengths and buckling sett...

—a

Default -~

e

Material and no. of parts
Secondary member

¥ GFOMFTRY
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B System lengths and buckling settings o x

Flf 18VFs AE

A& Settings Results
\—j\ Name  BG1
Buckling span Deflection span
°yy Deflection z= yy v
zz= 7z ¥ Deflectiony = zz v
b Active buckling constraints
4 Span settings
Buckling length factors Settings per span for y-y axis
Betayy factor Calculate v Swayy-y
1
ISWBY vy From setup vI
~J ko Member imperfection in 2nd order analysis
Total height Calculate v
my 1
= «
N, , Y
ﬁ_é "““H\\\\“w
Qg es
v
Save Cancel

This new setting has the name, here BG1, which you can attribute to others similar columns in their properties
window:
MEMBER (1) A

|
EAEARY

Layer Standaard

Type column (100) v
Analysis model Standard

FEMtype standard v/

Cross-section €S2 - CIRC {400) v/ —

Alpha 0 v
Member system-line at Centre v
ez[mm] 0.00
LCS standard v

¥ BUCKLING

ystem lengths and buckling sett... &1 Vo
Material and no. of parts | Default
BG1
Secondary member "{J J
—

| v GEOMETRY
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The calculated effective length can be viewed in Design menu > Concrete 1D > Slenderness for design:

Bl e v @

Concrete settings »

Concrete 1D 4 . Internal forces for design
Concrete 2D 4 ;‘ Slenderness for design

1D reinforcement design

KE? Edit reinforcement in section
'1 Bill of reinforcement (1D)

ﬂf Stiffness
Slenderness(Design)
Linear calculation
Load case: LC1
Coordinate system: Member
Extreme 1D: Global
Selection: All
Column B1 CIRC (400)
ECEN 1992-1-1:2004/AC:2008 Section 0 [dx = 0 m]
Slenderness
Axis Braced Ly [m] Bzpy [-1 | lozy [m] Ay -1 Nimzsy [-] Ay > Nimzpy
yyt No 45 2 9.01 903 296 2™ order
z-zL No 45 1 45 451 296 2" order

Manual input of effective length

The same option — as seen for the automatic calculation — allows you to manually define the buckling length
of the system. The option ‘Buckling length factors’ can be accessed within the section ‘Span settings’. In
the table ‘Settings per span for y-y/z-z axis’ you can insert the buckling length which needs to be taken into
account.

1 System lengths and buckling settings u] X
FiFf 2 8¢ FS @@

Settings Results

\|/
A/
A
24 Name  BG1
Buckling span Deflection span
®yy Deflectionz= yy v
zz= 7z ¥ Deflectiony = zz v
b Active buckling constraints
4 Span settings
Buckling length factors Settings per span for y-y axis
Beta yy factor Length v ly [m] Swayy-y
1 1.000
Sway y-y From setup v
‘& Member imperfection in 2nd order analysis
Total height Calculate v
my 1
< >
.
N §
(e
O
Qe 2w
Save Cancel
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Comparison of the two simplified methods

Whatever the reinforcement in the column, the method based on nominal curvature gives more or less the
same result, while the method based on the nominal stiffness is very affected by the reinforcement of the
column.

And on the other hand, the method based on the nominal stiffness is not usable anymore if the applied normal
effort Neq is too close to the buckling effort Ne.

% RECALCULATED INTERNAL FORCES
In Concrete Menu > Reinforcement Design > 1D member > Internal forces.
The design moment, Meq, is equal to Med = Moed + Mo.

With:
e Mz  2norder bending moment
e Moed bending moment taking into account 15t order and geometrical imperfections

Example: 2nd order.esa
Geometry

Column cross-section: RECT 350x350mm?2
Height: 4,5 m
Concrete grade: C45/55

Concrete Setup

All of the default values are kept.

This means that geometrical imperfection and 2™ order effects are taken into account.
Loads

Load configuration: Na = 405,00 kN
Myd = 40,50 kNm
Mzd = 0 KNm

Buckling data

Sway type is set by default.

Calculation of the effective length is done automatically by the software.
Slenderness criterion

Check if 2" order calculation is required following art 5.8.3.1:

Since A > Aim, a 2" order calculation will be required.

Note: the program automatically takes into account a second order moment if required. So, this check is just
extra information for the user.
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Internal forces
Ask for Meq in Design > Concrete 1D > Internal forces for design.
The Standard output is chosen:

Internal forces (FEM-based)

Extreme: ULS/2 (ULS)
Type: Combination (linear)
Designsituation: EN-ULS (STR/GEQ) SetB

Type of load N M, M: v, V: M,
[kN] [kNm] [kNm] [kN] [kN] [kNm]
Internal forces (FEM-based) -405.0 -40.5 0.0 0.0 0.0 0.0

Content: 1.35*LC1

Second order effect and imperfections

fids Nzg Mozayz: Mz Megy:  enyy ey @minzy  €0Edy €y €czyy
[kN] [kNm] [kNm] [kNm] [mm] [mm] [mm] [mm] [mm] [mm]

y-y-l- -405 -48.7 -73.2 -122 100 21.2 20 121 181 302

zz1 -405 8.6 63 716 0 -21.2 -20 -21.2 -156 -177

Design forces (recalculated)

Type of load Neg Meq, M:s. Vg, Veas M:o.
[kN] [kNm]  [kNm]  [kN] [kN] [kNm]
Design forces (recalculated) -405.0 -122.3 71.6 0.0 0.0 0.0

Results

The results for the reinforcement design are shown below:

Design forces

Case Nzg Vegy Ve Teg M:s, Mz M MAim
[kN] [kN] [kN] [kNm] [kNm] [kNm] vyt zzl
uLs/1 -300.0 0.0 0.0 00 -300 0.0 - - - -
uLS/2 -405.0 0.0 0.0 00 -1223 716 238 2nd 238  2nd
uLsA LC1
uLs/2 1.35*LC1
Longitudinal reinforcement
Basic Additional Detailing At Acoin Asreq: Asprov. Asmax Smin  Smax Status
[mmZ] [mmz] [mmzl [mmZ] [mmz] [mm] [mm]
[1] 2416 500 61 500 402 1225 242 258 Not OK
237 -
[2] 216 --- --- 385 61 385 402 1225 70 86 OK
237 -
[3] 216 --- - 500 61 500 402 1225 242 258 Not OK
237 -
[4] 216 --- -—- 385 61 385 402 1225 70 86 0K
237 -
3Y 4916 1000 804
3Z 4416 770 804
T 8416 1770 1608

Note that biaxial bending method was used for reinforcement calculation.
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2.4 Plate design

2.4.1 Used example
+ INPUT OF GEOMETRY

Project data: 2D environment = Plate XY

Basic

Project data

data

Functionality Actions

DATA

Name:

Part:
Description:
Author:

Date:

Structure:

Post processing
environment

Model:

UnitSet Protection

Example project

ACT Reinforce Concrete
Plate design

SCIA Engineer

03.09. 2021

£ Plate XY
@ default

= one

MATERIAL

Concrete 4]
ial C25/30

Reinforcement mate B 500A

V. e

Steel

Masonry
Aluminium

Timber

Steel fibre concrete
Other

v CODE

National Code:

B =

v National annex:

- Standard EN

'Thick-walled' Concrete cross-sections: the advanced 2D FEM method is off!

OK

Cancel

The Reinforcement material (e.g. BSOOA) chosen in the Project data window, will define the steel quality used
for the theoretical reinforcement design.
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Properties of the slab and the line supports:

B 2D member X 2 Line support on 2D member edge X
Name S1 Name Slel
Elementtype Standard v Constraint Hinged v
Element behaviour Standard FEM Z Rigid v
»"T\Z'/ s ja Type plate (90) v TRZ Rx Free v
R = IT Material €20/25 Yo Z Ry Free 7
55 .7 R o FEM model Isotropic v % 4 Geometry
// /// FEM nonlinear model none v > System GCS i
_____ Thickness type constant S Coord. definition Rela ¥
Thickness [mm] 250 Position x1 0.000
z LCS type Standard i n Position x2 1.000
) LCS angle [deg] 0.00 ) Origin From start v
% Y Layer Layerl Wi £ Ty
b Structural model
= W, — e
* LOADS
= Load cases & Load groups
Load Case Action type Load Group Relation EC1l-Load type
Self-weight Permanent LG1 / /
Walls Permanent LG1 / /
Service load Variable LG2 Standard Cat B: Offices
B Load cases X # Load groups X
FILIFES «» 0 @b a . Y  E ALl E a2 O @0
LC1- Self weight Name LC1 LG2 Name LG2
LC2-Walls Description Selfweight Relation Standard
LC3 - Service load Action type Permanent v Load Variable
Load group LG1 MES Structure Building
Load type Selfweight v Load type CatB : Offices
Direction -Z v
New | Insert Editr Delete Close New | insert Editi OK
= Load combinations
Type EN-ULS (STR/GEO) Set B
Type EN-SLS Quasi Permanent
® | Combinations X

H-iRIFE «a» O

Input combinations

v

ULS-Set B (auto)
SLS-Char (auto)
SLS-Quasi (auto)

4 Contents of combination

Actions

New | Insert Edit

Updated automatically
Active coefficients
LC1 - Self weight[-] 1.000

LC3-Service load [-] 1.000

Name SLS-Quasi(auto)
Description
Type EN-SLS Quasi-permanent

Structure Building

LC2-Walls [-] 1.000

Explode to envelopes >>>
Explode to linear >>>

Show Decomposed EN combinations  >>>

Close
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= Result classes

All ULS+SLS

B Result classes X

#F-IRBFE «a2 O a v Y

AlLULS Name AllULS+SLS

AlLSLS Description

AlLULS+SLS 2 [ist
ULS-SetB (auto) -EN-ULS (STR/GEO) SetB
SLS-Char (auto) -EN-SLS Characteristic
SLS-Quasi(auto) -EN-SLS Quasi-permanent

New | Insert | Edit | Delete Close

+ FINITE ELEMENT MESH

= Introduction

2 types of finite elements are implemented in SCIA Engineer:
e The Mindlin element including shear force deformation, which is the standard in SCIA Engineer.
The Mindlin theory is valid for the calculation of both thin and thick plates.
e The Kirchhoff element without shear force deformation, which can be used to calculate and design

only thin plates.

The element type used for the current calculation is defined in the Tools menu > Calculation & Mesh > Solver

Settings:
B Solver setup %
Name SolverSetupl A
Specify load cases for linear calculation
4 Advanced solver settings
4 General
Neglect shear force deformation (A >> A
Bending theory of plate/shell analysis Mindlin v
ype of solver Direc v
Number of sections on average member 10
Warning when maximal translation is greater than [mm] 1000.0
Warning when maximal rotation is greater than [mrad] 100.0
Coefficient for reinforcement 1
4 Effective width of plate ribs
Number of thicknesses of rib plate 20
4 Detection of adjacent beam / edge
Parallelism tolerance [deg] 10.00 v
(ERfanf ————— ——— EUMNILN,

= Mesh generation

Via the tools menu = Calculation & mesh = Generate mesh
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= Graphical display of the mesh

Set view settings for all entities, via right mouse click in screen or more options > View settings for all entities

u
MORE CPTIONS
Structure nodes
Local axes

Labels of local axes

0BoA

Structural shape labels

View settings for all entities

e Structure tab - Mesh - Draw mesh
e Labels tab > Mesh - Display label

= Mesh refinement
Via the tools menu - Calculation & mesh > Mesh settings
Average size of 2D (mesh) elements is by default=1 m

B | Mesh setup X

Name MeshSetupl
Average number of 1D mesh elements on straight 1D members 1

Average size of 1D mesh element on curved 1D members [m] 0.200
Average size of 2D mesh element [m] 1.000
Connect members/nodes 2

Setup for connection of structural entities
b Advanced mesh settings

B e 0K Cancel

OR

The mesh size can be changed in the FE analysis window before running the calculation.

B FE analysis X

Calculations 4 Mesh setup

r Average number of 1D mesh element 1
|2 Linear analysis

i ' Average size of 1D mesh element on ¢ 0.200
| Loadcases:3 |

' I Average size of 2D mesh element [m] 1.000
Otheriprocesses Connect members/nodes
Testinputofdata Setup for connection of structural en

P Advanced mesh settings
Save project after analysis 4 Solver setup
Specify load cases for linear calculati
P Advanced solver settings

Calculate

118 MJ — 08/08/2024



‘Basic rule’ for the size of 2D mesh elements: take 1 to 2 times the thickness of the plates in the project. For
this example, take a mesh size of 0,25 m.

oo

r @
[l
[ B

Opening]l @

L1000 |, 1000

Slgh|l

6000

4000

3333

L 2667

3000 | 1000

7 10000

(A)

©

2.4.2 Results for the linear calculation
* SPECIFICATION OF RESULTS

After running the linear calculation, go to the Results menu - 2D members - 2D Internal Forces.

Specify the desired result in the Properties panel:

System:

RESULTS (1) A

Name

v SELECTION
Type of selection

Filter

¥ RESULT CASE
Type of load

Combination
Envelope (for 2D drawing)
Averaging of peak
Location
System
Extreme
Type of values
Values

¥ OUTPUT SETTINGS
Print combination key
Standard result
Results on sections
Results on edges

» TABLE SETUP

2D internal forces

All v

No v

Combinations
ULS-Set B (auto) v/

Absolute extreme

Qo

In nodes avg. on macro
LCS mesh element v
Global

Basic magnitudes

» ERRORS, WARNINGS AND NOTES SETTINGS

ACTIONS 2>

@ Refresh

@ New combination from Combination key

@ Drawing setup 2D

@ Preview

e LCS mesh element: according to the local axes of the individual mesh elements
e LCS - Member 2D: according to the LCS of the 2D member (Pay _attention_ when working with shell

elements!)
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Location: 4 different ways to ask for the results, see chapter Results

Type forces: Basic, Principal or Design magnitudes, see Annex 1

Drawing setup 2D: Click on the button EI Here you can modify the display of 2D results (Isobands /
Isolines / Numerical results / ...), modify the minimum and maximum settings, ...

After making changes in the Properties panel, you always have to execute the ‘Refresh’ action.
* TYPES OF RESULTS
= Basic magnitudes

Combination = ULS; Type forces = Basic magnitudes; Envelope = Minimum; Values = m_x

These are the characteristic values coming from de FE-analysis in the center of the plate.
= Elementary design magnitudes

Combination = ULS; Type forces = Design magnitudes; Envelope = Maximum; Values = m_xD+

0.00
-20.00
-40.00
-60.00
-80.00

-100.00

mxo+ [kN1/m]

-120.00
-140.00

-170.68

The convention for the sign of the design moments has been changed since the v17 post-processor. Now a moment is positive when
it causes a tensile force on the bottom of the plate and negative when it causes tensile force at the top of the plate.

In the v16 post-processor a design moment is positive when you should reinforce for this moment. This means that for a positive value
for m_xD+ there is a tensile force at the top of the plate and that for a positive value for m_xD- there is a tensile force at the bottom of
the plate.
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The available values are mxD, myD and mcD, where ‘D’ stands for design. The ‘+’ and ‘-‘ respectively stand
for the values at the positive and negative side of the local z axis of the 2D member.

So for instance the value mxD+ is the moment that will be used for the design of the upper reinforcement in
the local x-direction of the 2D member.

The calculation of design moments for plates and shells according to the EC2 algorithm follows the chart from
CSN P ENV 1992-1-1, Annex 2, paragraph A2.8.

m_ozm, . a=xh=y

m,o<m, L a=y, h=x
m, = —|m,‘1.|
YES NO
- m, =0
Mg =M, + ‘m:‘_r| ab-
T
_ M., =m, +m._ " /|lm
Myp, =1, +|mx\1_| bD- 2" M . | g| \
N 3
M.p = -2- |m'{r‘ Mp. = _|ma|(-.1+ t.m:;r My }‘ ]
m, é‘mm.|
YES NO
.
Mg, =—H,+ ‘mm.| Map. =—M,+ M, _.-'|mb|
My, =—M, +|mm. My, =0
f . A
M,p. = _2_|m$‘ M. = —|mb|f._1+ (m,;. ma_)‘ J

What happens, is that for the 3 characteristic (bending and torsion) moments an equivalent set of 3 design
moments is calculated:

mx mxD
my = myD
mxy mcD

It is clear that mxD and myD are the moments to be used for the reinforcement design in the respective
direction. The quantity mcD is the design moment that has to be taken by the concrete. The Eurocode does
not mention any check for this value, but it is however available in SCIA Engineer for the reason of
completeness.
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The calculation of design forces for walls according to the EC2 algorithm follows the chart from CSN P ENV
1992-1-1, Annex 2, paragraph A2.9.

n,ozn, 1 oa=xb=y
n,<n, 1 oa=ypb=x
n, ‘Pin:
YES NO
HGD=HE+‘HKF| ny=0
,
= My, =0, +1_"/|n
Myp _”b+‘”x_1= 2 B xs-{' a| )
)
Hp =1 (1+ M. /7 )’J
— \ i
.pn __‘-‘HI.F <D | a|_ ¢y al |

Analogously, if membrane effects are present, for the 3 characteristic membrane forces an equivalent set of 3
design forces is calculated:

nx nxD
ny = nyD
nxy ncD

Here, the quantity ncD does have a clear meaning: it is the compression force that has to be taken by the
concrete compression struts. Therefore, to make sure that concrete crushing will not occur, the value ncD
should be checked to be < fcd.

Attention: These design magnitudes are not the ones used by SCIA Engineer for the reinforcement design in
the Concrete menu. A much more refined transformation procedure is implemented there to calculate the
design magnitudes from the basic magnitudes.

=  Principal magnitudes
Results menu - 2D members = 2D stresses/strain

Combination = ULS; Type forces = Principal stress; Envelope = Maximum; Values = g1+

164
14.0
12.0
10.0
8.0
6.0
4.0
2.0
0.0
2.1

o1+ [MPa]

-3l

‘1" and ‘2’ refer to the principal directions, calculated based on Mohr’s circle.

The first direction is the direction of maximum tension (or minimum compression). The second direction is the
direction of maximum compression ( or minimum tension).

Keep in mind that the most economic reinforcement paths are the ones that follow the trajectories of the
principal directions!
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Chapter 2: Design and Check

- COMPARISON MINDLIN <& KIRCHHOFF
= Shear force vx

Combination = ULS; Type forces = Basic magnitudes; Envelope = Maximum; Values = v_x

Mindlin

vx-max [kN/m]

649.58
587.50
525.00
462.50
400.00
337.50
275.00
21250
150.00
75.00
0.00
-50.00
-100.00
-150.00
-212.50
-275.00
-350.44

-w082 Mesh size = 0,05 m

Kirchhoff
vx-max [kN/m]
44971
400.00
¥ i 350.00
g P 32000
q [ 280.00
d L 240.00
200.00
4 F | oo
: Openingl q : i;;z
q 5 A 40.00
-0.00
| ¥ -40.00
q 1 -30.00
4 [ 120.00
q Lo | -1e0.00
) L |2z
1 b
& &
Section at lower edge
240,07
lL \N\Mﬁ\ T =1
180,45 Mesh size = 0,25 m
205.86
Lﬂmw——mmﬂmﬂmmmw_ mmm]]]]]]ﬂ]ﬂ]]]ﬂﬂWmW e + 4
134,23 Mesh size = 0,05 m
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= Torsion moment mxy

Combination = ULS; Type forces = Basic magnitudes; Envelope = Maximum; Values = m_xy

Mindlin
mxy-max [kNm/m]
71.80
60.00
50.00
‘ 40.00
‘ 30.00
20.00
10.00
0.00
Openingl i;ggg
-30.85
SIBA
/
|
|
|
|
Section at lower edge
l —8.28
T T]TTY
Wm T 1
8.02 Mesh size = 0,25 m

Mesh size = 0,05 m

mxy-max [kNm/m]

6362
54.00
48.00
4200
38.00
30.00
2400
18.00

Opening q 2o
S
P d = 500

= :
A 3

Kirchhoff

34 3@ Mesh size = 0,25 m
— 15,60
L, st
3469 Mesh size = 0,05 m

Conclusion: Kirchhoff gives the expected shear force values, Mindlin gives the expected torsion moments.
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2.4.3 Concrete setups
+ GENERAL SETUPS

= Setup 1: National Determined parameters

File > Project settings - National annex [...] > EN 1992-1-1[...]

OR

Click on the flag at the top right of SCIA Engineer - Manage annexes - EN 1992-1-1[...]

B | Concrete setup

4 Type of values

4 Type of functionality
Hollow core beams u
Prestressing

NA building =

[=-Standard EN
Concrete

(- General
Concrete
Non-prestressed reinforcement
~Prestressed reinforcement
Durability and concrete cover
=-ULs
General
Punching
B-sLs
General
(=) Detailing provisions
Common detailing provisions
~2D structures and slabs
~Punching

Select all Unselect all

Refresh

= Setup 2: Concrete settings

Concrete menu - Concrete settings

Concrete settings
Views: Complete setup

Description
<all>
4 Design defaults
b Reinforcement
b Minimum cover
4 Solver setting
4 General

Limitvalue of unity check

4 Creep and shrinkage

b Internal forces

Value of unity check for not calculated unity check

The coefficient for calculation inner lever arm

v \Viewsett... v || Load default Find

Symbol Value

POl <al> Ol<al> L

Lim.check 1.0 1.0

Neal.check 3.0

The coefficient for calculation effective depth of cros... Coeffy 0.9

Coeff, 0.9

The coefficient for calculation force, where member ... Coeffooy, 0.1

Age of concrete at the momentconsidered t 18250.00
Relative humidity RH 50
Type inputof creep coefficient Type @(t,to) Auto Auto
Age of concrete atloading to 28.00
Consider drying and autogenous shrinkage Type £c5(t,ts Auto Auto
Age of concrete at the beginning of drying shri... tg 7.00
4 SLS
Use effective modulus of concrete
4 Defaultsway type
Sway around y axis Sway yy
Sway around z axis Sway zz

[<J1 <]

Name Standard EN

4 Concrete
4 General

4 Concrete
4 National annex
4 EN_1992_1_1
4 ygy-partial factor for shrinkage acti
Value [-] 1.00
4 yc - partial factor for design values
Values [-] 1.50/1.20
4 fex max - Maximum value of the char
Value [MPa] 90.00
4 a.. - coeff. taking account of long tei
Value [-] 1.00
4 ay - coeff. taking account of long ter
Value [-] 1.00
4 K1 req - coeff. for calculation of ratio
Value [-] 0.44
4 Kg req - coeff. for calculation of ratio
Formula Formula
4 K3 req - coeff. for calculation of ratio
Value [-] 0.54
4 Ky req - coeff. for calculation of ratio
Formula Formula
4 Ksg req - coeff. for calculation of ratio
Value [-] 0.70
4 Kg req - coeff. for calculation of ratio
Value [-] 0.80

Load default NA parameters

National annex: -

Default | Unit ' Chapter Code Struct... CheckT...

<al> O <all> O <all- O <all> O <all> O

Independe... A

day 13.1.4B.1-2 EN1992-1-1
% 3.1.4.B.1-2 EN1992-1-1 A
3.1.4(2) EN1992-1-1 A
day 3.1.4(2),B1 EN1992-1-1
3.1.4(6) EN1992-1-1 A
day 3.1.4(6),B2 EN1992-1-1 |A

7.1(2) EN1992-1-1 Al

Independe.

Independe...

v

Cancel

OK

Cancel

All of the adjustments made in one of the two general setups are valid for the whole project.
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+ MEMBER DATA

It is possible to overwrite the data from the general setups per 2D member, namely by means of Member
data. This is automatically defined on any 2D member (same is true for 1D members).

=
2D MEMBER (1) > CONCRETE 2D DATA (1) Q
Name CMD2D
2D member
Member type  Plate s

¥ DESIGN DEFAULTS
REINFORCEMENT
PLATE
LONGITUDINAL

Design of provided reinforcement (*:/

Design template of provided reinforc... Plate o :_.—:
Material B 500B s :—._:
UPPER (Z+)
Type of cover  Auto s
Type of first layer  Principal s
Diameter of first layer [mm] 10,0 s

Angle of first layer direction [deg] 0,00
Type of second layer  Principal v

Diameter of second layer [mm] 10,0 s

Angle of second layer direction [deg] 90,00

2.4.4 ULS design
+ REINFORCEMENT DESIGN

= Internal forces
Design menu - Concrete 2D - Internal forces

Basic (centroid) : the values shown here are exactly the same as in the Results menu; they are calculated by
the FEM solver.

Design (centroid) : the values shown here are different from those in the Results menu.
e The design magnitudes in the Results menu are calculated by the FEM solver according to some
simple formulas specified in EC-ENV.
e The design magnitudes in the Concrete menu are calculated by the NEDIM solver, where a much
finer transformation procedure is implemented, based on the theory of Baumann.
These are the values that will be used for the SCIA Engineer reinforcement design.
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Theory of Baumann:

1) Calculation of the lever arm.

The lever arm is necessary for the calculation of surface forces. Value z will be calculated in the direction of
the angle of the first principal moment. The forces will be recalculated and a cross-section set will be created
in this direction. The reinforcement will be designed for these recalculated forces and from the designed
reinforcement the inner lever arm will be calculated.

Principal stresses and directions at both surfaces
0.=0.48 MPa ¢,.=0.11 MPa -> o, =-5.86=-5.86"
0. =-0.11 MPa oy. =-048 MPa -> . =-5.86"°
-> direction for calculation inner lever arm
oz =-5.86

Recalculated forces to direction of inner lever arm
n,=0.0 m,=49704

O fo  1-2010°

fy= - = 1333 MP
VR 15 @
d=210 mm
£ 0.0018 _
N=1-05 =-=1-05- 00 -=075
2 2 2 2
f2  Eo 0.0035°  0.0018
2 6 2 6
p=1- 2 Ewp-E2 - 2 0.0035-0.0018 0.389
faz 0.0035 - 5
£ 0.0035
Epal = = P 500 = 0.617
_ Yk A
g2t g 00035 s 500000

Xbal = &pal-d = 0.617-210=0.13
Nebal = - &pal*d-b-n-fog=-0.617-210-1000-0.75-13.33 =-1295 kKN/m
n; = 0 kN/m > ncpa = -1295 kN/m => predominant tension

1
d 1‘\/1-4'[3' abs(mz)—nz-(d.—O.S-h)

=ﬁ

X

b-d”n-fus
|
_ 2-06.23189' 1_\] : _4.0'389'abs(4970)—0-2(0.21 - 0.5-250) o
1000-0.21°-0.75-13.33
z=d-B-x=210-0389-2 =209 mm
Z, =124 mm
z =85 mm

If value z cannot be calculated it will be calculated according to formula: z=0,9 *d
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2) Calculation of normal forces at the surfaces of 2D element.

The inputted internal forces will be recalculated to both surfaces according the following formulas:

Lower surface

om0 493
M=yt = Y o009 ~ 230 KN/m
oo.ny om0 122
T T 7 T2 T 0209

Ny My 0 -0385
YT YT, T2 Top09 - BKN/m
Upper surface
Ny My _g_ 493 _
M= T, =5 o209 - 23O KN/m
ny om0 122
=3 "7 T2 0209 - BKN/m
Ny My _Q_ -0.385
My =TT, = T o209 - BKN/m

3) Calculation of principal forces at surfaces of 2D element.

The principal forces at both surfaces and the direction of the first principal force will be calculated according to
the following formulas:

Lower surface
Principal forces at lower surface:

MNe- +Ny- 1 2 2
m-=T+—- nx-—ny.) +4 - nyy-

236 58 2
- (236-58) +4-18 =238kW/m
1
Ny + 1N 2
.= ———>~ —1—'\1 _—ny + 4Ny
2
1
2
=¥—%--\/ (236-58) +4--18" =57 kN/m
Direction of principal forces:
2Ny 2--18 i
al-=05-ArcTg e — Ny —0.5-Arch(23.6_5.8)——6

Upper surface
Principal forces at upper surface:

Nx+ + Ny+ 1 2
n|+:27+?- (nx+—ny+ +4 - nyy+

|
236+-58 1 : 2
:7++?\/ (-236--58) +4-18 =-57 kN/m

Nes +Nys 1 2 2
e = =Y (N = Nys ] +47Nyye

_ -236+-58
2
Direction of principal forces:

2 Ny 218
—= ) 90=05-ArcTg[—="°—|-90=-96
s — Ny ) c 9( 236 - —5.8)

1 2 2!
—?-\/ (-236--58) +4-18" =-238kN/m

o+ =0.5-Arclg
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4) Recalculation of principal forces at both surfaces to inputted directions.

The recalculation of the principal forces to the inputted direction will be done separately for both surfaces by
using Baumann’s transformation formula.

Lower surface
Angles for Baumann's transformation formula
Ol1-= Qlinp,1- —-=0--6=6°
02-= Qinp2- — - =90--6=96°
Q3-= Qeon-— - =45 --6=51"°

Recalculated dimensional forces at lower surface (acc. to Baumann)
nj-- sin (th_)' sin (0[3.)+ njj-- COS (-:12.)- cos(ag.)

fEdst-= sin{ o — - -sin(ag-—ou-
23.8-sin(96)- sin(51)+ 5.7 - cos (96)- cos (51)
) sin(96 - 6)-sin(51 - 6) = 254 kN/m
ni--sin (Dtg_)' sin(0t1.)+ nji-- COS (-:13.)- cos(ou.)
Meds2- = sin (0(3- - Otz_)- sinlo- — Otz_)
23.8-5in(51)- 5in(6)+ 5.7 - cos(S'])- cos(6)
) sin(51 - 96)-sin (6 - 96) = 77 kN/m
. ni--sin (ou.)- sin(cxg.)+ nji-- COS (-:11.)- cos(ag.)
Eds3- =

sin{ a- — os- -sin(az- - O3-
23.8- 5in(6)- 5in(96)+ 5.7- cos (6) cos (96)
sin(6 - 51)-sin(96 - 51)

=-3.7 kN/m

Upper surface
Angles for Baumann's transformation formula
01+ = Qinp,1+— 00+ =0--96=96"°
02+ = Clinp,2+— M+ =90 —-96 =186 °
03+ = Olcon+ — Qi+ = 135 - -96 = 231 °

Recalculated dimensional forces at upper surface (acc. to Baumann)
N+ - sin(csz- sin(om) + N+ cos(az+)- cos(a3+)

edst- = sin(a2+—0t1+)-sin(a3+—0t1+)
-5.7-sin(186)-sin(231) + -23.8 - cos(186)- cos(231)
- sin(186 — 96)-sin(231 - 96) =217 kN/m
_ n|+-sin(0t3+)-sin(0t1+ - n||+-cos(0t3+)-cos(0t1+)
feds2+ = sin{oz. — oz4) sin{ors — 024
-5.7-sin(231)- sin(96)+ -23.8- cos(231)- cos(96)
) sin(231 - 186)- sin(96 - 186) =40 kN/m
n|+-sin(0t1+J-sin(a2+)+ n||+-cos(0t1+ -cos(agJ
edss = sin(om—a3+)-sin(a2+—a3+)
_ 5.7-5in(96)-sin(186)+ -23.8-cos(96)- cos(186) _ 37 im

sin(96 - 231)-sin(186 - 231)
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5) Calculation of virtual forces at both surfaces to inputted directions.

The virtual forces are necessary to convert the pressure/tensile forces at the surface back to the center of the
plate. The virtual force represents the equivalent force at the other side of the plate.

Virtual forces at both surfaces
Lower surface
Angles for Baumann's transformation formula
Qly = Cinp1+— . =0--6=67
Oy = Clinp2+ — ¢4 =90 --6=96"°
O3, =0y — Q. =45 --6=51"°

Recalculated virtual forces at lower surface (acc. to Baumann)

ni.-sin (o:2+)- sin (0(3+) + Ny.- €os (d2+)- cos (0(3+)

AEdsvirt1- = sin(o:2+ - om)-sin (0(3+ - 07+
23.8-5in(96)- sin (51) + 5.7 - cos (96)- cos (51)
- sin(96 - 6)-sin(51 - 6) =234 kN/m
n\,-sin(a3+)-sin(a1+)+ n|\,-cos(a3+)-cos (om)
MEdsvirt2- = sinlo: —az. ) -sinloq: — aos
23.8-sin(51)-sin(6) + 5.7 - cos(51)- cos(6)
) sin (51 - 96)- sin(6 - 96) = 7.7 kN/m
n\--sin(o:1+)-sin(cx2+)+ nii- - cos (om)-cos (a2+)
NEdsvirt3- =

sin{a1+ — az+)-sin|c: — o3+
_ 238-sin(6)-5in(96) + 5.7 - cos (6)- cos (96)
- sin(6 - 51)-sin(96 - 51)

=-3.7 kN/m

Upper surface
Angles for Baumann's transformation formula

0. = Wipp,1- — Ape = 0--96=96"°
O2- = Olinp,2-— %+ =90 --96 =186 "°
O3-= Oon+ — Ol =135 --96=231"°

Recalculated virtual forces at upper surface (acc. to Baumann)

N+ -sin (0:2_)- sin (0:3_) + Ny« COS (0(2_)- cos (or3_)

MedsvirtT = = sin(ag_ - oz1_)- sin(ozg_ - 0
_ -5.7sin(186)sin (231)+ -23.8 -cos (186)- cos (231)
- sin(186 - 96)-sin (231 - 96) =217 k/m
o m+-sin(a3_)-sin(ou_)+ n|\+-cos(a3_)-cos(cx1_)
MEdsvirt2+ = sinlos. — ax ) sinl o — oo
_ -5.7-sin(231)-sin(96) + -23.8 - cos(231)- cos(96) _
- sin(231 - 186)-sin (96 - 186) = 40 kN/m
n\+-sin(on.)-sin O2-)+ Ny« cos | a- -cos(org.)
Medsirt3= = sinlat- = as-)- sinl az- = ;-
_ 5.7 sin(96)-sin(186)+ 23.8- cos(96)- cos(186) 7y

sin(96 - 231)-sin (186 - 231)
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6) Recalculation of forces at surfaces to center of gravity of cross-section.

Using the transformed dimensional forces and virtual forces the internal forces at the center of the plate can
be calculated.

Lower surface
Dimensional forces of lower surface transformed to centroid
Nedi- = Nedst- + Nedsvirti+ = 25.4 + -21.7 = 3.7 kN/m
Meg1- = Neger-* Z- = Negsvirtt s * 2 = 25.4 85 = -21.7 - 124 = 4.9 kKNm/m
NEd2- = Nedsa- + Nedsvir+ = 7.7 + -4.0 = 3.7 KN/m
MEda- = NEgsz- * Z- — Negsviriz+ " Z+ = 7.7 -85 —-4.0-124 = 1.2 KNm/m
NEga- = Neds3- + Nedsvira+ = -3.7 + -3.7 = -7.4 kKN/m
Meds- = Negsa-  Z- — Nedsvira+ *Z+ = -3.7 -85 = -3.7-124 = 0.1 kNm/m
Upper surface
Dimensional forces of upper surface transformed to centroid
Ned1+ = Nedst1+ + Nedsvirtr- = -21.7 + 25.4 = 3.7 kKN/m
Medis = - Nedsts  Zs + Nedsyirn- - Z. = - -21.7 - 124 + 25.4 -85 = 4.9 kNm/m
Nedos = Nedeos + Negevir- = -4.0 + 7.7 = 3.7 kKN/m

Medo+ = - Nedso+ - Ze + Negevir- - Z- = - -4.0-124 + 7.7 -85 = 1.2 kNm/m
Ned3+ = Neds3+ + Nedsvirs- = -3.7 + -3.7 = -7.4 kN/m
Meda+ = - Nedsa+ * Zo + Nedsyirz-* Z- = - -3.7- 124 + -3.7- 85 = 0.1 KNm/m

The available values are: mEd,1+, mEd,2+, mEd,c+, mEd,1-, mEd,2-, mEd,c-, nEd,1+, nEd,2+, nEd,c+, nEd,1-
, NEd,2-, nEd,c- and vEd. “+” and “-“ stand for the design values at respectively the positive and the negative
side of the local z-axis of the 2D member. “1” and “2” stand for the reinforcement directions, which are by
default respectively the local x- and y- direction of the 2D member. (mEd,c+ and mEd,c- are the design

moments that would have to be taken by the concrete, but they have no real significance for the reinforcement
design.)

Combination = ULS; Type values = Design internal forces; Value = mEd, 1+

I"nE’dl + [kNm/m]

>

7

Compare the result for this value mEd,1+ (Concrete menu) with the result for the equivalent value mxD+
(Result menu) shown on page 120.

Despite the different transformation procedures, the general image of the results will be similar for orthogonal
reinforcement directions (acc. to the local x and y axes). The largest difference is caused by the shift rule that
is only taken into account in the design magnitudes calculated by the NEDIM solver (values mEd,1 and mEd,?2).
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The shift rule takes into account the additional tensile force caused by the shear force by shifting the moment

line by a distance ai. ai is determined as in the image below.

O

10: a,= Coeff,-d - (cot@ - cota) / 2
20 a=d

The shift rule is taken into account in the default concrete settings. You can deactivate this option in the

concrete settings.

Concrete settings

views: Complete setup v View sett... v | Load default Find

Description Symbol
<all> £ <all>
4 Design defaults
b Reinforcement
b Minimum cover
4 Solver setting
b General
4 Internal forces
Shear force reduction above supports
Momentreduction above supports

P <all=

Value

» [shifting of moment curve to cover additional tensile force caused by shear

Geometricimperfection in ULS GiuLs
Geometricimperfection in SLS €isLs
Minimum eccentricity €min
Firstorder eccentricity with the equivalentmoment

Second order eccentricity ey

v

Internal forces modifications
DesignAs

Conversion to rebars

Interaction diagram

Shear

Torsion

Punching

Stress limitations

vy vvYSYvYTVYYSY

Cracking forces

I
V]
In firstorder ... In firstor
V] ]

Default

L <all>

Chapter
<al> 0O

6.2.1(8)
5.3.2.2(4)
9.2.1.3(2)
5.2(2)
5.2(3)
6.1(4)
5.8.8.2(2)
5.8.8

Code
<all> yol

EN1992-1-1
EN1992-1-1
EN1992-1-1
EN1992-1-1
EN1992-1-1
EN1992-1-1
EN1992-1-1
EN1992-1-1

National annex: -

Structure CheckTy...
<all> D <all>

Beam,B
Beam,B
Beam,Ri

Column
Colurmn
Column
Column

Column

0

Remark

[m]

v

B 10 3= Coeff,-d- (cot0 - cota) /2
20: 3,=d

Ifthe check boxis ON, the additional tensile
force caused by the shear force is taken
into accountusing the shift rule

OK Cancel

If we uncheck this option the general image of mEd,1+ is closer to the one obtained for mxD+ (page 120).

132

medi1 + [kNm/m]
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= Provided reinforcement

Before calculating the theoretical reinforcement it is possible to add a template of reinforcement to your
plate(s). This template can be used to:
e Compare the template with the calculated theoretical reinforcement. By doing this it is easy to see
where this basic template is not sufficient.
e Perform the punching design, Crack width check and the code dependent deflections.

The reinforcement added by the template is called Provided reinforcement.

To add Provided reinforcement go to Concrete menu - Concrete settings - Design defaults

Concrete settings ] X

views: Complete setup v \View sett... v || Load default Find Nalionalannex:-
Description Symbol Value Default Unit | Chapter Code Struct... ' CheckT...

<all> Pl <al> O <al> Pl <al> O <all> PO|<all> O <al> O <al> O

4 Design defaults

4 Reinforcement

> Beam/Rib
> Beamslab
b Column
4 Plate
4 Longitudinal
Design of provided reinforcement Independe... Plat Design d
Design template of provided reinforcement Plate_Basic_Ad... ... Plate_Ba Independe...|Plate,S... |Design d 4
4 Upper(z+)
Type of cover Typecs Auto Auto 4.4.1 EN1992-1-1 |Plate,S,
Diameter of firstlayer dsqs 10.0 10.0 mm EN1992-1-1 Plate
Angle of firstlayer direction o, 0.00 )0 leg EN1992-1-1 |Plate,S
Diameter of second layer dgpe 10.0 1 mm EN1992-1-1 |Plate,S
Angle of second layer direction ap, 90.00 0.00 deg EN1992-1-1 Plate.s
P Lower(z-)
4 Shear
Diameter of shear reinforcement 8.0 ) mm EN1992-1-1 |Plate,S... |Design d
Arrange perimeters of shear links automatically - 9.4.3 EN1992-1-1 Plate Design d

b Minimum cover

OK Cancel

Click on the 3 dots next to the ‘Design template of provided reinforcement’. This opens a window with all the
default templates.

B | Provided reinforcement (design) X

B EIRIFE a2 AW
Plate_Basic_AddList_All
Plate_Basic_Lower

Plate_Basic_Both

Plate_Basic_Add_Lower
Plate_Basic_Add_Both
Plate_Basic_AddListDiam_Lower
Plate_Basic_AddListDiam_Both

Name Plate_Basic_AddLis

Description Basicand list additi

Member type Plate, Shell(Plate)
Cross-section Rectangle
Mode Standard

New | Insert Edit OK

MJ — 08/08/2024 133



Advanced Concept Training — Concrete

You can select one of these templates, make a new one or edit one of the existing templates. Select the first

template and click ‘Edit’.

| Provided reinforcement (design) edit - Plate

Membertype Plate, Shell(Plate)

Cross-section

Standard

Mode

Longitudinal reinforcement

Definition of Basic By Diameter v

Basic (As,bas)

Layer Diameter Spacing
[mm] [mm] [em”2/m]
[1+] 10,0 200,00 3,93
[24] 10,0 200,00 3,93
. [1-] 10,0 200,00 3,93
[2-] 10,0 200,00 3,83
B, B,

Diameter
[mm]
10,0
10,0

Additional (As,add)

Spacing

[mm]

0,00;100,00;2...
0,00;100,00;2...
0,00;100,00;2...
0,00;100,00;2...

a X

Sortby As
[ecm*2/m]

min Area 0,00-7,85
min Area 0,00-7,85
min Area 0,00-7,85
min Area 0,00- 7,85

OK Cancel

In this window the reinforcement can be defined. There are 2 types of reinforcement in templates:

Basic reinforcement: This type of reinforcement is added over the entire plate.
Additional reinforcement: This type of reinforcement is only added in zones where, according to

the calculated theoretical reinforcement , extra reinforcement is needed. You can define a diameter
and spacing as extra reinforcement. A choice can be made to sort the additional reinforcement by
minimal area, minimal diameter or maximal spacing.

Note: In the design defaults you can change the reinforcement directions. These directions are respected by
as well the provided as the theoretical required reinforcement.

Concrete settings

views: Complete setup

v View sett... v | | Load default Find

Description Symbol Value Default
<all> Pl O <all> Pl <all> O
4 Design defaults

4 Reinforcement

b Beam/Rib
> Beamslab
b Column
4 Plate
4 Longitudinal
Design of provided reinforcement
Design template of provided reinforcement Plate_Basic_Ad... ... Plate_Ba
4 Upper(z+)
Type of cover Typecs Auto Aut
Diameter of firstlayer dgqs 10.0 1€
Angle of firstlayer direction Oy 0.00 0.0!
Diameter of second layer dgpe 10.0 10.
Angle of second layer direction oy 90.00 C
4 Lower(z-)
Type of cover Typec. Auto Aut
Diameter of firstlayer dgq- 10.0 1
Angle of firstlayer direction oy 0.00
Diameter of second layer dgo. 10.0 10.
Angle of second layer direction o 90.00 0.

134

b Shear

Unit | Chapter

mm

mm

0

<all>

44.1

m] X

National annex: -

Code Struct..

<all>

Independe... Plate S,
Independe... Plate,S

EN 1992-1-1 |Plate,S.

EN1992-1-1 Plate.S.
EN 1992-1-1 |Plate.S.
EN1992-1-1 Plate,S
EN1992-1-1 |Plate,S.
EN1992-1-1 Plate

EN1992-1-1 |Plate,S.
EN1992-1-1 Plate,S.
EN1992-1-1 |Plate.S.
EN 1992-1-1 |Plate,S.

OK

CheckT..
Pl <all= O <all> O

>>

Cancel
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= Theoretical reinforcement
Concrete Menu-> ULS & SLS 2D Reinforcement design
In the menu Reinforcement design (ULS) you have 5 types of values:

¢ Required: These values represent the theoretical reinforcement calculated by SCIA Engineer. This
takes into account the detailing provisions.

4 Plate, Shell{Plate)
4 Longitudinal
Check min. ratio of principal reinforcement
Type of the minimum tension principal reinforcementf.. Auto
Type of the minimum tension principal reinforcementf.. Auto
Check max. ratio of principal reinforcement
Check min. ransverse ratio of secendary reinforcement
Check min. bar distance
Minimal bar distance slp.min 20
Check max.spacing of principal lengitudinal reinforcement
Check max.spacing of secondary longitudinal reinforcem...
4 Shear
Check min. ratio of shear reinfarcement
Check min. thickness of member with shear reinforcement
Min. thickness of member with shear reinforcement Hmin 200

Check max. spacing of shear links

Max. spacing of shear links Coeffgmayps 0.8

291
260
240
220
200
180
160 —
140 ==
120
100

Asreq,1+ [m‘n 2 /m]

60
40
20

As,reql+: Theoretical required reinforcement on the top side of the plate (positive z direction) in the
first reinforcement direction. Taking into account the detailing provisions.
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e Required — Statically: These values represent the theoretical reinforcement calculated by SCIA
Engineer without the detailing provisions taken into account.

262
240
220
200
180
160 —

140
B
. 120
s - 100

60
40

5‘
i
)
iﬂhls 20
:
il

Asult,1 + [Mm2/m]

Vi

As,ultl+: Theoretical required reinforcement on the top side of the plate (positive z direction) in the
first reinforcement direction. Without taking into account the detailing provisions.

¢ Required — Not covered: These values show if there is extra reinforcement needed on top of the
provided reinforcement. Areas where this value is 0 are areas where no extra reinforcement is
needed (compared to the provided reinforcement). Areas where these values are not 0 are areas
where the provided reinforcement is not sufficient.

e
=
BAsreq1+ [mM m2/m ]

AAs,reql+: Theoretical additional required reinforcement on top of the provided reinforcement on the
top side of the plate (positive z direction) in the first reinforcement direction.
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e Provided: These values show you the provided reinforcement defined in the templates.

No.prov,1+
g10,0/200 + @10,0/100! (insufficient)

210,0/200 + ¢10,0/100
10,0/200 + ¢10,0/200
210,0/200 + ¢10,0/300
10,0/200 + p10,0/400
10,0/200

I/

3

|

As,prov,1+ or N@,prov,1+: Provided reinforcement on the plate in mm2/m or as the amount of
reinforcement respectively. If elements are red the additional reinforcement in the template is not
sufficient.

e Provided — Utilization: Unity checks where provided reinforcement is compared to the required
reinforcement. This will give you an idea of the efficiency of the reinforcement.

= Calculation of longitudinal reinforcement

The theoretical longitudinal reinforcement is calculated out of the design internal forces.

Direction of reinforcement layer [a=90°]

[2-]: lower surface
mMeg = -0.293 kNm/m | ngg = 166 kN/m [ULS/2]
fea =167 MPa (yc = 1.5, acc.= 1)
fya=435MPa (ys= 1.15)
@10 mm : d;=45 mm -> d=205 mm
x=-5mm -> z=185 mm
A, =187 mmzlm (tensile)

250
205

pi=0.091%
direction of reinforcement layer [a=0°

[1+]: uppersurface
mgg = -154 kNm/m | ngg = 166 kN/m [ULS/2] 2048 mm/m

fea =167 MPa (yc= 1.5, o = 1) L —_—
fya =435 MPa (ys= 1.15) >
e wn
wn

@10 mm :d4=35 mm -> d=215 mm
x=58 mm ->z=192 mm

A :=2048 mmZ/m (tensile)
pi=0.953%

21

Direction of reinforcement layer [a=90°]

[2+]: upper surface
Mgy = -0.293 kNm/m | ngg = 166 kN/m [ULS/2]

fea =167 MPa (yc= 1.5, o= 1) < :Sr—
fya =435 MPa (ys=1.15) o

@10 mm : d;=45 mm -> d=205 mm & §
x=-5mm ->z=185 mm

A..:=195 mm°/m (tensile)
01=0.095%
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= Calculation of shear reinforcement

Before calculating the shear reinforcement two checks are done:
¢ Ved < Vramax: The design internal forces on the plate should be lower or equal to the maximum shear
resistance of the plate.

cxL\.'\r'l—-)m." Z°Vq 'fcd
cotg(6) +1g(6))

e Ved<Vrac: If Veais smaller than Vrac No shear reinforcement is required. If this is not the case punching
shear reinforcement will be automatically calculated by SCIA Engineer.

VRd, max = (

1
Viae = max(‘]OG-(CRdc k-(100- oy e )7 + ks -acp)-d;o)

1
= max|10°- (0.12 -198-(100-458.10°-25)° + o.15-o)-0.21,-0)= 112 kN/m
Visemn = Max(10° (Voo + ks 02 )-:0) = max(10°- (0.486 +0.15-0)-0.21:0) = 102 kn/m
Vage = MaX (VrgeiVremin ) = max (112 kN/m;102 kN/m) = 112 kN/m

Check shear capacity (without shear reinforcement)

md,max
Vg = 823 kN/M £ Vrgmax = 878 kN/m (OK)

Check vpge
Veg = 823 kN/m <= vgy. = 112 kN/m (OK, no shear reinforcement is required)

When Ved > VRramax the following error appears in the output of the reinforcement design.

Punching shear resistance at the column Increase the column size or change plate
Warning  perimeter (vRd,max) is not sufficient acc. to properties (use higher grade of concrete
§6.4.3(2). material or increase the thickness).

This error message is found at locations with high peak values for the shear stress. Most of the time these
peak values are singularities, and do not occur in reality. You have roughly 2 options: you can just ignore the
peaks or average them, for example by means of Averaging strips.

+ Practical reinforcement design

Next to theoretical required and provided reinforcement you have also practical or User reinforcement. This
type of reinforcement can be added to the plate via the Concrete menu-> 2D Reinforcement.

B | Reinforcement 2D X

Name RR1
2D member Slab1
4 Reinforcement

Type Bars 7

Material B 500A \ A

Surface Upper v

Number of directions 2 b
Direction closest to surface 1 Y.

Angle of first direction [deg] 0.00

4 1
:E Diameter (dl) [mm] 10.0
sl sl @dl Concrete cover (cl,cu) [mm] 30
Bar distance (sl) [mm] 200
Offset [mm] 0

Reinf. area [mm"2/m] 393

Diameter (dl) [mm] 10.0
Concrete cover (cl,cu) [mm] 40
Bar distance (sl) [mm] 200
Offset[mm] 0
Reinf. area [mm”2/m] 393
Total weight [kg] 58.26
4 Geometry
Geometry defined by Polygon v
Actions
Load fromsetup >>>

OK Cancel
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This reinforcement is to be added separately at the upper and lower side, and in the different reinforcement
directions.

Note: You can add multiple layers of practical reinforcement on the same area. The reinforcement added to
this area is the sum of all these layers.

% Combination Provided reinforcement and user reinforcement

After running the reinforcement design, it might be possible the provided reinforcement is insufficient in certain
areas. This means you should introduce some additional reinforcement. In this case you can apply two different
workflows:
(a) Define all the reinforcement as practical reinforcement;
(b) Combine the provided reinforcement and the practical reinforcement which will only be defined in
the areas where it is necessary to define additional reinforcement.

This principle will be explained by using the following example for the ULS reinforcement design in direction
1orthelocal x-direction. Within the design defaults, you can define a template for the provided reinforcement
which can be used within the actual design. In this case the basic reinforcement will be set to @10 a 150 and
the addition reinforcement will be set to zero.

Provided reinforcement (design) edit - Plate_Basic_AddList_All a X

|
Membertype Plate, Shell(Plate) Longitudinal reinforcement
| Cross-section w | Definition of Basic By Diameter v
| Mode Standard Basic (As,bas) Additional (As,add)
Layer Diameter Spacing As Diameter Spacing Sortby As
[mm] [mm] [mm*2/m] [mm] [mm] [mm*2/m]
[14] 10 150 524 10 0 min Area
[24] 10 150 524 10 0 min Area
‘ [1-] 10 150 524 10 0 min Area
[2-] 10 150 524 10 0 min Area
B, B,
O
@]

OK Cancel
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When running the ULS design for the value As_prov,1-, it can be seen the provided reinforcement of @10 a
150 will be insufficient to withstand the acting loads. This indicates the application of additional reinforcement
will be necessary.

ReillfProv,L
$10/150 (insufficient)
$10/150

= v
—— N

When generating the value As_add,req,1-, you can see the exact amount of reinforcement in mm2/m which
needs to be added on top of the provided reinforcement. In this case an additional reinforcement of 578 mm2/m
will be necessary. This value can be translated into the configuration of @10 a 100 as practical reinforcement.

578

Asaddreq-[mm2/m]
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This value can be translated into the configuration of @10 & 100 as practical reinforcement. Since there is no
required additional reinforcement in direction 2, only one direction of reinforcement will be added to the 2D

member by using practical reinforcement as defined within the previous section.

B Reinforcement 2D

2

| ® ® \??

sl sl @dl

4 Reinforcement

4 Geometry

Actions

Name RR3
2D member Slab1

Type Bars
Material B 500A
Surface Lower
Number of directions 1
Angle of first direction [deg] 0.00
Diameter (dl) [mm] 10.0
Concrete cover (cl,cu) [mm] 40
Offset[mm] 0
Bar distance (sl) [mm] 100
Reinf. area [mm”2/m] 785
Total weight [kg] 359.44

Geometry defined by Polygon

Load from setup

>>>

- mumEuy

B 500A (10.0} a 100 mm
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When generating the results once more for the value As_prov,1- and activating the option ‘Consider user
reinforcement’, it can be seen the user defined reinforcement of @10 a 100 is added on top of the basic
reinforcement of @10 a 150 which is defined within the design defaults.

Extreme Global

Type of values  Provided & User v/
Values As,prov,1- v/

Consider user reinforcement

v LIMIT STATE CONDITION

Reinferov,1-
$10/150 + $10/100

The applied values are visible within the preview of the reinforcement design.

Longitudinal reinforcement - Summary

Designed reinforcement layers (in direction from the member local x axis):

Basic Additional o« As,mi\ A DAy As!eq As.prw As,ma( Smin(d)  Smax Status

User  Auto []  [mm7 [mm] [mm7] [mm7] [mm’] [mm’] [mm] [mm]

2+] $10/150 — 900 277 53— 277 524 10000 58 60 OK
011%  021% 537 <400

(-1  $10/150 $10/100 - 0.0 291 1102 -- 1102 1309 10000 55 60 OK
u 044%  0.52% 537 <400

21 010/150 900 277 70 - 277 524 10000 58 60 OK
011%  021% 537 <400

A; =g - required reinforcement area as max(A; uis As min) * AA seni As orov - provided reinforcement area; A; min/max - min/max
reinforcement area; Smax(min) - Maximum spacing of bars (minimum clear distance between bars

The option ‘Consider user reinforcement’ is also accessible within all the reinforcement checks — crack width,

punching and CDD. This allows you to easily check the reinforcement introduced by both the template and the
practical bars.
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2.4.5 SLS Design of 2D members — Crack width and stress limitation

Next to the ULS design of 2D members the Eurocode defines some restrictions related to SLS design as well,
more specifically the crack width and the limitation of the tensile stress in the reinforcement. Due to these SLS
conditions you might need to increase the amount of reinforcement which should be sufficient to withstand the
acting ULS forces. The total amount of reinforcement to fulfil the conditions for both the ULS and SLS design

can be calculated within SCIA as well as the increment of statically required reinforcement.

The principle of this design method will be explained by the following example of a 2D plate. On this member
CMD will be applied in which the crack width in the first direction at the bottom surface will be limited to
0,100 mm. The tensile stress in the reinforcement can be limited both within the design defaults and the CMD.

In this example the limit will be set to 150 MPa.

B CMD

4 Design As
4 Plate, Wall, Shell(Plate), Shell(Wall), Deep Beam

Coefficient for increasing the statically required area of reinforceme 0.00

Coefficient for increasing the statically required area of reinforceme 0.00

4 |nteraction diagram

Interaction diagram method NRdMRd

4 Shear

Type calculation/input of angle of compression strut User(angle)

Angle of compression strut [deg] 40.00

Cotangent angle of compression strut 1.19175359259421

4| Stress limitations

Stress limitin the reinforcement User input

Limit stress in reinforcement [MPa] 150.0

4 Cracking forces

Type of strength for calculation of cracking force f_{ctm}

Value of strength for calculation cracking force f_{ct,eff}

4| Crack width

Type of maximal crack width User-defined for different surfaces
User defined crack width for upper surface [mm] 0.100
User defined crack width for lower surface [mm] 0.100

Chapter:7.3.1(5)
Code: EN 1992-1-1
Remark : User defined crack width for lower surface w-

ST

4 Stresslimitations
Indirectload (imposed deformation)
b Stress limitin the reinforcement
b Cracking forces
I Crack width

b Dadl o aki

Auto A

Auto
Yield strength
User input

LLto

OK

. Cancel gn

Since this design method is applicable for the ULS and SLS, it is important to select a result class which

contains both ULS and SLS combination.

RESULTS (1)

Name

v SELECTION
Type of selection

Filter

™~

\/

Reinforcement design (ULS+SLS

All v

No v

[v RESULT CASE
Type of load

Class

Classes v

All ULS#SLS v

Envelope (for 2D drawing)
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The first step of the design procedure consists of the determination of As_req for the ULS state for each
direction and each surface. During this step SCIA will determine two values, more specifically:

(a) As_ult: the statically required reinforcement to withstand the ULS acting forces;

(b) As_req: the required reinforcement including the detailing provisions from the EN.

When looking at the given example, it can be seen the required reinforcement As_req,1- is equal to
1614 mm2/m. The statically required reinforcement As_ult,1- is equal to 1102 mm2/m. This value is a bit
lower since it does not contain the increment of longitudinal reinforcement due to the SLS design.

Asreq1-[Mm2/m]

CMD2D

Reinford =
3
5 ~
Class: Al L E
Extreme 1000 L
Selection! 900 =
Location: s
System: o =
700
600
500
400
300
200
100
I 0
I
[
i
>
=]
&
-
£
I3 Q
& &)
x

After the calculation of As_ult you can choose to integrate the SLS restriction and you have three possibilities:
e Combination of the ULS and SLS design based on cracks.
e Combination of the ULS and SLS design based on stress limitation.
e Combination of the ULS and SLS design based on cracks and stress limitation.

This can be defined within the properties of the reinforcement design.
w LIMIT STATE CONDITION

Design ULS

Design SLS (crack width) | @)
Design SLS (reinf. stress) | @[%)

¥ OUTPUT SETTINGS
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After activating these settings the increment of longitudinal reinforcement can be generated, in this case the
value AAs_serv,1-. SCIA will determine the principal forces mEd,ch and mEd,QP in order to calculate the
appearance of cracks based on the designed ULS reinforcement As_ult. Next to the principal forces it is also
necessary to calculate the amount of reinforcement in the direction of the principal forces.

Within the following step, SCIA will determine the maximum allowable crack width based on chapter 7.3.4 from
EN 1992-1-1:2004 and compare it to the defined limit as shown below.

Principal stress g|[-]=-4.58°
Meg,char = 65 KNm/m ] Ned,char = 0 kN/m
Megqp = 47 KNM/m | neg.qo = 0 kN/m
Recalculation of required areas to direction of principal stress

2 2
Asuito = Asuit1- - COS (A(XW-) + Aguir2- - COS (A(XZ-)
2 2
=1102-cos (-5) +277 - cos(-95) =1097 mm
Asservo = Asuito + DAssery,1- - COS (A(XT-)Z + DA gery 2 - COS (AQZ-)Z
=1097 + 511~ cos (-5) + 0- cos (-95) = 1605 mm?

Check of cracks occuring (87.1(2))
feierr = 2.6 MPa
o, =5.716 MPa > o, = 2.6 MPa => cracks appear

Check of reinforcement stress limitation (87.2(5))
o.=149.3 MPa < 0., = 150 MPa
Effective tension area (87.3.2(3))
heer = 644 MM => A, ¢ = 1605 mm” (p, ¢ =249 %)
Calculation of crack width (87.3.4)
N ki ko ks~ Peq B 0.8-0.5-0.425-0.01
Srmax = K3 -C+ 7’}% =34-0.03+ 0.0249 =170 mm (7.11)
g — k- hi '(1+Ue'ppeﬁ)
Pp.eff ’ 0.6-0;
Sm_Scm = Max ;
- E: E:
2.6
149.3-0.46- -1 1+6.35-0.0249
~ ( 0.0249 ] ( ) 0.6-149.3\_04689,
= max 200000 200000 | 00

Wi = Srmax €sm_Ecm = 170 mm - 0.468 %0 = 0.0797 mm
Check of crack width
wy, = 0.0797 mm s w5 = 0.1 mm

If the cracks are within the limit, then As_ult is sufficient to fulfill the restrictions for both ULS and SLS. If not,
then SCIA will start the iteration process to increase the As,ult by an extra amount of reinforcement to ensure
the crack width is within the allowable limits. When looking at the table below it can be seen an additional
amount of 1166 mm2/m for the first direction at the bottom of the member should be added to the reinforcement
As_ult,1-.

Longitudinal reinforcement - Summary

Designed reinforcement layers (in direction from the mem Xis):
Basic Additional « Asmin  Asur AA; ., 5req As.prcv Acrzc  Sminih  Smax Status
User Auto  [7] (mm’] [mm’] | [mm] fmm’]  [mm]  [mm’] [mm] [mm]

[2+] ¢10/150 -- 27 20.0 277 53 0 277 524 10000 58 60 OK
0.11% 0.21% 237 <2400

[1-] ¢10/150 ¢10/100 --- 0.0 291 1102 511 1613 1310 10000 55 60 Not OK
0.65% 0.52% 237 <2400

[2-] ¢10/150 --- = 0.0 277 70 0 277 524 10000 58 60 OK
0.11% 0.21% 237 <2400

A;req - required reinforcement area as max(As yi Asmin) + Mg sern; Asprov - provided reinforcement area; As min/max - min/max
reinforcement area; smauimin) - Maximum spacing of bars (minimum clear distance between bars
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When looking at the output for AAs_serv,1- a value of 562 mm?2/m can be generated.

System:

erv,1-[Mm2/m]

@ 0

If this value of AAs_serv,1 will be added to the value of As_ult,1-, it will result in the value As_req,1-. In short
the following summary can be created:

e As_req,i,t+/-: Required reinforcement area for ULS and SLS including detailing provisions for the
particular direction (1,2) and surface (+,-).

e As_ult,i,+/-; Statically required reinforcement based on ULS for particular direction (1,2) and
surface (+,-).

e AAs_serv,i,*/-: Increment of statically required reinforcement based on SLS for particular direction
(1,2) and surface (+,-).

The same procedure can be applied for the limitation of tensile stress within the reinforcement. In this case
SCIA will determine the amount of reinforcement for the ULS and use this reinforcement to calculate the actual
stresses in the reinforcement. This value will then be compared to the defined allowable limit. The limit can be
defined in both the design defaults and CMD. You have three possibilities to define the limit of the stresses:

e Auto: based on definition in the national annexes 7.2(5).
e Yield Strength: the limit is determined based on fy (characteristic yield strength of reinforcement)
e User input: the limit must be decided by the user.

This can be checked within the output, in this case the user defined value of 150 MPa can be seen.

Principal stress g)[-1=-0.0672°

Meg crar = 63.2 KNM/M | Neg crar = 0 kKN/mM
MEdgp = 46.5 KNm/m | Ngggp = 0 kKN/m
Recalculation of required areas to direction of principal stress

Asuito= Asult1-- COS (AOH )Z + Aguit2- - COS (Aaz«)z
- 1024 cos(-0.07) + 277 - cos(-90) = 1024 mm?
Ascervo=Asuits + DAgseny 1.+ COS (Aou.)z + AAg e 2.+ COS (Ac(z.)z
= 1024 + 562 cos (-0.07) + 0- cos(-90) = 1586 mm?

Check of cracks occuring (87.1(2)

feterr = 2.6 MPa
o = 5.565 MPa > o, = 2.6 MPa => cracks appear

Check of reinforcement stress limitation (§7.2(5))

o:= 149.4 MPa = o;)im = 150 MPa

As previously mentioned when the SLS restrictions are not fulfilled an increment must be calculated
serv_coeff will be calculated depending on the following conditions:

146

¢ In case of crack width only: serveee=W coetr= (Wk / Wk,max)®>+0,01
e In case of reinforcement stress only: Servceefi=Ss,coeff= (Ss / Ss,im)+0,005
e In case of reinforcement stress only: Servceefi= Max(Ss,coeff; Wk,coeff)
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When the statically reinforcement is designed based on ULS +SLS, the verification of the detailing provisions
must be done. The same procedure and warnings as used for ULS design will be applied for ULS+SLS
design, only one step further. The final reinforcement area As_req for direction (1,2) and surface (+,-) will be

determined by the following formula, taking into account the minimal and maximal areas from detailing
provisions:

As,req,l,Z,t =min (maX(As,uIt,l,Z,t; As,serv,l,Z,i; As,min); As,max)
2.4.6 Crack control
+ INPUT DATA FOR CRACK CONTROL
= Maximum crack width

The values of the maximum crack width (wmax) are national determined parameters, dependent on the chosen
exposure class. Therefore, this value can be found in the setup for National Determined Parameters, via the
File menu = Project settings - National annex [...] > EN 1992-1-1[...].

B | Concrete setup

X
4 Type of values =-EC-EN Name ECEN
NA building - C_fm[me 4 Concrete
e m—— = General
4 Type of functionality Concrete P General
Hollow core beams B4 Non-prestressed reinforcement | P ULS
Prestressing [ Prestressed reinforcement 4 SLS
Durability and concrete cover
i 4 General
=-uLs
General 4 National annex
Punching 4 k3 crack - coefficient for calculation ma
=-sLs
Value [-] 3.40
General
=J-Detailing provisions 4 kg crack - coefficient for calculation ma
Common detailing provisions Value [-] 0.42
ED sthrudures ancishbs 4 Wnax - for non-prestressed structure |
unching
Values [mm] 0.4/0.3/0.3
P Detailing provisions
Select all Unselect all Refresh Load default NA parameters. Cancel

= Type of used reinforcement

You can perform the Crack width check for all three types of reinforcement (Required, provided and user
reinforcement). The crack width check is performed on a Quasi-permanent SLS combination.

If the type of reinforcement used for the crack width check is either the provided or required reinforcement an
ULS combination should be chosen as well. This is necessary because the required/provided reinforcement is
calculated based on an ULS combination. After this reinforcement is calculated it can be used to perform the
crack width check. All this is done automatically and can be set in the properties window of the crack width

check.
RGO v SELECTION
Type of selection  All v/
Filter No v
I I <> w RESULT CASE
7Combination used to perfrom the crack width check B coce o T
/ / / | / &’) Combination SLS v
\u Envelope (for 2D drawing) Absolute extreme v/
Type of reinforcement  Required v/
w RESULT CASE FOR REQUIRED REINFORCEMENT

™
Combination used to calculate the theoretical

reinforcement used in the crack width check
| I [ I I I

Required/provided reinforcement

Typeofload Combinations v/

Combination ULS
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| | | | | & v RESULT CASE

Combination used to perform the crack = e _
% ypeof load Combinations
width check <:
Combination SLS v

= <t ff f f i Envelope (for 2D drawing) Absolute extreme v~
Amount of reinforcement is already

known -> no ULS combination necessary
w EXTREME 2D

| <‘P || | | l Averaging of peak ( ) )

User reinforcement

Type of reinforcement  User v/

= Theoretical background

Crack appearance

If condition below is satisfied no cracks will appear in the concrete.
Oct,max+ < fct,eff

With:

_ Dix |, My

Octmaxt = 7 + oy Zemaxit = normal concrete stress on un-cracked section at the most tensioned

fiber of concrete cross-section
o f. e = Mean value of the tensile strength of the concrete effective at the time

Calculation of crack width

W = €m_cm - Srmax
With:
Gs,ii_kt'&%'(1+ae,ii'pp,eff,ii) Osit
® (&m — €cm)i+ = Max : Esi+ 0,605
min <k3ci+ + Siliskadsis, g g XH)) if g5 < 5(ciy + 0,5dg54)
®  Simaxit = - Pp.effi+ - - - -
1,3 (h—x4) fsgiz = S(Ciir + O'Sds,ii)
+ RESULTS FOR REQUIRED THEORITICAL REINFORCEMENT

Desing menu - Concrete 2D - SLS crack width
Crack width w+

Combination = SLS; Type of reinforcement = Required; Value = w+

w+ [mm]
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Crack width w-

Combination = SLS; Type of reinforcement = Required; Value = w-

Unity check

Combination = SLS; Type of reinforcement = Required; Value = UC

0.269
0.240
0.220
0.200
0.180
0.160
0.140
0.120
0.100
0.080
0.060
0.040
0.020
0.000

w- [mm]

v

1.00
0.25

w[-]

A green value stands for a unity check < 1 (Wcalc < Wmax), a grey value stands for unity check < 0,25 and a red

value means that wmax is exceeded.
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2.5 Punching

2.5.1 Theoretical background

% General

Punching shear can result from a concentrated load or reaction acting on a relatively small area, called the
loaded area Aioad Of a slab or a foundation.

The most common situations where punching shear has to be considered is the region immediately
surrounding a column in a flat ceiling plate or where column is supported on foundation plate.

The following problem types can be distinguished: interior, edge and corner columns.

Design of punching shear reinforcement is based on clause 6.4 of EN 1992-1-1: 2004 / A1:2014 + National
Annexes.

The verification reveals either that the load-bearing capacity of the reinforced concrete is sufficiently high, or
that punching shear reinforcement must be designed and installed. If the verification limits are exceeded, the
verification result is marked as not permissible. In this case, you must change the model parameters or select
a suitable design alternative.

The verification of punching failure at the ultimate limit state can be resumed as follows:
e Check of the shear resistance at the face of the column noted uo, and at the basic control perimeter
named ui.
e Ifshear reinforcementis required, a further perimeter uoutef Should be found where shear reinforcement
is no longer required.

Those control perimeters are shown in the following pictures:

o 41

‘2d

= arctan (1/2) -1 .......... n
= 26,6° - basic control
' c section

a) Section

- basic control area Acont

- basic control perimeter, w4
[D]- loaded area Aoad

reont further control perimeter
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https://help.scia.net/webhelplatest/en/krs/attachments/theory_na_en_1992_enu.pdf
https://help.scia.net/webhelplatest/en/krs/attachments/theory_na_en_1992_enu.pdf

oS

= Basic control perimeter ul

Load distribution and basic control perimeter

The basic control perimeter u: is taken at a distance 2d from the loaded area, where d is the effective depth.

2d

2

-
!

v | 2d

2d

“Lh

~

In case there is openings near the loaded area, they are dealt with according to clause 6.4.2(3).

If the shortest distance between the perimeter of the loaded area and the edge of the opening does not exceed
6d (see figure), part of the control perimeter contained between two tangents drawn to the outline of the
opening from the center of the loaded area is ineffective.

h>/

V(h.Le)

- opening

In SCIA Engineer, openings on 2D members are automatically considered according to the previous criteria.

= Effective depth des

The effective depth of the slab is assumed constant and is calculated acc. to formula 6.32 of EN1992-1-1:
(dy +d,)

eff — 2

where dy and d: are the effective depths of the reinforcement in two orthogonal directions.

+ Punching shear calculation

The punching shear calculation is done according to EN1992-1-1 art.6.4.3.

First the design shear resistances along the control sections are calculated:

° VRd,c

the control section considered

design value of the shear resistance of a slab without punching shear reinforcement along

* Vo, design value of the punching shear resistance of a slab with punching shear reinforcement
,CS

along the control section considered

® Vo max d€SigN value of the maximum punching shear resistance along the control section considered
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Then the following checks should be performed.
= Check at the column perimeter up

At the column perimeter uo, or at the perimeter of the loaded area, the maximum punching shear stress should
not be exceeded.
N

EdO S VRd,max
With :
Vedo design shear stress at the column perimeter uo
® VRdmax = 0.5*v *fq
e v =0.6%1 - f/250)

= Check at the basic perimeter u;

At the basic control perimeter uz:
e Ifvsv.,. Punching reinforcementis not needed

e Ifv_>v., . Punching reinforcementis needed

The punching shear resistance of a plate Vra,c is calculated according to formula 6.47, EN1992-1-1:
VRd,c = CRd,C- k. (100 P1- fck)l/3 + klccp 2 (Vmin + klccp)

With:
e P average reinforcement ratio in specific distance around column
o fex characteristic concrete compressive strength in MPa
® Vmin = 0,035 - k32 . fckl/2

_ 018

J CRd,c_T
o k=1+ /Zdﬂsz,o
e dinmm

The maximum shear stress v_, is calculated for considered control perimeter ui according to clause 6.4.3(1)

as follows:
VEq

Vgq = B-m
1

The B-factor is to consider the non-uniform load transfer (due to unbalanced bending moment). If the load
transfer is non-uniform, local peak loading should be compensated by help of this 3-factor.

In case that lateral stability of the structure does not depend on frame action between the slabs and the
columns, and where the adjacent spans do not differ in length by more than 25%, approximate values for 3
may be used according to clause 6.4.3(6).

In SCIA Engineer, you must decide whether these approximate values can be used, because the program
cannot check the preconditions described above.

By default, the recommended approximated values are:

- internal column
- edge column
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Those values might be different according to the National Annexes and can be viewed in the National Annexes

setup:
B Concrete setup x
4 Type of members Standard EN P General )
1D ﬂ - C;";:::m 4 Punching
20 @ i Concrete 4 MNational annex
4 Type of values Non-prestressed reinforcement 4 Cpd o
Prestressed reinforcement - ~
NA building | Durability and concrete cover Value[] 9-18
4 Type of functionality = 4 ky - factor considering effects of axial load
Hollow core beams 4 Pur:(-n;ngl Value[] ©.10
Prestressing a - SLS 4 Vi - min. value of shear resistance
- General Formula Formula
& A“ﬂ:::::::i 4 VR4 may - design value of max. shear resista
Stress limitation during tensioning Formula Formula
~ 515 stress limitation 4 By - coeff. to increase shear stress around
= Detailing provisions N
Common detailing provisions Value[] 1.15
Columns 4 Bedge - coefl. to increase shear stress arour
":Sle)a:?:ucturesand slabs L] -
Punching 4 B - coefl. to increase shear stress around
Value [-] 1.50
“ Kmay - factor limiting shear capacity of app
Value[-] 1.50
4 Koy - factor defining placement of last peri
Value [[] 1.50
F SLS
Allowable stress
P Detailing provisions
L < b4 W
Select all Unselect all Refresh Load default NA parameters Cancel
Otherwise, as described in art 6.4.3, the B-factor can be calculated by the following general formula:
2
B=1+ Kk MEd,y uy n (k MEd,z Uy )2
= . . Zr .
y VEd le VEd le
Calculation of B-factor with general formula can be set in Concrete setup > Punching:
Concrete settings [m] *
Views: Complete setup ¥ |View settings « Load default Find National annex: _
Description Symbol Value Default Unit  Chapter Code Structu... CheckT...
=all> Pl<al- L2 <all= Pl 2<.0|<al  LOf=<al> Pzl O<alr O
P oesiges
> Conversion to rebars
I Interaction diagram
I Shear
F Torsion
4 Punching
4 Shear stress calculation
b Typeof Beta factor Typep Ap 643036 EM1962-1-1  Plate Solver se.
Reduction of shear stress by soil pressure 6.4.4(2) EM 1962-1-1 | Flate =
4 Control perimeter
Distance of control perimeter for ceiling plate coeff kyq cap |2 6.4.2(1) EM1952-1-1 | Plate
Distance of control perimeter for foundation plate coeffkys joun 2.00 1 6.4.2(1) EM1562-1-1 | Flate
Distance from column face to consider apenings coeff kgpan 6.4.2(3) EM1962-1-1 | Plate
Distance from column face to collect input data abo... | coeffk g | 300 64.4(1) EM 1962-1-1 | Flate
I Stress limitations
I Cracking forces
 Crack width
I Deflections
> Detailing provisions -
OK Cancel
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= Design of punching reinforcement if required

In case that v_ > v, , punching reinforcement should be designed.

If punching reinforcement is required, the outer control perimeter uout beyond which the reinforcement is no
longer needed is calculated acc. to clause 6.4.5(4):
B. Vkq

VRd,C' d

Uout,ef =

Calculation of the required punching reinforcement

In SCIA Engineer, the shear reinforcement is designed using the following assumptions:
¢ the distribution of the shear links is considered as radial only
e only vertical shear links are supported

¢ the shape of reinforcement perimeters around the column is the same as for the shape of the basic
control perimeter

The required area Aswreq Of One perimeter of shear reinforcement around the column assumed as radially
distributed vertical shear links is calculated as:
_ (VEdur — 0.75 " VRqe) " Uy " S;

sw,re
A ,req ] 5 . f
. ywd,ef

fywa.ef IS the effective design strength of the punching reinforcement according to formula:
fywd,et = 200 + 0.25 - deft < fywd
Detailing provisions for the punching reinforcement

The required area might be adjusted to fulfil detailing provision rules acc. to clause 9.4.3(1), so that number
of shear links ns per each reinforcement perimeter is:

4 - Asw,req U1 Jast U Jast
n, = max { B ;
T - dg Stmaxul  Stmax,out
o ds diameter of shear link
o M condition of maximum allowed tangential spacing of links of reinforcement perimeters placed

St maxul

within the basic control perimeter (u1,ast is length of last perimeter of shear reinforcement there)

Us last

e ——— condition of maximum allowed tangential spacing of links of reinforcement perimeters placed

St max,out

outside the basic control perimeter (us,ast is length of last perimeter of shear reinforcement there)

)
o o °
o Uy o
° o ° S Uy
o ° o ° o
o o o ©° o
o © ©° o ! o )
o o° <x.d 0o, © %29 <x.d
° . S <X
oo o0 o0 - )
00 90 o000 - oo &b
o (]
o o o o o &
o ©o o © o
° ° o o o o © o
=] o o o
o o © o ©
° o ° eg._o %
° o )
°
St,max,ut St,max,out
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In SCIA Engineer, limitation of spacing Stmaxu1 and Stmaxcut are set in Concrete setup > Detailing provisions >
Punching:

Concrete settings O X

Views: Complete setup ¥ |View settings « Load default Find National annex -
Description Symbol Value Default Unit  Chapter Code Structu... | CheckT...

=all= Pl <al O <al> Pl<ale P|<.Pl<al Of<al> Pl <ale PO|<alz O

- Lrack width
= Deflections

4 Detailing provisions

> Beam /Rib
- Beamslab
r Column
I Plate, Shell{Plate)
. Wall, Shell{Wall)
 Deep beam
4 Punching ==
Check min. shear reinforcement 9.4.3(2) EM1562-1-1 | Plat:
Check distance of the first perimeter of shear links 94.301.4) EM 1962-1-1 | Plate
Min. distance from column face coeff sg min | 030 0.30 94.3(1) EM162-1-1 | Plat
Mazx. distance from column face coeff sg may | 0.50 0.50 9.4.3(4) EM 1962-1-1 | Plate
Check max. radial spacing of shear links 94.3(1) ER1962-1-1  Plate
Mazx. spacing of shear links coeff s, may | 075 075 94.3(1) EM 1962-1-1 | Plat
Check max. tangential spacing of shear links o 94.3(1) EM 1962-1-1  Plate
Max. tangential spacing within the first cantrol peri... | coeff s, gz o 150 L0 94.3(1) EM 1962-1-1 | Plat
Mazx. tangential spacing outside the first contral per...| coeffs, oo, 2.00 2.00 9.4.3(1) EM 1962-1-1  Plate
Check minimum number of perimeters of shear links 94.3(1) EM 1962-1-1 | Plate

Min. number of perimeters of shear links Nper.min 2 2 9.4.3(1) EM 1982-1-1  Plate

OK Cancel

The last condition, which must be fulfilled acc. to clause 9.4.3(2) is minimum reinforcement area of single shear
link Asw1,min according to formula (9.11):

0,08 . ka/nyk Syt St
Aswl,min = 15

With:
e St spacing of shear links in the radial direction
o S spacing of shear links in the tangential direction

The final designed area of each perimeter of shear reinforcement around the column is:

ng * T * d2
Agw = 4 2 Dg * Aswl,min

The required number of shear reinforcement perimeters around columns, nper, is determined based on clause
6.4.5(4), which specifies that the outermost perimeter of shear reinforcement, as, last = So + Sr * Nper, Should be
placed at a distance not greater than kout * dett within uout. The following formula for nperis derived:

+1| = rlper,min

_ [3out = S0 — kout * deff
Nper

= .
With:
o Kout Coefficient to determine the maximum distance of last perimeter from uout. Default value is 1,5.
This is a National Annexes parameter.

®  Npermin Minimum number of reinforcement perimeters around column required acc. to clause
9.4.3(1). Default value is 2 in Concrete settings > Complete setup view > Detailing provisions >
Punching.

e Aot Distance of the outer perimeter Uout.

The total amount of shear reinforcement Asw,tot around the column is then calculated as :
Asw,tot = Nper * Asw
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2.5.2 Punching design

+ Configuration

The punching check in SCIA Engineer is only available when a real column or a nodal support have been
connected to a plate. No punching check can be performed for a point load or a little surface load applied to
the plate.

SCIA Engineer supports circular and rectangular cross sections only for the punching check.

The column position with regard to the edges of the plate and the openings is recognize. Also, for the punching
check, all edges and angles of the plate are taken as straight... so if they are not in your model, the program
makes an approximation.

SCIA Engineer doesn’t support all punching cases of column-plate connection. The list of all current limitations
can be found in our webhelp. Each unsupported configuration is mentioned in the list of Errors/warning/notes
of the report in the punching check report.

Summary

Name Case Punching Punching UCwdmax UGRdc Shear UGwRd,cs  UCasw,det uc Errors,

case shape [-1 [-1 reinforcement [-1 [-1 [-1 warnings,
perimeters Check notes

N6l  |ULS/1 |N/A N/A N/A ) Wo/131
NOT OK

N63  |ULS/1 |N/A N/A 3.00] 3.00 [N/A - - 3.00 We/124
NOT OK

Concrete

Punching Punching Ve Medy Plate Material  des Uo  Vedwo  VRdmax
case shape [kN] [kNm] h fca [mm] [m] [MPa]l [MPa]
Medz [mm] [MPa] m U1 Vedul VRd,c

[-] [kNm] [%] [m] [MPa] [MPa]
N61  |ULS/1 |N/A N/A - - N/A  |N/A - - - - .
- - - - - - - - 3.00
N63  |ULS/1 |N/A N/A - - N/A  [N/A - - - - 3.00
- - - - - - - - 3.00

E/W/N Presenton members
W6/131 | N6l
We/124 | N63

Description Solution
Node cannot be calculated for punching. The connected

column has not supported type of cross-section.
Node cannot be calculated for punching. The connected |Split the columnin the node to get a separate column
column goes through the plate. above and below the plate.

* Choice of reinforcement

The punching design will check if the longitudinal reinforcement As in the plate is sufficient to resist to the
shear force around a column-plate or nodal support-plate connection.

In SCIA Engineer you can choose between 3 types of reinforcement for the punching check/design:
e As, required — calculated by the software for a specific load combination
e As,provided — user set in Reinforcement design > Design defaults
e As,user - practical reinforcement inputted by user manually in 2D Reinforcement

The choice between As,required, As,provided or As,user is done in the Properties panel for Punching design:

D @ ¥ w89 © 1 ‘a

Concrete settings 3
Concrete 1D »
Concrete 2D »

% ULS punching

ﬁ Bill of reinforcement (1D)
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n @
c

RESULTS (1) [~
MName Pons ontwerp
w SELECTION
Type of selection  Current
Filter No v~

w* RESULT CASE

Typeofload Combinations

Combination ULS
v REINFORCEMENT

Type of reinforcement ]
LIMIT STATE CONDITION Required

Design ULS Provided
User

Averaging of peak

| i = mmddne mam o

+ Punching check
Studied example: punching.esa
Geometry

Concrete class C30/37

Reinforcement class B500B

Plate thickness 200 mm

Column cross-section 10 x R 300x300 mm?2 and 6 x circular C400 mmg2

Plate and columns are connected to each other by means of the action Connect members/nodes.

Loads

*Load cases
e SW: Self weight
e DL: Dead Load = Surface load -1 kN/m? + Line force on edges -1 kN/m
e LL:Live Load = Surface load -1 kN/m2
e LL1: Additional case for further study= -25 kN/mz, to be explained later

*Combinations
e ULS (Type EN — ULS (STR/GEO Set B)) = SW, DL, LL
e SLS (Type EN — SLS Quasi Permanent) = SW, DL, LL
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Work method

The Punching Design command can be selected in the main menu “Design”:

D @ ¥ @ ¥ © 1 fa

Concrete settings 3
Concrete 1D »
Concrete 2D »

# ULS punching
ﬁ Bill of reinforcement (1D)

The command is available, when EC — EN national code is selected in Project data and the linear or non-linear
static analysis is done for the model containing 2D members from concrete material. Once the command is

selected, appropriate parameters are listed and can be adjusted in property window with following options.

(5
RESULTS (1) A
Name Pons ontwerp
* SELECTION
Type of selection  All ~~
Filter No v~
w RESULT CASE
Typeof load Combinations
Combination ULS
» REINFORCEMENT
Type of reinforcement  Required *~
LIMIT STATE CONDITION
Design ULS
Averaging of peak  @[¥)
Location Innodes avg.
System W
v EXTREME
Extreme Node v~
Values UC
¥ OUTPUT SETTINGS
Output  Brief ~
Print explanation of symbols () )
Print combination key  (@l[¥)

¥ ERRORS, WARNINGS AND NOTES SETTINGS
Show Information about warning... () )
Show errors  None v
Show warnings None
Show notes  None v~
ACTIONS 25

(® Refresh

@ Mew combination from Combination key

() Preview

Set the type of Selection to ALL, the Type of load to Combination ULS and the type
Required then click “Refresh”

of Reinforcement to

158 MJ — 08/08/2024



You will notice that the UC for every node will be displayed along with the control parameter in colour. In total
there are 3 colours (Green, blue and red).

e Green: Shear capacity without reinforcement is sufficient (UCvrd,c < 1.0 and UCyvrd,max < 1.0)

e Blue: Shear capacity with shear reinforcement is sufficient (UCvrd,c > 1.0 but UCvRrd,cs < 1.0)

e Red: Plate is not designable by application of reinforcement or maximum shear capacity of concrete
adjacent to the column is not sufficient (UCvrd,cs > 1.0 or UCvrd,max > 1.0)

Punching design
Values: UC

Linear calculation

Combination: ULS

Extreme: Node
Selection: All

2000

5000

“

o

P
I

5000

12000

@
-®

>< L[}

Presentation of results as a numerical output is possible via Preview and / or Table results. For the Punching
Design, there is available two types of output:
e Brief - contains just a summary table with basic results

Punching design

Linear calculation

Combination: ULS
Extreme: MNode
Selection: Al
Summary
Punching UCurdmax UCwrdc Shear UCurdes UCasw,det uc
shape [ [1 reinforcement [1 [1 (=l
perimeters Check
N15 ULS/1 | Corner Rectangle 0.82 0.96 |not required - 0.96
column (300;300) oK
N20 ULS/1 | Corner Rectangle 0.86 1.01 | 3x 998(radial) 0.68 1.00|1.00
column (300;300) 80+2x80=240 OK, BUT
N53 ULS/1 | Internal Circle (400) 0.37 1.07 | 3x 126@8(radial) 0.72 1.00 (1.00
column 80+2x80=240 OK, BUT
N55 ULS/1 | Internal Circle (400) 0.12 0.37 |not required - 0.37
column oK
N57 ULS/1 |Internal Circle (400) 0.37 1.07 |3x 12@8(radial) 0.72 1.00|1.00
column 80+2x80=240 OK, BUT
N59 ULS/1 |Internal Circle (400) 0.36 1.06 | 3x 1208(radial) 0.71 1.00 (1.00
column 80+2x80=240 OK, BUT
N61 ULS/1 |Internal Circle (400) 0.17 0.52 |not required - 0.52
column OK
N63 ULS/1 | Internal Cirdle (400) 0.37 1.08 |3x 12@8(radial) 0.72 1.00|1.00
column 80+2x80=240 OK, BUT
N88 ULS/1 |Edge column |Rectangle 0.43 0.98 |not required - 0.98
(300;300) oK
N90 ULS/1 |Edge column |Rectangle 0.43 0.98 |not required - 0.98
(300;300) OK
N95 ULS/1 | Corner Rectangle 0.21 0.44 |not required - 0.44
column (300,300) OK, BUT

e Standard - contains the same summary table as in Brief output supplemented by additional tables
providing further semi-results
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= Shear capacity without reinforcement is sufficient

Select Node N61 and change the type of selection to current.

A brief output will show:

Punching design

Linear calculation
Combination: ULS
Extreme: Node
Selection: N61
Summary

Name Case Punching Punching UCurdmax UCurdc Shear UCwrd,es  UC asw,det uc

case shape [-1 [-1 reinforcement [-1 [-1 [-1

perimeters

N61 ULS/1 |Internal Circle (400) 0.52 |not required
column oK

Name Combination key
ULS/1 1.35%SW + 1.35*%DL + 1.50*LL

We can see that the UC < 1, let’s look at the standard output for this node:

We can see that Ved.u1 = 0,28MPa < Vrd,c = 0,55MPa so the shear capacity without reinforcement is sufficient.

Punching design
Linear calculation
Combination: ULS
Extreme: Node

Selection: N61

Summary

Name Case Punching Punching UC.rdmsx UCurdc Shear UCyvrdes UCasw,det uc

shape [1 1 reinforcement [1 [1 [-1
perimeters
0.52 |not required

Circle (400)

Concrete

Name Case Punching Punching Ved Medy Plate Material de uo Vedwo Vedmax UCvRdmax
[kN] [kNm] h fed [mm] [m] [MPa] [MPa] [-]
AVed Medz [mm] [MPa] P uz VEdul VRde UCrd,c
[kN] [kNm] [ %] [m] [MPa] [MPa] [-]

Circle (400) 0.09 | Ceiing 160.00 | 1.257

column 0.00 13.98 | 200.00 |20.00 0.17| 3.267 0.28 0.55 0.52

The control parameter is displayed in Green colour.

= Shear capacity with reinforcement is sufficient

Let us look now at the standard output for node N59:

Punching design
Linear calculation
Combination: ULS
Extreme: Node

Selection: N59

Summary

Case Punching Punching UC.rdmax UCurdc Shear UCwRdcs  UCasw,det uc

case shape [-1 [-1 reinforcement [-1 [1 [-1

perimeters Check
Internal Circle (400) 1.06 |3x 12@8(radial)
column 80+2x80=240 OK, BUT

Concrete

Name Case Punching Punching Ved Medy Plate Material desf uo VEduo  VRdmex  UC vRdmax
case [kN] [kNm] h fed [mm] [m] [MPa] [MPa] (=]
B AVeq Medz: [mm] [MPa] M ui VEdui VRd,c UCyrd,c

[-1 [kN] [kNm] [%] [m] [MPa] [MPa]
Internal Circle (400) 26.85 | Ceiing 160.00 | 1.257
column 6.10 | 200.00

1.15

Reinforcement

Name Case Shear Uout Stu1l Control perimeters  Material = Aswreq Asw VRdcs UCrd,cs
reinforcement [m] [mm] (distance/capacity) fywd,ef [mm2] [mm?2] [MPa] [-1

perimeters Aout [MPa] Aswimin  Aswiot  KmaxVRde UCAsw,det
[mm] [mm?2] [mm?2] [MPa] [-1

3x 12@8(radial)
80+2x80=240 354 230 290.0 11 1810 0.82 1.00

We can see here that Vedu1 = 0,58MPa < VRrd,c= 0,55MPa and the UCyrd,c= 1,06 > 1.

160
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So shear reinforcement needs to be designed. The final value is Aswtt = 1810mm? which take into account

detailing provisions.

The control parameter is displayed in blue colour.

You can also show the Asw.ot graphically:

Velues: h-? ﬁ"- %
Lnear calostation RESULTS (1) [~}
m“’ Nome  Poms ontwerp
Selecton: 5% v SELECTION
Type of sebection  Curvem
Faw  No
v RESULT CASE
Tyoeollond  Combiration
Combleution  ULS
v RUNORCOMENT _—
Type of renlomement  Bagered
UM STATE CONDITION
Desgruts
Mveragieg of pesk -
Location i modes g,
Syaterm
v DT
Urtreme  Node
Vakas  Apwciot
v OUTRUT SETTINGS
Owmne  sandard
Priet explanation of symdon ()
w ERRORS, WARMINGS AMD NOTES SETTINGS
Show Information stoutmaming.. (0 )
v Mo
= Use of provided reinforcement
Let's add some provided reinforcement to the plate.
In the Concrete settings, go to the Design Defaults view:
Concrete settings O X
| views: Design defauts v [Viewsettings v | | Loaddefault ||  Find | nationst nnex: [
Description Symbol  Value Default  Unit  Chapter  Code Structure  CheckTy...
<all- Fl<al- P <al Flealk PO <Ol <ale O <alr O <alls O Designe X
4 Design defaults
4 Reinforcement
- Beam [Rib
- Beamslab
r Column
- Plate
- Wall/ Deep beam
[ Minimum cover ﬂ
E=S
Activate the provided template for the plates:
Concrete settings [m] X
Views: Design defaults v Viewsettings v | | Loaddefault |  Find | - —
B Provided reinforcement (design) X
Description Symbol Value Default  Uni "
<all> Pl<ale O] <al> Dl<al O HABENRE o« AwD
4 Design defaults Plate_Basic_Lower
4 Reinforcement Plate_Basic_Both
> Beam |/ Rib Plate_Basic_Add_L...
> Beamslab Plate_Basic_Add_...
Plate_Basic_AddLi..
i Column et m maas
4 Plate Mame Plate_Ba:
4 Longitudinal Description Only basi
Design of provided reinforcement Member typ: Plate, She
» Design template of provided reinfercement Plate_Basic_B«v .. JPlate_Ea..
Cross-sectiol Rectangle
4 Upperiz+)
Type of cover Typece Auto Auto Mode Standard
Diameter of first layer dogy 10 10 mm
Angle of first layer direction oy 0.00 0.00 deg
Diameter of second layer dapy 10 10 mm
Angle of second layer direction ooy 90,00 90.00 deg
4 Lower (z-)
Type of cover Types. Auto Auto
Diameter of first layer dey 10 10 mm
Anmla af Fect | i onn 00 A
[ New | mmsert | Eait | oK
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Here you can choose between the different templates.

You can give a basic provided reinforcement without any additional reinforcement or allow SCIA Engineer to
calculate additional reinforcement when needed.

For this example, we will define the basic reinforcement without additional reinforcement and we will use
diameter 16 mm with a spacing of 150 mm.

Provided reinforcement (design) edit - Plate_Basic_AddList_All a X
Member type Plate, Shell(Plate) Longitudinal reinforcement
| Cross-section + Definition of Basic By Diameter v
Mode Standard Basic (As,bas) Additional (As,add)
Layer Diameter Spacing As Diameter Spacing Sort by As
[mm] [mm] [mm#2/m] [mm] [mm] [mm~2/m]
» [14] 16 150 1340

[2+] 16 150 1340

111 16 150 1340

[2-] 16 150 1340

H,

OK Cancel

Now look at the standard output for node N59. With the required reinforced we needed additional shear
reinforcement but with the provided reinforcement set above no need for shear reinforcement:

Punching design

Linear calculation
Combination: ULS
Extreme: Node
Selection: N59
Summary

Case Punching Punching UC.rdmax UCwrdc Shear UCurdes UC Asw,det uc

case shape [1 [1 reinforcement [1 [1 [1
perimeters

Circle (400) 0.82 | not required
column OK

Concrete

Name Case Punching Punching Ved Med,y Plate Material VEdwo  VRdmax
case shape [kN] [kNm] h fed [m] [MPa] [MPa] [-1
AVed Med: [mm] [MPa] ui VEd,u1 VRd,c UCvrd,c

[kN] [ kNm] [m] [MPa] [MPal

We can see that Vedu1 = 0,58 MPa < Vrac= 0,71 MPa so the shear capacity without reinforcement is sufficient.
The control parameter is now displayed in Green colour instead of blue.
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= Unity check is not ok: control perimeter is red

Change the “Type of Result” to Load Case LL1 and display the result for node N59:
Punching design (I

v SLECTON

v BESILT CASE

RESATS (1)

Name  Pom ortwerp

Tyoe of secton  Cevest

Trpeof bl Land cases

Loadcase ALY

v FENFORCEMENT

LT STATY CONDITION

v DR

) Pt erasnaten of amon
)

Control perimeter is now displayed in red and the UC = 1,44 > 1.

Take a look at the Standard Output:

Punching design
Linear calculation

Load case: LL1

Extreme: Node

Selection: N59

Summary

Name Case Punching Punching UCrdc Shear UCurdes  UCasw,det uc
[-1 reinforcement [1 [-1 [-1
perimeters Check
Circle (400) 2.17 | 7x 1998(radial)
80+6x110=740

Concrete

Name Case Punching Punching \ Medy Plate Material dert Uo VEduo  VRdmax UC uRdmax
case shape [kN] [kNm] h fod [mm] [m] [MPa] [MPa] [1
B AVeq Med:  [mm] [MPa] p ui VEdul VRde UCvrd,c
[-1 [kN]  [kNm] [%] [m] [MPa] [MPa] [-1
Circle (400) 71.59 | Ceiing . X .
11.71 (200.00

Reinforcement

Name Case Shear Uout Stu1 Control perimeters  Material = Acw,req VRdes
reinforcement [m] [mm] (distance/capacity) fywd,ef [mm?] [mm?] [MPa]
perimeters Aout Stout [MPa] Aswimin  Aswtot KmaxVrde UCasw,det
[mm] [mm] [mm?2] [MPa] [-1
7x 1908(radil) 165 | 320/144%, 640/89%,
80+6x110=740 311 |1 960/66%

We can also show the errors and warning in the output by checking this option in the properties panel:

oA
RESULTS (1)
Name  Pons ontwerp
'w SELECTION S
Typeof selection  Current »/
Filter  No
v RESULT CASE
Typeolioad Load cases
Loadcase LLL v
w REINFORCEMENT )
Typeof reinforcement  Provided
Consider user reinforcement ()
UMIT STATE CONDITION
DesignULs
DesignStSCrackwidth (0 )
DesignstSReinfstress (3 )
Averaging of peak ([
Location In nodes avg.

¥ Report preview | W.
& & & [ Defautt HEINT & ® v EXTREME
g 1 D . o Extreme  Node
NS9 UL [7x 1908(radil) 7.074| 165 |320/144%, 640/89%, |B 5008 84 Nakiaa: UG
X G " 4 - L —
80+6x110=740 926| 311 [960/66% 290.0 20| 6685 1.08 L7 OUTEUT SEYTRNGS

Output  Standard
Print explanation of symbots (3 )

We/ii7 [Nso | " ERRORS, WARNINGS AND NOTES SETTINGS
Description Solution fshow Information about warning...
Punching shear resstance at the basc control permeter | To avorl design of shear renforcement try to arease Showerrors All v
(VRd,c) 5 not sufficent acc. to §6.4.3(2). Punchng shear |the amount of ongtudinal renforcement. s i T
leinforceme required.

Tyoe of rordoemest  Provded
Comuitier wax mickorcamwe ()

TTawA

Pmd\g resistance f plate weh desgned shear Use higher grade of material or increase the thickness Show notes  In extremes only

reinforcement (vRd,cs) 5 not sufficent acc. to §6.4.5(1). |of the @e, Show table with explanation of W... (@l[Y
orTal CONGTete Stesses (50, cp) are a3 fe 3

cakulation of punching shear resistance (vRd,c) acc. to ‘i:o’:: &

§6.4.4(1). ®

Capacty of designed shear reinforcement (vRd,cs) is Preview

Imite

d_by value of kmax*vRd,c acc. to §6.4.5(1).
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2.6 Code dependent deflection (CDD)

2.6.1

Intro

The CDD calculation is a more rigorous calculation of the deflection. The calculation procedure is the same as
for the simplified method, but with following differences:
3 types of combinations are used to calculate the deflections
Calculation of stiffness is more precise

To be able to use this method in SCIA Engineer, the following settings should be set beforehand:
1. Use the post processing environment ‘default’ in the Project settings:

164

2.

Project data

Basicdata Functionality Actions

UnitSet Protection

DATA
Name: -
Part: -
Description: -
Author: User
Date: 30.08.2021
Structure: f’ Frame XZ
Post pr.ocessing & default
environment
Model: E One

MATERIAL

Concrete
Material €30/37

Reinforcement mate B 500A

Steel

Masonry
Aluminium

Timber

Steel fibre concrete
Other

CODE
National Code:

Bl =

National annex:

- Standard EN

'Thick-walled' Concrete cross-sections: the advanced 2D FEM method is off!

OK

X

v e

Cancel

In the Concrete menu, you will then see a new check named Code dependent deflection:

el

v

ICODE DEPENDENT DEFLECTION §

adl %

>

&
& Es

7/

N kK APA
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2.6.2 Types of combination for CDD

The combinations used for the CDD calculation can either be automatically generated or inserted by the user.
Automatic Creation of combinations for CDD

Three different combinations are automatically created by the software in the background to calculate the
deflection:
1. Combination for calculation of total deflection
Generated directly from the user choice of combination in the CDD check, properties panel:
RESULTS (1)
Name Code dependent deflectior
ECTION

Type of selection  All
Filter No v
Automatic combination ([

ULT CASE,EQR DEELECTION

Typeof load Combinations

Combination  SLS-Char (auto) v/

nvelope (for 2D drawing) Absolute extreme v/

Type of reinforcement  User v/

2. Combination for calculation of immediate deflection
Uses the generated combination for total deflection and removes variable load cases with duration
type Medium, Short or Instantaneous.
Duration type is defined in the Load cases properties:

B | Load cases X
- IRFEE a2 O =B v Y
LC1-SW Name LC3
LC2-per Description var
LC3-var Action type Variable v
Load group LG2 Vi
Load type Static v
Specification Standard v
Duration|Short N
Master load casejLong
3D Wind Medium

Instantaneous I

|
3. Combination for calculation of deflection due to creep

Uses the generated combination for total deflection and multiplies variable load cases by a
coefficient defined in Concrete settings > Deflections:

Concrete settings [m] X

Views: Complete setup v |View sett... v | Load default Find Nalionalam\ex:-
Description Symbol  Value Default Unit Chapter Code Struct... Check...

<all> DOl <al> O <all> O <all> O <all O <al> O <all> O <all> O

4 Designdefaults
b Reinforcement
b Minimum cover

4 Solver setting

-

General

b Internal forces
b DesignAs
b Conversion to rebars
b Interaction diagram .
b Shear
I Torsion
I Stress limitations
I Cracking forces
b Crack width
4 Deflections
Coefficient for increasing the amountofreinforc... Coeffgie 1.0 1.0 Independ... |All [Be... | Sclvers,
Maximal total deflection Lfx; x= Xiot 250.0 250.0 7.4.1(4) |EN1992-1-1/1D (Be lver s
Maximal additional deflection L/x;x= Xadd 00.0 200.0 7.4.1(5) |EN1992-1-1/1D (Ex slver s,
» BType of variable load coefficient far the automatl..l UsePsi2f & L= Psi2 Independ... | All (Be Solver s
p_Detailing ici, Use Psi2 factor
User input 0K Tyl

Additional characteristic combinations are generated for each previously mentioned combination to determine
if the section is cracked or uncracked.
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Manual input of combinations for CDD

It is possible for you to introduce your own combinations for calculation of immediate deflection and
deflection due to creep.

In order to introduce these manual combinations, the option “Automatic combination” must be unchecked in
the CDD check, properties panel.

Two new sections (“Result case: Creep deflection” and “Result case: Immediate deflection”) appear in the
properties window where you can choose the combinations for creep and immediate deflections.

These combinations have to be linear combinations, it means that creep and immediate deflection will be the

same for all sub-combinations generated from combination for total deflection.
= RESULTS (1) [\

Name Code dependent deflection

4

SELECTION
Type of selection  All ~

Filter No v~

Automatic combination ()

* RESU
Typeofload Combinations
Combination SLS-Char (auto) ~~
Envelope (for 2D drawing)  Absolute extreme s

4

RESULT CASE: CREEP DEFLECTION
Typeofload Combinations

Combination  SLS - creep deflection

w RESULT CASE: IMMEDIATE DEFLECTION
Typeofload Combinations “~

Combination  SLS - immediate deflection .~

Type of reinforcement  User

- CVTBEME 1R

The combination for the calculation of the total deflection remains generated directly from your choice of
combination in the CDD check in the properties panel.

2.6.3 Type of reinforcement

For the CDD method, it is possible to calculate the deflection with required, provided or user inputted
reinforcement. This choice is done in the Properties window of the CDD check:

= RESULTS (1) /)
Name Code dependent deflection
w SELECTION
Type of selection  All

Filter No

Automatic combination @[%)

¥ RESULT CASE FOR DEFLECTION
Typeof load Combinations

Combination  SLS-Char (auto) v/

Envelope (for 2D drawing)  Absolute extreme

Type of reinforcement I User]

w EXTREME 1D Required
Provided

User

Extreme 1D

Results in sections
Direction (local) z (1D/2D) v
Values UC v
Output  Brief
Print combination key (%)
Print explanation of symbols (D
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2.6.4 Calculation of stiffness for 1D elements

Members which are not expected to be loaded above the level which would cause the tensile strength of the
concrete to be exceeded anywhere within the member should be considered to be uncracked. Members which
are expected to crack, but may not be fully cracked, will behave in a manner intermediate between the
uncracked and fully cracked conditions. New stiffness (stiffness with taking into account cracking) is calculated
in center of each 1D element.

Two types of stiffness are calculated:

Short-term stiffness - is calculated using 28 days modulus of elasticity Ec = Ecm, it follows that value
of stiffness is loaded directly from properties of the concrete material

Long-term stiffness - is calculated using effective E modulus based on creep coefficient for acting
load, it follows Ec = Eceff = Ecm/(l"‘(p).

Calculation effective modulus of elasticity is based on equation 5.27 in EN 1992-1-1, but instead of effective
creep coefficient e, only creep coefficient ¢ is used

The following procedure is used for the calculation of stiffnesses:

1)
2)

3)

4)

5)

6)

The transformed cross-section characteristics of uncracked section (Ai, li, ti...) are calculated

The stiffnesses of the uncracked cross-section ((Eiy),,( Eiz), (EA)) to the center of the uncracked
transformed cross-section are calculated.

The maximum value of tensile stress of the uncracked cross-section (value octres) for respective
characteristic combination (Nchar,res,Mchar,res,y, Mchar,res,z) is calculated

The maximum value of tensile stress of uncracked cross-section (value octimm) for immediate
characteristic combination (Nchar,im,Mchar,im,y, Mchar,im,z) is calculated

Compare ot With oetimm
. If oc=octimm, the respective characteristic combination will be used for calculation,
Nchar:Nchar,res,Mchar,y :Mchar,res,y, Mchar,z:Mchar,res,z,Gct:Gct,res

. If oct=octimm, the immediate characteristic combination will be used
Nchar=Nchar,im,Mchary =Mchar,im,y, Mchar,z=Mcharim, z,Gct=0ct,im

Compare oct With oer
e If oc<oer, the cross-section is uncracked:
o bending stiffness around y-axis Ely = (Eiy)
o bending stiffness around z axis El; = (Eiy)
o axial stiffness EA = EA,,
e If o200, the cross-section is cracked and average stiffness will be calculated.
1. The transformed Css characteristics of the cracked section (Air, lir, tir...) is calculated.
2. The stiffnesses of the fully cracked cross-section ((Eiy)u,( Eiz)u, (EA)n) to center of cracked
transformed cross-section is calculated
3. The stress in the tensile reinforcement of the fully cracked cross-section (value osr) for
characteristic combination (Nchar,Mchar, Mchar z) is calculated.
4. The stress in the tensile reinforcement of the fully cracked cross-section (value os)for
respective combination (N,My,M:) is calculated.
5. The distribution coefficient { according equation 7.19 in EN 1992-1-1 is calculated
GSI' 2
<= 1-5(3)
where B is a coefficient taking account the influence of the duration of the loading or of
repeated loading on the average strain (=1 for calculation of short-term stiffness, p=0,5
for calculation of long-term stiffness)
6. The average value of the stiffnesses based on equation 7.18 in EN 1992-1-1 is calculated
o bending stiffness around y-axis (Eiy) = 1/[C/(Eiy)n + (1-C)/ (Eiy)i]
o bending stiffness around z-axis (Eiz) = 1/[C/(Eiz)n + (1-C)/ (Eiz)i]
o axial stiffness (EA) = 1/[(C/(EA + (1-C)/( EA)],

Stiffness is recalculated to principal axis for unsymmetrical cross-section
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7) The five types of stiffnesses are calculated for each 1D element and each dangerous combination:

Type of stiffness Respective combination

Short-term stiffness for immediate deflection Immediate
Short-term stiffness for short-term deflection Total
Short-term stiffness for creep deflection Creep
Long-term stiffness for creep deflection Creep
Long-term stiffness for shrinkage deflection Total

8) The following stiffnesses are changes in stiffness matrix for 1D elements:

e EA«=EA
e GA=GA; = G-EAJ(1,2-E0)
e Ely=Eiy

e El, =Eiz

o GI=0,5-(1-w)-(El,)El,)05

Where:

e G is shear modulus of the concrete calculated according to formula G = 0.5%Ec/(1+m)
e m is Poisson coefficient of the concrete loaded from material properties of the concrete

Eccentricity of stiffnesses (distance between center of gravity of concrete cross-section and center of gravity
of cracked transformed cross-section) is not taken into account in current version

Calculation of curvature, strain and stiffness caused by shrinkage of a 1D element

Calculation of shrinkage forces

The forces caused by shrinkage are calculated according to formulas below. The forces are calculated for both
states: uncracked and cracked cross-section.

Where :

168

Nshr = -ges(t,ts)- Coefreini2(Esi-Asi)
Mshry = Nshr-€shr,z
Mshr,z = Nshr-€shry

Eshry = Z(Esi'Asi)/ Z(Esi'Asi'ysi) - tiy

€shr,z =Z(Esi'Asi)/ Z(Esi'Asi'Zsi) - tiz

ecs(t,ts)- - total shrinkage strain

Coefreint - coefficient increasing amount of reinforcement

Esi - modulus of elasticity of i-th bar of reinforcement

Asi - area of reinforcement of i-th bar of reinforcement

ysi - position of i-th bar of reinforcement from center of gravity of cross-section in y-direction

Zsi - position of i-th bar of reinforcement from center of gravity of cross-section in z-direction

ty - distance between center of gravity of transformed uncracked/cracked cross-section and center
of gravity of concrete cross-section in y-direction

tiz - distance between center of gravity of transformed uncracked/cracked cross-section and center
of gravity of concrete cross-section in z-direction
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Shrinkage deflection (long-term stiffness)

[ N[kN] M, [kNm] M. [kNm] |
Combination: CO2/1_tot 0.00 15975 0.00
Characteristic combination (char): CO2/1_tot_char 0.00 15975 0.00

Forces caused by shrinkage: My, = 140.74 kN, M 5, = 24.56 kNm, M ;.- = 0.00 kNm

Cross-section characteristics

Type of t, t. A L I X A,
component [mm] [mm] [m mz] [m mi] [m mi] [mm] [m mz]
Linear 0.0 00 220000 90210 17.610° 2180 -
Uncracked 0.0 -197 356135 12.110° 19.710° 2322 1407
Cracked 00 734 175211 53110 13.710° 1391 1407

Cracking forces

N.. M. M. o [ R o @, B 4 E.
[kN] [kNm] [kNm] [MPa] [MFa] [MPa] [MPa] [-] [ [GPa
000 7303 000 487 220 YES 1446 3164 05 0.806 300

Stiffness calculation
Axial stiffness EA: EA, =9600.00 MN  EA, = 3600.00 MN

1 1 \
BA=—7 77 ~osss  1-ogss  SooCO00MN 718

EA,  EA 960000~ 9600.00
Bending stiffness EI.).: EI.). = 672.92 MNem * EI.) =193.17 MNm *

1 1 2 .
Bl = = 20871 MM 718
hS 7 1.7 08%6 1 _08% m (r1a)

Bl E, 19307 67292
Bending stiffness El : El,,=527.00 Mhem ©

Fl = ! 1 53700 MRk £ 718

El,, = 527.00 MNm?

Calculation of strain and curvature caused by shrinkage

Strain and curvature caused by shrinkage are calculated for each 1D element and these values are calculated
for both states (uncracked and cracked cross-section).

Calculation of strain caused by shrinkage:
o gy =-gcs(t,ts)- Coefreint- 2 (Esi- Asi)/ (Eceft- Ai)

Calculation of curvature around y and z axis caused by shrinkage
o (1/ry) = -gcs(t,ts)- Coefreint- 2(Esi-Asi- (tiz-Zsi) )/ (Ecet- liy)
o (1/rz) = -gcs(t,ts)- Coefreint 2(Esi-Asi- (tiy-Ysi) )/ (Ecet- liz)

Where:

ees(t,ts)- - total shrinkage strain

Coefreint - coefficient increasing amount of reinforcement

Esi - is modulus of elasticity of i-th bar of reinforcement

Asi - is area of reinforcement of i-th bar of reinforcement

ysi - position of i-th bar of reinforcement from center of gravity of cross-section in y-direction

Zsi - position of i-th bar of reinforcement from center of gravity of cross-section in z-direction

ty - distance between the center of gravity of transformed uncracked/cracked cross-section and

center of gravity of concrete cross-section in y-direction

e t; - distance between the center of gravity of transformed uncracked/cracked cross-section and
center of gravity of concrete cross-section in z-direction

o FEcerf - effective modulus of elasticity of the concrete calculated according to formula Ec = Eceff =

Ecm/(1+0).

Ecm - secant modulus of elasticity of concrete

¢ - creep coefficient

Ai - transformed area of uncracked/cracked cross-section

liy - transformed second moment of area around y-axis of uncracked/cracked cross-section

calculated to center of gravity of transformed uncracked/cracked cross-section

e |z - transformed second moment of area around z axis of uncracked/cracked cross-section calculated
to center of gravity of transformed uncracked/cracked cross-section

Calculation of stiffnesses for shrinkage

The stiffness of uncracked/cracked cross-section for shrinkage is calculated from strain and curvatures caused
by shrinkage by using total level of load (total load combination)

¢ bending stiffness around y-axis Ely =Mioty/(1/ry)

e bending stiffness around z axis Elz = Miot,2/(1/rz)

e axial stiffness EA = Nrot/ex
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2.6.5 Calculation of stiffness for 2D elements

The following procedure is used for the calculation of stiffness of 2D elements:
1) The principal stresses of 2D element for both surfaces is calculated

170

grtar 1 2
MF=T 5 +E\I (UII—U}.:-J +4- Ty,

b

D___Gx_T_'l'El.:'__l ||

2T 5 5\' [Gx;—ﬂ_}:]]‘h + 4- Ty,

2) The angle of principal stresses at both surfaces is calculated

2 G
a[ﬂ.i — 0,5 . tan_l —xy-l-
OxT — Oy

+

3) The final value of the principal stress is calculated

=01+ If 61+201-
o=as1- otherwise

4) The internal forces are recalculated to the direction of the principal stresses o

m(a) =m, - cos*(a) +m,, - sin*(a) +m,,, - sin(2-

o)

n(a) = n, - cos*(a) +n,, - sin’*(a) + n,,, - sin(2 - a)

where nx,ny,Nxy,Mx,My,Myxy are 2D forces in center of 2D element

5) The area of reinforcement is recalculated to the direction of of the principal stress o

As(a) = As-cos?(a-as)

where As,as is area and angle of longitudinal reinforcement

6) The non-linear stiffness in the first principal direction is calculated according to the procedure as for

1D element

e for rectangular cross-section (b =1m, h = thickness of 2D element in center of gravity)
o forinternal forces N = n(a) , My= m(ar) and M:=0 according procedure as for 1D element

7) The non-linear stiffness in the second principal direction is calculated according to the procedure as

for 1D element

e for rectangular cross-section (b =1m, h = thickness of 2D element in center of gravity)
e for internal forces N = n(a+90) , My= m(a+90) and Mz=0 according procedure as for 1D element

8) The stiffness for shrinkage deflection is calculated in both directions of principal axes as explained

in the next section.

9) The five types of stiffnesses are calculated for each 2D element and each dangerous combination:

Type of stiffness

Respective combination

Direction of principal stress
First (EA1,Ely1,Elz1)

Short-term stiffness for immediate deflection | Immediate
Second (EA2z,Elyz,Elz2)
Short-term stiffness for short-term deflection | Total First (EA1, Elys Elz1)
Second (EA2z,Elyz,Elz2)
. . First (EA1,Ely1,Elz1)
Short-term stiffness for creep deflection Cree
P P Second (EA2z,Elyz,Elz2)
First (EA1,Ely1,Elz
Long-term stiffness for creep deflection Creep (EALElys,Elz)
Second (EA2,Elyz,Elz2)
First (EA1,Ely1,Elz
Long-term stiffness for shrinkage deflection | Total (EAElys,Elz)

Second (EA2,Elyz,Elz2)
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10) The following stiffnesses are changes in stiffness matrix for 2D elements:

e D11 =Ely:

e D22 =Ely:

e D33=0.5(1-n)(D11-D22)°5
e D44 =G-h/1.2

e D55=G-h/1.2

e D12 =p (D11-D22)%5
e dll1=EA:

e d22=EA:

e d33=G:h

e d12=p- (d11.d22)05
Where:

e G is shear modulus of the concrete calculated according to formula G = 0.5-Ec/(1+p)
e uis Poisson coefficient of the concrete loaded from material properties of the concrete

Eccentricity of stiffnesses (distance between center of gravity of concrete cross-section and center of gravity
of cracked transformed cross-section) is not taken into account in current version

Calculation of curvature, strain and stiffness caused by shrinkage of a 2D element

Calculation of shrinkage forces

The forces are calculated in the center of gravity of each element and they are calculated in two directions:
e The first one is the direction of principal stress o
e The second one is the direction of principal stress a+90°

The forces caused by shrinkage for first/second direction are calculated according to formulas below. The
forces are calculated for both states: uncracked and cracked cross-section.

o nNshr = -gcs(t,ts)- Coefrein2(Esi- Asi(w))

° Mshr = Nshr-€shr,z

Where:

eshr,z =2 (Esi-Asi(w)/ 2(Esi-Asi(a) Zsi) - tiz(o)

ecs(t,ts) - total shrinkage strain

Coefreint - coefficient increasing amount of reinforcement

Esi - is modulus of elasticity of i-th bar of reinforcement

Asi) - is area of reinforcement of i-th bar of reinforcement in first (angle a)/second direction

(angle a+90°) of principal stress

Zsi - position of i-th bar of reinforcement from center of gravity of cross-section in z-direction

o iz - distance between center of gravity of transformed uncracked/cracked cross-section and centre
of gravity of concrete cross-section in z-direction and in first (angle o))/second direction (angle a+90°)
of principal stress
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Calculation of strain and curvature caused by shrinkage

Strain and curvature caused by shrinkage are calculated for each 2D elements and these values are calculated
for both states (uncracked and cracked cross-section). The values are calculated in both directions of principal

stresses.

Calculation of strain caused by shrinkage:

ex =-gcs(i1s) CoefReinf- X (Esi- asi(o))/(Eceff- Ai(o))

Calculation of curvature around y and z axis caused by shrinkage:

Where:

(2/r) = -gcs(t,ts)- Coefreint 2(Esi- Asi(o)- (tiz()-Zsi) ) (Eceft- liy(a))

ges(t,ts) - total shrinkage strain

Coefreint - coefficient increasing amount of reinforcement

Esi - is modulus of elasticity of i-th bar of reinforcement

Asi) - IS area of reinforcement of i-th bar of reinforcement in first (angle a)/second direction
(angle a+90°) of principal stress

Zsi - position of i-th bar of reinforcement from center of gravity of cross-section in z-direction

tiz() - distance between centre of gravity of transformed uncracked/cracked cross-section and centre
of gravity of concrete cross-section in z-direction and in first (angle a)/second direction
(angle a+90°)of principal stress

Ecef - effective modulus of elasticity of the concrete calculated according formula Ec= Eceff =
Ecm/(1+0).

Ecm - secant modulus of elasticity of concrete

¢ - creep coefficient

Aiw) - transformed area of uncracked/cracked cross-section in the first (angle a)/second direction
(angle a+90°) of principal stress

liyw - transformed second moment of area around y axis of uncracked/cracked cross-section
calculated to centre of gravity transformed uncracked/cracked cross-section in the first
(angle a))/second direction (angle a+90°)of principal stress

Calculation of stiffnesses for shrinkage

The stiffness of uncracked/cracked cross-section for shrinkage is calculated from strain and curvatures caused
by shrinkage by using total level of load (total load combination)

Where:

bending stiffness in direction of first principal axis Ely1 =mtotw/(1/r)1
bending stiffness in direction of second principal axsi Ely2 =mtota+90)/(1/r)2
axial stiffness in direction of first principal axis EA1 = Niotw/ex,1

axial stiffness in direction of second principal axis EA2 = Ntot(a+90)/€x,2

Not(e,), Niot(eero0 - are axial forces from total combination in 2D element recalculated to direction of first
and second principal axis

Miot(), Miot(a+90 - are bending moments from total combination in 2D element recalculated to direction
of first and second principal axis

ex.1(2) - IS strain caused by shrinkage calculated in direction of first (second) principal axis

(1/n12 - is curvature caused by shrinkage calculated in direction of first (second) principal axis

Deflection for shrinkage is calculated in FEM analysis for total combination, therefore the stiffness are
calculated with using internal forces for total combination

172
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2.6.6

Parameters for the calculation of shrinkage strain

The total shrinkage strain is composed of two components, the drying shrinkage strain and the autogenous
shrinkage strain. The drying shrinkage strain develops slowly, since it is a function of the migration of the water
through the hardened concrete. The autogenous shrinkage strain develops during hardening of the concrete.

There are three options for calculation/input of total shrinkage strain that can be selected in the concrete
settings menu:

No (Consider drying and autogenous shrinkage= No): shrinkage will not be taken into account

in CDD calculation

Automatic calculation (Consider drying and autogenous shrinkage = Auto), where shrinkage

strain is calculated according to EN 1992-1-1, chapter 3.1.4(6) for following input parameters:

o Relative humidity

o Age of concrete at beginning of drying shrinkage

o Age of concrete at moment considered
Except of these input parameters, automatic calculation of shrinkage strain depends on material
properties (mean compressive strength of concrete fem, characteristic compressive cylinder strength
fek, type of cement), cross-section parameters (cross-sectional area Ac and the perimeter of the
member in contact with the atmosphere u)
User input (Consider drying and autogenous shrinkage = User value) and you can input directly
value of total shrinkage strain

Concrete settings O s

Views: Complete setup v |View sett... v | Load default Find National annex: n
Description Symbol Value Default Unit Chapter Code Struct... Check...

<all= D <all= D <all= ,O <all= D <all> D <all= D <all= D <all= D

- Design defaults

4 Solver setting

4 General
Limitvalue of unity check Lim.check L0 1.0 Independe... All(Bea
Value of unity check for notealculated unity check Neal.check 3.0 3.0 Independe.
The coefficient for calculation effective depth of cros... Coeffy 0.9 0.9 Independe.
The coefficient for calculation inner lever arm Coeff, 0.9 Independe.
The coefficient for calculation force, where member ... Coeff o 0.1 0.1 Independe...

4 Creep and shrinkage e
Age of concrete atthe momentconsidered t 1825.00 18250.00 |day |3.1.4B.1-2 EN1992-1-1 A
Relative humidity RH 50 50 3.1.4B.1-2 |[EN1992-1-1 All(Bea
Type inputof creep coefficient Type @(tto) |Auto Auto 3.1.4(2) EN 1992-1-1

Age of concrete atloading fy 28.00 28.00 day |3.1.4(2),B1 |EN1992-1-1 A
» Konsider drying and autogenous shrinkage Type geltts Auto uto 3.1.4(8) EN1992-1-1
Age of concrete at the beginning of drying shrin... tg 06 day 3.1.4(6),B2 EN1992-1-1 /
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2.6.7 Calculation of deflection

The following deflections are calculated in the CDD check:

Oin linear (elastic) deflection, calculated for the total combination and for linear stiffness.

Aimm immediate deflection, the deflection after applying permanent and long-term variable loads which
means calculated for short-term stiffness and immediate combination

Oshort Short-term deflection, the deflection which considers cracking of cross-section calculated for
short-term stiffness and total combination

Ocreep Creep deflection, calculated as the difference between deflection calculated for long-term and
short-term stiffness for the creep combination. Acreep = Ocreep, long — Ocreep, short

Oshr deflection caused by drying and autogenous shrinkage. The long-term stiffness is calculated from
strain and curvature caused by shrinkage using total combination.

Oadd additional deflection, the deflection after applying a variable load and considering creep calculated
as the difference between total and immediate deflection. Aadd = Stot — Oimm

Ot total deflection, the deflection which considers creep and cracking calculated as the sum of short-
term deflection and deflection caused by creep. Atot = Oshort + Ocreep

load
i 6short

-
«

All those values can be displayed on the screen:

RESULTS (1) J
Name Code dependent deflection

v SELECTION

Type of selection  All v
Filter No v
Automatic combination (V)

‘W RESULT CASE FOR DEFLECTION

174

N e Typeofload  Combinations
£ Combination  SLS \/
(=2}
= Envelope (for 2D drawing)  Absolute extreme
HEENITIT T T T T T T T 1 L L T L LT T T T T T -
1. [N N e O 9525551 Type o einfrcement._Required
J\ T _ v RESULT CASE FOR REQUIRED REINFORCEMENT
Typeofload Load cases
Sl = Load case LC1-SW v/
c v EXTREME 1D
£ Extreme 1D  Global v
5 Results in sections  All v
(9]
1 Direction (local)  z (1D/2D) ™/
= Valuesf| Stot
output] V¢
iF | stot
= Print combination keyl" g0t tim
= Print explanation of symbolsfl  Sadd
Badd, li
at v ERRORS, WARNINGS AND NOT Slain 2%
g Show Information about warni... {5
Show errorsf|  Sshort
é i - Screep
. showwarningsfl .
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Chapter 3: Modification of results

3.1 Location

During a calculation in SCIA Engineer, the node deformations and the reactions are calculated exactly (by
means of the displacement method). The stresses and internal forces are derived from these magnitudes by
means of the assumed basic functions and are therefore in the Finite Elements Method always less accurate.

The Finite Elements Mesh in SCIA Engineer exists of linear 3- and/or 4-angular elements. Per mesh element
3 or 4 results are calculated, one in each node. When asking the results on 2D members, the option ‘Location’
in the Properties window gives the possibility to display these results in 4 ways.

3.1.1 In nodes, no average

All of the values of the results are taken into account, there is no averaging. In each node are therefore the 4
values of the adjacent mesh elements shown. If these 4 results differ a lot from each other, it is an indication
that the chosen mesh size is too large.

This display of results therefore gives a good idea of the discretisation error in the calculation model.

12115 24| 30
91 18 25 31
M| 18 24 [ 29
9117 24 | 30

3.1.2 In centers
Per finite element, the mean value of the results in the nodes of that element is calculated. Since there is only
1 result per element, the display of isobands becomes a mosaic. The course over a section is a curve with a

constant step per mesh element.
| E ;

MJ — 08/08/2024 175




Advanced Concept Training — Concrete

3.1.3 In nodes, average

The values of the results of adjacent finite elements are averaged in the common node. Because of this, the
graphical display is a smooth course of isobands.

In certain cases, it is not permissible to average the values of the results in the common node:

- At the transition between 2D members (plates, walls, shells) with different local axes.

- If a result is really discontinuous, like the shear force at the place of a line support in a plate. The peaks will
disappear completely by the averaging of positive and negative shear forces.

3.1.4 In nodes, average on macro

The values of the results are averaged per node only over mesh elements which belong to the same 2D
member and which have the same directions of their local axes. This resolves the problems mentioned at the
option ‘In nodes, average’.

14 1 14 25 | 28
141 14 28] 28
1313 EEi e
13 ] 13 EE

3.1.5 Accuracy of the results

If the results according to the 4 locations differ a lot, then the results are inaccurate and the mesh has to be
refined. A basic rule for a good size of the mesh elements, is to take 1 to 2 times the thickness of the plate.
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3.2 Averaging strip

An averaging strip averages peak values over a zone. You can find the averaging strip in the Input Panel in
the “Result tools” category :

INPUT PANEL @ All workstations

Res AVERAGING STRIP & Altags -

&Aoo

3 B

Mame RS1
Type Strip v
Width [m] 1.000

Direction longitudinal =

Type: a point or a strip can be chosen.
Dimensions: here the dimensions of the point/strip need be set.

Direction:
1) Direction = Longitudinal

g
3 T
H
g

o pods

—

Longitudinal means that the averaging is done in the longitudinal direction of the strip. In the example
above this is the y-direction. This means that the averaging is done for my. The values my are
averaged in the x-direction.
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2) Direction = perpendicular

B 1 0 R

i
= & 20 mtemal forees

Perpendicular means that the averaging is done perpendicular to the longitudinal direction of the strip.
In the example above this is the x-direction. This means that the averaging is done for mx. The values
mx are averaged in the y-direction.

7
iy D e

u emen
Anat megretudes
Exeme: Gibal

B A A S A S A (O
hoh b b b bk h Tk

f@@ﬁ

Both means that the averaging is done in both directions of the averaging strip. This means the values
are averaged for mx as well as my in the direction perpendicular to mx and my.
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To activate the averaging strip, the option ‘Averaging of peak’ needs to be checked in the properties panel.
¥ RESULT CASE

Type ofload Combinations ~
Combination ELU-Set B (auto)

Envelope (for 2D drawing)  Absolute extreme

I Averaging of peak I

Location  In nodes avg. on macro
System  LCS mesh element
Extreme Global
Type of values  Basic magnitudes

Values m_x ~

As an example, we will apply averaging strips to the model of the chapter “2D concrete members”for the value
Asw,req.
o  Asw,req Without Averaging of peaks

13264.90
12000.00
11000.00
10000.00

9000.00

Aswreq [Mm % m?2]

8000.00
7000.00
6000.00
5000.00
4000.00
3000.00
2000.00
1000.00

0.00

o  Aswreq With averaging of peaks

8545.83
7800.00 I
7200.00

6600.00 —

Aswreq [Mm 2fm2]

6000.00 —
5400.00 —
4300.00 —

4200.00

3600.00 .
3000.00
2400.00

1800.00
1200.00
600.00
0.00
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3.3 Rib

A rib can be added to a plate in the Input Panel in the “1D Members” category:

= INPUT PANEL g8 Al workstations
= 1D Membe R * & Alitags
= | | VN v 0O

But also in the Input Panel in the “2D Members” category:

= INPUT PANEL g2 Al workstations
i 20 M¢ RIBBED SLAB @ Altags

Ao Feodolobloaas
o

3.3.1 Results inribs

When a rib is added to the model there will be an option rib available in the result properties of 1D and 2D
n has an influence on what results you view.

RIB Activated RIB Not Activated

members. This optio

1D-Results

2D-Results
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% Link between the internal forces calculated for the entire T-section, and for the beam and slab

separately

When calculating the internal forces in a rib, the substitute T-section is used to calculate the results. The web
of this T-section is formed by the rib-beam itself, the flange of the T-section is made with the effective width of
the slab. The effective width of the slab has to be used to determine the internal forces of the slab that have
to be added to the internal forces calculated in the rib itself.

T the heart of the entire substitute T-section
T1 the heart of the left part of the effective width
T2 the heart of the right part of the effective width
T3 the heart of the original rib
Left part Right part
+T1
+T2
+T
z +T3
7 0

The coordinates of the hearts are used as lever arms in Y and Z direction:

LeverArmZ1=T1z-Tz

LeverArmY1=Tly-Ty

LeverArm Z2=T2z-Tz

LeverArmY2=T2y-Ty

LeverArmZ3=T3z-Tz

LeverAmY3=T3y-Ty

LeverArm Z=Tz-0z

LeverArmY =Ty -0y

The final internal forces in the rib can be calculated with the formulas below:

N = N beam + N slab, left + N slab, right

Vy = Vy beam + Vy slab, left + Vy slab, right

Vz =V beam + V: slab, left + V: slab, right

Mx = Mx beam + Mx slab, left + Mx slab, right

My = My beam + My slab, left + My slab right + N slab, left * (Lever Arm Z1)

— N slab, right * (Lever Arm Z2) + N beam * Lever Arm Z3;

e M;=M;beam + M; slab, left + M slab, right + N slab, left * (Lever Arm Y1)

— N slab, right * (Lever Arm Y2) + N beam * Lever Arm Ys;
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+ Why is there an axial force in the rib?

SCIA Engineer integrates the ribs as eccentric beams attached to slabs. The eccentricity is calculated from
the half of the slab thickness and half of the height of the cross section of the beam.

E=D/2+H/2

During the input of the cross section of the beam, the height of the cross section is defined as a distance
between the bottom of the slab and the bottom of the beam. In the picture, the height is marked as “H”.

Due to the shift of the neutral axis, the internal forces in the whole system change. In a simple system subject
to a bending moment only, we get a structure with an internal bending moment as well as axial force.

Usually, if the beam is below the slab, we get compression in the slab and tension in the beam.

The eccentric beam causes axial forces in the slab. This results from the deformation of the whole slab+beam
system. The picture shows the horizontal deformation “ux” to explain graphically the behaviour of the system.
This system is composed of two beams of a rectangular cross section connected by rigid links. The horizontal
displacement of the support is free to prevent the constraint.

J QIl]'“nii-iiiii;;::-;:a
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The horizontal deformation in a side view:

If we look at the beginning of the beam, we can see compression in the slab and tension in the beam:

Of course, the whole system must be in equilibrium and the total axial force equal to the sum of the axial force
in the slab and in the beam must be zero.

In our model, we have only one beam and all the internal forces of the top part are integrated in the axial force
in the rib. Practically, the effective width of the slab is smaller than the whole width of the slab. Only
exceptionally are the ribs arranged in such a way that there are no gaps in between the effective widths and
all internal forces in the slab can be summed up into the rib. This happens if the distance between the ribs is
smaller or equal to the effective width of the slab calculated from the national code.

- Behaviour of arib in a wide slab

Now we can investigate a system where the width of the slab is greater than the effective width of the slab.
The equilibrium condition must be fulfilled. If we integrate all the axial forces in the whole slab and the beam,
we - of course - get a zero result.
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Distribution of the axial force in the slab. This is independent on the defined effective width of the slab. Only
the stiffness of the slab and beam is responsible for the shape of the distribution of internal forces.

o — —————

‘,
oo bdazwidisddbeiiaasselAN e

e =

This is a section across the middle of the slab showing the distribution of the axial force.
2p7

—tec4n

D R R e

We can integrate the axial force in the section across the whole width of the slab. We get 439kN.

B I S S

Compared to the axial force in the beam, which is 435kN. We see the whole system is in equilibrium. The small
difference results from the size of the finite elements.

i ’J{—-'r {j’T' T r‘j_:,
- : “-7;4{;"%;,1_
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+ Comparison of different effective widths

However, if we extend the effective width of the slab to the whole width of the slab, we neglect the distribution
of the internal forces over the slab and the concentration over the beam. (In fact, there are two limit values:
the minimum effective width is equal to the width of the beam and the maximum one is equal to the whole
width of the slab.)

The internal forces in the slab are excluded from the slab and integrated into a new virtual T section. This
virtual section consists of the effective slab width and the beam.

Distribution of the axial force in the slab. We can see that the distribution is equal to the one in the pictures
above where the effective width of the slab was defined according to the code.

In the picture we can see the axial force after the forces within the effective width of the slab were excluded
from the slab. In SCIA Engineer you can achieve this using the checkbox “RIB” in the results.
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We get axial force equal to 56kN, which is in the slab. The total axial force in the slab was 435kN. Therefore,
in the part outside the effective width we have axial force 435 - 56 = 379kN.

In the beam, we still have the same 445kN. (The difference to the previous pictures results from the changed
size of the 2D finite elements).

Look what happens if we increase the effective width of the slab to 1500mm. This results from the following
formula: 2 * (0,1 * L) + bw = 2*0,6+0,3

As we can see, the axial force in the slab is still the same. It must be, because the effective width of the slab
has no influence on the distribution of the axial force in the finite element calculation. It only affects the split of
the forces after the calculation between the slab and the virtual T section.
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The area of the effective width of the slab will be removed from the slab and the forces will be integrated into
the T section. The internal forces outside of the slab will remain in the slab.

These internal forces will be moved to the T section.

pos

If we integrate the axial forces, we get 234kN.
S e
$

In the rectangular section below the slab we get the original 445kN.

” ' 4l }!!a

If we reduce this axial force of the beam by 234kN, which is the sum of the axial forces from the effective width
of the slab, we get 211kN
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The axial force outside the effective width remains in the slab.

If we integrate the forces (left and right) outside the effective width, we get axial force equal to 210kN, which
is in equilibrium with the tension in the rib as a T Section.

v

3.3.2 Stiffness of ribs in CDD calculation

The calculation of the stiffness of the rib depends on the checkbox “Rib”.
+ Check box is OFF

The stiffness of the beam and the plate will be calculated separately. If there is 1D reinforcement in part of the
slab it is not taken into account for the calculation of the stiffness of the plate.

+ Check box is ON

1) Equilibrium for the final cross-section is calculated for each dangerous combination and each type of
stiffness.

2) The stiffness of the rib, only taking into account the rib cross-section, is calculated with the height of
compression zone from equilibrium on the whole (final) section. Stiffnesses are calculated to the centre of
gravity of the transformed final cross-section.

Rio cssl 4

- —

L Rb zun

n

R css
Nk cas

3) Stiffness of the 2D element outside of the effective width is calculated by the standard procedure. Stiffness
of the 2D element inside effective width is calculated in two directions: direction of the rib (arin)and direction
perpendicular to the rib. (ouin + 90)

4) The stiffness perpendicular to the rib is calculated by the standard procedure.
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5) The stiffness in the direction of the rib is calculated according to following procedure:

The 1D reinforcement which is designed or inputted in part of the slab of the final cross-section is
taken into account for the calculation of the stiffness of the 2D element. This reinforcement is
transformed to 2D reinforcement and is added to the standard 2D reinforcement.

Uncracked stiffnesses (EA,, Ely,, Elz,) will be calculated for the whole thickness of the 2D element
with standard 2D reinforcement (required/provided/user) and with transformed reinforcement from
the 1D member. The stiffness is calculated to the transformed centre of gravity of the uncracked
section.

Cracked stiffness is calculated in case that (cct <= ocr). The stiffness (EAn, Ely,i, Elz,i) will be
calculated taking into account parameters from the calculation of the 1D element which is nearest
to centre of gravity of the 2D element. The height of compression zone is calculated according to

formula:

K. = Acc — Acc,Rib
= —
beff
Where:

o Acc — compressive area of whole cross-section for cracked CSS

o AccriB —CcOmpressive area of part of cross-section (rib cross-section) for cracked CSS

o beff — effective width of the slab for check

o oct-is maximum tensile strength calculated for final cross-section (rib cross-section + part

of the slab) and for characteristic combination

The stiffness is calculated to the transformed centre of gravity of the cracked section.
The average stiffness will be calculated from the cracked and the uncracked stiffness using the
distribution coefficient, which is calculated from the stresses calculated for the whole cross-section
of the 1D element which is nearest to centre of gravity of the 2D element.

o bending stiffness around y-axis (Ely) = 1/[C/(Ely)n + (1-C)/ (Ely)i]

o bending stiffness around z-axis (Elz) = 1/[C/(Elz)n + (1-C)/ (Elz)|]

o axial stiffness (EA) = L/[(C/(EA + (1-C)/( EA)]

3.4 Orthotropy

In engineering practice, you may often come across a situation when the slab (or wall) to be designed has
different characteristics (stiffness) in the longitudinal and transverse direction and thus, shows different
behaviour in these two directions. Such a behaviour may result from the geometry (e.g. ribbed slabs) or from
physical assumptions for a particular situation, for example, when determining deformations in a cracked plate
or when excluding vertical members from a horizontal stiffening system (e.g. masonry walls).

Whenever you need to adjust the finite element model accordingly to reflect such a behaviour in SCIA
Engineer, the orthotropic properties can be used. These orthotropic properties can be defined in two ways.

Orthotropy in the properties of a 2D member

=y

2D MEMBER (1) [
A~ g8

Name D1

Layer cCalquel -

Elementtype Standard
Element behaviour e
Type plate (90) ~
Shape

—_—

Material (C25/30 ~~ —
FEM model v

FEM nonlinear model || 1Sotropic
Orthotropic
iIcknessType constant

Thickness [mm] 200.00

Member system-plane at Centre
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The difference is in the data you need to enter. In the orthotropy, the stiffnesses are defined directly, while in
the property modifier, a factor is specified by which the isotropic stiffnesses are multiplied.

The property modifier is a bit more flexible because it does not depend directly on the properties of the modified
part. If you want to enter an uniaxially stretched plate, then you can do that for a 20cm thick plate and also for
a 30cm thick plate using the same values. The orthotropic properties require that you define separate
properties for each of the plates (20cm and 30cm one).

On the other hand, also the orthotropy has its advantages. It can be parameterized, and the program includes
a set of generators to help you with the input.

However, it is important to understand individual orthotropic parameters. The stiffnesses are defined with
parameters starting with a "D" or "d". The property modifiers ask for the following parameters for a shell
element:

B Stiffness factors 2D >
HEEFE a2 O @@ A L
SFz2D1 Mame SF2D1
Description
Type Standard v

Correction factor for D11 1.000
Correction factor for D12 1.000
Correction factor for D22 1.000
Correction factor for D33 1.000
Correction factor for D44 1.000
Correction factor for D55 1.000
Correction factor for d11 1.000
Correction factor for d12 1.000
Correction factor for d22 1.000
Correction factor for d33 1.000

New Insert Edit Delete CK

The parameters beginning with "D" represent plate stiffnesses. The parameters starting with "d" are membrane

stiffnesses. The direction is derived from the direction of the local coordinate system.
e D11: Flexural stiffness in the "x" direction (bending)

D22: Flexural stiffness in the "y" direction

D12: Mixed stiffness of D11 and D22 (transverse contraction)

D33: Torsional stiffness

D44: Shear flexural stiffness in the "x" direction

D55: Shear flexural stiffness in the "y" direction

d11: Normal membrane stiffness in the "x" direction (stretching)

d22: Normal membrane stiffness in the "y" direction

d12: Mixed stiffness of "d11" and "d22" (transversal contraction)

d33: Shear membrane stiffness
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In case of a simple, isotropic plate, the stiffness can be expressed using the following formulas:

Membrane stiffness

Plate direction

E-h3

Dii =Dyy = ———o—_
11 22 12(1 _ VZ) E-Rh

h3
B = 5
1
E d33—§-(1—v)-vd11-d22
C =

Dyy=Dss= G-h
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+ How to model a one-way slab in SCIA Engineer

A one-way slab is a slab that bears the load in one direction mainly. It can be a slab supported on two edges
only or a slab supported on four edges for which the bigger span length Ly is at least twice the smaller span

Lx. The design of a one-way slab will lead to reinforcement mainly in the bearing direction.

In a Finite Element software like SCIA Engineer, when the slab is supported on its four edges, the software
will by default consider it as a two-way slab. Since there is no predefined main direction for the bearing of the
load, the bending stiffness of the slab will participate in both x and y directions. In SCIA Engineer you can

easily define a one-way-bearing slab.

2D internal forces

Values: mx

Linear calculation

Load case: LC1

Extreme: Member

Selection: All

Location: In nodes avg. on macro.
System: LCS mesh element

2D internal forces

Values: my

Linear calculation

Load case: LC1

Extreme: Member

Selection: All

Location: In nodes avg. on macro.
System: LCS mesh element

Figure 1: Bending moments in a two-way slab (on the left) and one-way slab (on the right)

192

mx [kNm/m]

10.00
9.00
8.00
7.00
6.00
5.00
4.00
3.00
2.00
1.00
0.00
0.28

my [kNm/m]
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In SCIA Engineer, the input of a one-way slab can be done with orthotropy properties. Two types can be used
and are explained below.

+ One-way slab using “two heights” orthotropy type

The example is made of a slab supported by beams and columns. In the slab properties, change the FEM
model to “Orthotropy”, edit the orthotropy property and select the type of orthotropy “two heights”. The input
data are the thickness of the plate for the calculation of the flexural stiffness in the x-direction, hi, and the y-
direction, h2. For a slab bearing mainly in the x direction (smaller span length in the example), h: should be
kept equal to the actual plate thickness (180 mm) and h: (thickness in y-direction) should be reduced.

=4
2D MEMBER (1) Q
A~ g M
Name D1
B Orthotropy *
Layer Calquel »~ =
-8 [# - A Al |
Elementtype Standard ~~ HiRFE -« O *Y
/ot Name OT1 "
Element behaviour R -
I Type of orthotropy Twe_heights v I
Type late (90
ype plate (90) v Material C20/25 Yo
SHane 4+ Flexure
Material - Effective height, h1 (x) [mm] 180
| FEMmodel Orthotropic “~ | | Effective height, h2 (y) [mm] 1 |

FEM nonlinear model none Torsion reduction coeff 1

i 1.2
Orthotropy  OT1 v~ Shear reduction coeff

D11 [MNm] 1.5188e+01
Member system-planeat Centre
D22 [MNm] 2.6042e-06

Eccentricity z [mm]  0.00 D12 [MNm] 1.2578e-03

LCS type  Standard D33 [MHMm] 2.5156e-03
Swap orientation () ) Da4 [MN/m] 1.8750e+03
LCS angle [deg]  0.00 = D55 [MH/m] 1.041Te+01

Figure 2: Parameters for a one-way slab using "two heights" orthotropy type

There is no specific rule regarding the value of h2. With smaller values of hz, the results will be close to the
following load distribution:

1D internal forces

Values: My

Linear calculation

Load case: LC1

Coordinate system: Principal
Extreme 1D: Member
Selection: All

Filter: Type of beam = Beam

Figure 3: Bending moment in the supporting beams of a one-way slab (on the left) and of a one-way load panel (on the right)
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The resulting moment mx in the slab is then close to a 1m-wide simply supported beam:

194

2D internal forces
Values: mx

Linear calculation
Load case: LC1
Extreme: Member
Selection: All

_q*Ll% 357

m, = 9,4kNm/ml

8 8

Location: In nodes avg. on macro.

System: LCS mesh element

Figure 4: bending moment mx in a one-way slab
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+ One-way slab using “one direction” orthotropy type

This type of orthotropy requires three input parameters and can also be used for modelling hollow core slabs:
the equivalent beam cross-section CSS, the spacing L used for the calculation of the flexural bending stiffness
in direction 1 (or x) and the concrete topping height h used for the calculation of the flexural bending stiffness
in direction 2 (or y). To model a one-way slab, a small value of h can be used. However, keep in mind, that h
is also used for the calculation of the self-weight of the slab.

For the equivalent cross-section, a slab-equivalent shape is used: “thickness of the slab” x “width of the beam”,
i.e. 180 x 1000mm. For the spacing parameter, as the slab is plain, the same value as for the width of the
beam is used, i.e. 1000mm.

B Orthotropy b4
Rl e as O mB A  §
a 0oT1 Name OT1 I
I Type of orthotropy One directionslab ¥ I
4 Flexure

£SS €83 - Rectangle (180; 1000) v ...
C55 spacing, al [mm] 1000
Material C20(25 v
| Height of slab, h [mm] 1 ]
D11 [MNm] 1.5309e+01
D22 [MNm] 2.5000e-06

D12 [MNm] ©.0000e+00
D33 [MNm] 2.8284e+00
D44 [MN/m] 1.9721e+03
D55 [MN/m] 1.0417e+01

Figure 5: Parameters for a one-way slab using "one direction" orthotropy type

1D internal forces 20 internal forces

Values: My Values: m«

Linear calculation Linear calculation

Load case: LC1 Load case: LC1

Coordinate system: Principal Extreme: Member

Extreme 1D: Member Selection: All

Selection: All Location: In nodes avg. on macro.

Filter: Type of beam = Beam System: LCS mesh element

i) &)
L - [

Figure 6: Bending moment in the supporting beams and in the one way slab using the type "one direction”

For small values of hz or h, both types give the same results for the bending moment in the bearing direction
and the load transferred to the supported beams.

There are still some differences between both orthotropy types. First, using “one direction” type leads to higher
values of bending moment on the secondary beams (parallel to the bearing direction). This is due to the
torsional moment component of the plate (D33) that is different between both types. Secondly, with “one
direction” orthotropy type, the self-weight of the slab is calculated based on the concrete topping thickness h
only. The total height of the slab is thus not accounted for and you have to add the missing part of the self-
weight manually in a permanent load case.
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